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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (http://
h20230.www2.hp.com/svi_partner_list.jsp), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide provides general reference information for HP Business 
Availability Center.

How This Guide Is Organized

The guide contains the following chapters:

 Part I User Interface

Provides additional reference material regarding the user interface, explains 
the main concepts, tasks, and references of Topology Query Language (TQL) 
and View Explorer, explains how to work with reports, how to use the 
toolbars and right-click menu options in IT Universe, and how to work with 
dates, data samples, and log files. 

 Part II Data

Describes the data samples and their fields that are available in various 
contexts in HP Business Availability Center (including Custom Reports, 
Measurement Filters, and Custom Query Builder).

This chapter describes: On page:

How This Guide Is Organized 11

Who Should Read This Guide 12

Getting More Information 12
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Welcome to This Guide
 Part III Dates and Times

Describes date and time reference information for HP Business Availability 
Center.

 Part IV Troubleshooting

Describes the problems that arise while working with or administering 
HP Business Availability Center.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

Readers of this guide should be knowledgeable about enterprise system 
administration and HP Business Availability Center.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.
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1
Working in Reports

Reports consist of charts and tables that help you track and analyze the 
health of your monitored environment. You view and generate reports, and 
drill down and/or apply various filtering criteria to examine performance 
trends and pinpoint the cause of availability and performance issues.

About Working in Reports

Reports enable you to examine and analyze the data that HP Business 
Availability Center collects. When generating reports, you can specify 
various report settings, including time range and resolution, profile, 
grouping, and filters.

You can also customize reports by adding a header and a footer, by selecting 
to automatically or manually generate the report, or by customizing other 
display elements. For details, see Chapter 2, “Sharing and Storing Reports.”

For details on the navigation functions in HP Business Availability Center, 
see “Navigating HP Business Availability Center” in the HP Business 
Availability Center Deployment Guide PDF.

This chapter describes: On page:

About Working in Reports 15

Understanding Common Report Elements 16

Choosing the Time Range and Granularity 19

Animating Report Charts with Macromedia Flash Player 22
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Chapter 1 • Working in Reports
Note: HP Business Availability Center presents certain reports within the 
context of transaction thresholds. For details on configuring transaction 
thresholds, see “Transaction Threshold Settings” in Using End User 
Management.

Understanding Common Report Elements

The items listed in the table below are common to most report pages. You 
may see only a few of the items described below in your report. Report 
elements specific to a certain application are described within that 
application’s documentation:

Item Description

After you have specified the report criteria, click 
Generate to generate the report (in certain 
applications, reports are generated automatically 
when the page is loaded).

Certain reports are initially generated 
automatically, whereas for others you must specify 
report criteria and generate the report manually. 
For details on setting reports to be automatically 
generated, see “Configuring Report Generation 
Settings” in Platform Administration.

Time Range and 
Granularity Bar

Located at the top of the report area. Displays the 
currently selected report date and time frame and 
granularity.

For details, see “Choosing the Time Range and 
Granularity” on page 19.
16



Chapter 1 • Working in Reports
Divides a table of data or a list of reports into pages. 
You move from page to page by clicking the 
relevant button:

➤ To view more reports, click the Next page or 
Last page buttons.

➤ To view previous reports in the list, click the 
Previous page or First page buttons.

Click the back button to view the previous page in 
the list of reports.

Click the forward button to view the following 
page in the list of reports.

Click to view the first page of reports.

Click to view the last page of reports. 

Click the Sort Up button to display an alphabetical 
list in the column you chose.

Click the Sort Down button to display a reverse 
alphabetical list in the column you chose. 

Click to reset the table columns’ width to its 
default setting. You can adjust the width of the 
table’s columns by dragging the borders of the 
column to the right or the left.

Click the Select Columns button to open the Select 
Columns dialog box and select the columns you 
want to be displayed on the table. 

For details on the Select Columns dialog box, see 
“Select Columns Dialog Box” on page 45.

Item Description
17



Chapter 1 • Working in Reports
Click the Print button to drill down for the 
following options:

➤  produce a .pdf format file. For details, see 
“Producing a Printer-Friendly Report in .pdf 
Format” on page 27.

➤  send a report to a printer. For details, see 
“Printing a Report” on page 27.

Click the Format button to drill down for the 
following options:

➤  produce a .csv format file. For details, see 
“Saving a Report in .csv Format” on page 28.

➤  produce an Excel format file. For details, 
see “Saving a Report in Microsoft Excel Format” 
on page 29.

➤  produce an .xml format file. For details, see 
“Saving a Report in .xml Format” on page 30.

Click the Export button to drill down for the 
following options:

➤  send a report by e-mail. For details, see 
“Sending a Report by E-Mail” on page 31.

➤  publish a report with updated data. For 
details, see “Publishing a Report” on page 33.

➤  save a report to the report repository. For 
details, see “Saving a Report to the Report 
Repository” on page 36.

<animated reports> Certain reports are animated with Macromedia 
Flash Player. For details, see “Animating Report 
Charts with Macromedia Flash Player” on page 22.

<breadcrumbs> The list of pages appearing horizontally across the 
top of the page that you have navigated through to 
get to the current page. 

Note: Each page in the list of breadcrumbs is a link 
which you can click to trace your path of 
navigation.

Item Description
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Chapter 1 • Working in Reports
Choosing the Time Range and Granularity

When generating a report, you choose the time range and granularity in 
which the report is displayed.

For additional information on choosing the time range and granularity in 
Service Level Management, see “Tracking Range and Granularity in Service 
Level Management” in Using Service Level Management.

To choose a time range and granularity:

 1 From the time range list (labeled View), select a time range. You can display 
reports by:

➤ custom range

➤ hour, day, week, month, quarter, year

➤ past hour, past day, past week, past month, past quarter, past year

<color coding> HP Business Availability Center uses color coding 
in reports to organize data in a meaningful way, 
and make reports more readable.

Use the legend that appears in a report to get a 
basic description of the color coding used in the 
report. For detailed information about a specific 
report and how to interpret the color coding used, 
refer to that report’s documentation.

View as Graph tab Located just above the report.

Click to display a graphical representation of the 
data. This is generally the default view.

View as Table tab Located just above the report.

Click to display a tabular representation of the 
data.

Item Description
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Chapter 1 • Working in Reports
➤ week to date, month to date, quarter to date, year to date

➤ previous week, previous month, previous quarter, previous year

➤ last <definable time period>

Note: Not all reports include all the above time ranges.

 2 Select:

➤ Hour, Day, Week, Month, Quarter, or Year to generate the report in that 
time range. Then choose either the start date and time or the end date 
and time. HP Business Availability Center updates the other accordingly. 
Continue to the next step.

➤ Custom to generate the report for a time range whose start and end date 
you want to manually select. Then choose both a start and end date and 
time. Continue to the next step.

➤ Last to generate the report for the last hour, day, week, month, quarter, or 
year. 

➤ Any of the other options to view the time range relative to the current 
date and time. (If you select one of these options, and then make changes 
to the start and end dates, the View box updates the time range.) To 
continue, skip to step 7 on page 21. 

 3 To specify a starting date and time, click the start date link (labeled From). 

To specify an ending date and time, click the end date link (labeled To) to 
open the calendar window.

 4 Use the calendar to select the start or end date and time for the report. 
Choose a month, year, and time from the lists, and click a date in the 
calendar table.

Use the forward and back arrows on either side of the selected month to 
move the time period forward or back by a month.

 5 Click OK to accept the date you chose.

Click Reset to reset the calendar to the default day, month, year, and time.

Click Cancel to close the calendar without changing the starting time.
20



Chapter 1 • Working in Reports
 6 Use the forward or back arrows as required to move the selected time period 
forward or back by the period of time specified in the time range list. If a 
custom time range is selected, HP Business Availability Center moves the 
time period forward or back by the current custom time range.

 7 For reports that are divided by time units, you can select report granularity. 
From the granularity value and granularity unit lists (labeled Every), select 
the granularity for the report. The available granularity units (minute, hour, 
day, week, month, year) differ depending on the selected time range and the 
specific report, and the granularity values differ per granularity unit.

The granularity determines how many measurement samples are displayed 
in the report per time interval. By default, reports are limited to a maximum 
of 32 samples (trend reports have a maximum of 50 samples). Thus, for 
example, if you select the “Day” time range and the “minutes” granularity, 
since there are 1,440 minutes in a day and a maximum of 32 samples on a 
chart, the granularity ranges from “every 45 minutes” (1440/32=45) to 
“every 59 minutes” (above 59 minutes, you use the “hour” granularity unit).

Additional examples:

➤ If you select the Day time range and a granularity of every 1 hour, the 
report is displayed using 24 samples (1 hour x 24 = 1 day).

➤ If you select the Month time range and a granularity of every 1 week, the 
report is displayed using 4 samples (1 week x 4 = 1 month). 

You can modify the allowed number of samples in reports in the 
Infrastructure Settings Manager. To do so, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, click Foundations, select End 
User/System Availability Management, and locate the Max Data Points in 
Report parameter entry in the Data table. Modify the value to the required 
amount.

For details on using the Infrastructure Settings Manager, see “Infrastructure 
Settings” in Platform Administration.
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Chapter 1 • Working in Reports
Note: 

➤ In certain reports, the selected time range is displayed along the x-axis. 
HP Business Availability Center breaks down the time range according to 
segments that differ depending on the selected time range. For details, 
see “Report Times” on page 320.

➤ Depending on the time range you select, HP Business Availability Center 
generates reports using either raw data or aggregated data. A note is 
displayed in the report when aggregated data is used. For details, see 
“How Reports Use Aggregated Data” on page 311.

Animating Report Charts with Macromedia Flash Player

You can choose to use Macromedia Flash Player to render report charts, to 
control the flow of information and add interest to your reports. 

Your users must have Flash Player installed on their machines. If they do 
not, the browser displays a message containing instructions on 
downloading Flash Player.

The reports that support the use of Flash Player are those that include charts. 
Scatter charts are not supported.

Pie charts in Flash reports have the following functionality, available from 
the context menu (opened by right-clicking on the chart):

➤ Enable Rotation. When this option is selected, you can click and drag to 
rotate the pie. Toggles with Enable Slicing Movement.

➤ Enable Slicing Movement. When this option is selected, you can click on a 
pie slice to slide it out from the main pie. Toggles with Enable Rotation.

➤ View 2D/View 3D. Toggle between these options as required.
22



Chapter 1 • Working in Reports
By default, the KPIs Distribution Over Time, KPIs Summary, and KPIs Trend 
reports (available in Dashboard and My BAC Business Dashboard) use Flash 
with a built-in one second delay for rendering the reports. If required, you 
can remove the delay (so that the reports are immediately displayed fully 
rendered). To remove the delay, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Reports Delay Time entry in the 
Business Reports Properties table. Modify the value to False.

For details on customizing Flash Player charts, contact Customer Support.
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2
Sharing and Storing Reports

You can share and store reports using various methods, including printing, 
exporting to other formats, and storing in a repository for future access.

About Sharing and Storing Reports

HP Business Availability Center provides the following functionality for 
sharing and storing reports that you generate:

➤ sending a report to a printer or saving a report in .pdf format

➤ formatting a report in .csv, Excel, or .xml format

➤ exporting a report, by sending it by e-mail, publishing it, or saving it to the 
report repository

This chapter describes: On page:

About Sharing and Storing Reports 25

Printing Reports 26

Formatting Reports 28

Exporting Reports 31
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Chapter 2 • Sharing and Storing Reports
Depending on the type of report you are viewing, some or all of the 
following buttons are available:

Printing Reports

You can send a report directly to a printer or produce a printer-friendly 
report in .pdf format.

This section includes the following topics:

➤ “Printing a Report” on page 27

➤ “Producing a Printer-Friendly Report in .pdf Format” on page 27

Category Click to...

produce a .pdf format file. For details, see “Producing a 
Printer-Friendly Report in .pdf Format” on page 27.

 send a report to a printer. For details, see “Printing a 
Report” on page 27.

produce a .csv format file. For details, see “Saving a Report 
in .csv Format” on page 28.

produce an Excel format file. For details, see “Saving a 
Report in Microsoft Excel Format” on page 29.

produce an .xml format file. For details, see “Saving a 
Report in .xml Format” on page 30.

send a report by e-mail. For details, see “Sending a Report 
by E-Mail” on page 31.

publish a report with updated data. For details, see 
“Publishing a Report” on page 33.

save a report to the report repository. For details, see 
“Saving a Report to the Report Repository” on page 36.
26



Chapter 2 • Sharing and Storing Reports
Printing a Report

Tip: Before printing, ensure that printer settings are set to print the selected 
frame, and not to print frames as laid out on screen.

To obtain optimal print results if you are using Microsoft Internet Explorer, 
enable the Print background color and images option (Tools > Internet 
Options > Advanced tab > Printing).

To print a report:

 1 Click the Printer-Friendly Report button to open a window displaying the 
printer-friendly report.

 2 To print the report, click the browser’s Print button, or right-click on the 
page and select Print.

Producing a Printer-Friendly Report in .pdf Format
The following procedure explains how to produce a printer-friendly report 
in .pdf format.

To produce a report in .pdf format: 

 1 In any report, click the Open in PDF Format button to display the report in 
.pdf format in a new browser window.

 2 Follow the Adobe Acrobat instructions to print or save the file in your local 
file system. 
27



Chapter 2 • Sharing and Storing Reports
Note: When producing a hierarchal UCMDB report, the size of the .pdf is 
limited to the default number of data units defined for your environment. 
The default value is 400. A data unit is the information displayed under a CI 
in a report. In a table, each row is counted as one data unit. If this value does 
not suit your needs and must be modified, contact Customer Support. 

If the file you are producing contains more than the allotted number of data 
units, the .pdf file is truncated.

The affected UCMDB reports are: 

➤ System Report

➤ Asset Report

➤ Related CI’s Report

➤ Correlation Report

➤ Export Package to Report

Formatting Reports

You can format a report in .csv, Excel, or .xml format.

This section includes the following topics:

➤ “Saving a Report in .csv Format” on page 28

➤ “Saving a Report in Microsoft Excel Format” on page 29

➤ “Saving a Report in .xml Format” on page 30

Saving a Report in .csv Format
The following procedure explains how to save a report in .csv format. Only 
those reports that support this functionality include the CSV button.
28



Chapter 2 • Sharing and Storing Reports
To save a report in .csv format:

 1 In a report, click the CSV button to open the report in a new browser 
window.

If your browser does not display the .csv file in a new window (for example, 
if you do not have Microsoft Excel installed on the machine), follow your 
browser’s instructions to view the file or save it to disk.

 2 Select File > Save As, choose a path, file name, and file format type 
(Microsoft Excel, .csv, and so on), and click Save.

Note: For the CSV formatted report to display correctly, the comma (,) must 
be defined as the list separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the Control Panel, and on the 
Numbers tab ensure that the comma is defined as the List Separator value. 
In Solaris, you can specify the list separator in the application that opens 
the CSV file.

Saving a Report in Microsoft Excel Format
The following procedure explains how to save a report in Microsoft Excel 
format. Only those reports that support this functionality include the Excel 
button.

Note: Microsoft Office Excel 2002 or later must be installed on the client 
machine from which you are generating the report.

To format a report in Excel format:

 1 In a report, click the Excel button .

 2 Choose whether you want to display the report or save it. To save the file, 
click Save, and in the browser that opens, choose a path and file name and 
click Save.
29



Chapter 2 • Sharing and Storing Reports
Any tooltips in the report are converted to comments in Microsoft Excel. To 
view all the text of a large tooltip, edit the comment by right-clicking the 
cell and choosing Edit Comment. Enlarge the box by dragging a corner: 

Saving a Report in .xml Format
You can save a report in .xml format to send to users, or to insert into other 
reports. The data in the XML file is not updated. Only those reports that 
support this functionality include the XML button.

To open a report in .xml format:

 1 In any of the reports that support this functionality, click the Open in XML 
Format button to open the report in a new browser window.

 2 Select File > Save As, choose a path, file name, and .xml file format type and 
click Save. This step is optional.
30



Chapter 2 • Sharing and Storing Reports
Tip: To extract HTML code from the report, save the file as HTML, open the 
file in an HTML editor, and copy the relevant table into the target file. 

Exporting Reports

You can send a report by e-mail, publish a report with updated data, or save 
a report to the report repository.

This section includes the following topics:

➤ “Sending a Report by E-Mail” on page 31

➤ “Publishing a Report” on page 33

➤ “Saving a Report to the Report Repository” on page 36

Sending a Report by E-Mail
The following procedure explains how to send a report by e-mail.

To send a report by e-mail:

 1 Click the E-mail this Report button to open the Mail Details window.

 2 Change the default subject, if required.

 3 Specify one or more e-mail addresses in the To box. Separate multiple 
addresses using a semi-colon.

 4 Specify an e-mail address for receiving replies in the Reply-to box.

If required, an e-mail address can be configured to appear in the Reply-to 
field by default. This is done in the Infrastructure Settings Manager. Select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, click 
Foundations, select Business Availability Center, and locate the Default 
Reply-To Address entry in the Business Availability Center Interface - Display 
table. Update the value as required. 

For details on using the Infrastructure Settings Manager, see “Infrastructure 
Settings” in Platform Administration.
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 5 If required, type a comment in the Comments box.

 6 Specify whether you want to send the report as:

 a HTML mail. The report is displayed in the e-mail client (the e-mail client 
must support, and be configured to display, HTML).

➤ Select Include Images to include all report resources (for example, 
graphics) in the e-mail. 

➤ Clear Include Images so the images are not included in the e-mail. In 
that case, all report resources (for example, graphics) are located on 
HP Business Availability Center servers. A network connection to 
HP Business Availability Center is required to view the images in the 
report.

 b HTML attachment. The report is displayed in a browser (the browser 
must support the MHT format—Microsoft Internet Explorer supports 
MHT format, for example). 

➤ Select Send as Internet Explorer Archived HTML. The report is 
displayed in a browser (the browser must support the MHT format—
Microsoft Internet Explorer supports MHT format, for example). All 
report resources (for example, graphics) are included in the e-mail.

➤ Select Zipped attachment to send the attachment in zipped format. 

 c PDF. The report is displayed in .pdf format in a new browser window.

➤ Select Zipped attachment to send the attachment in zipped format. 

Note: If you choose to use a mail option that displays the report content in 
the e-mail client, check that the e-mail client does not employ security 
restrictions which prevent the running of scripts contained in HTML mail. 
E-mail clients that do employ such restrictions may be unable to properly 
display all report content.

 7 Click OK to e-mail the report.
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Publishing a Report
You can generate up-to-date reports that can be viewed by users who do not 
usually work with HP Business Availability Center, and, therefore, do not 
know how to create reports. However, these users must have a network 
connection to HP Business Availability Center to view the report. You 
publish the reports in .csv format, Excel format, .xml format, or printer-
friendly format, and send the report (generally, by e-mail) to the user. 

The report contains data that is updated when the report is accessed. For 
example, say you prepare a report for the past month (24 Oct 2005 8:00 AM 
– 21 Nov 2005 8:00 AM), publish the report, and send the URL or an HTML 
file of the report to a user. The user accesses the report a week later (on 28 
Nov 2005), at which time the report shows the updated past month 
(31 Oct 2005 8:00 AM – 28 Nov 2005 8:00 AM). 

You would probably publish reports that use a relative tracking period (for 
example, past month, month to date), as it may not be useful to publish 
reports that use an absolute tracking period (for example, hour, day, 
month). 

You can choose between two methods for publishing reports: URL and 
HTML. Use URL to submit the form with a GET method (recommended), 
and HTML to submit the form with a POST method.

For a list of reports that you can publish, see the list of customizable reports 
in “Defining a Default Header and Footer” in Custom Reporting and Alerting. 
You can also view a list of these reports in the Report Types window 
accessed from the Report Repository page. For details, see “Searching for a 
Report in the Report Repository” on page 126.
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To publish a report in .csv, Excel, .xml, or printer-friendly format:

 1 Set up the report that you want to publish. Where relevant, choose the 
Graph or Table format. 

Tip: Choose only from tracking periods that show data when the user 
accesses the report. For example, say you set up the Triage report to show 
data for the past hour, then send the report to a user. If the monitor being 
tracked by the profile is going down shortly, the user’s past hour does not 
include data.

 2 Click the Publish Report button to open the Publish Report window.

 3 Choose the format in which you want to publish the report: CSV, Excel, 
XML, or Printer-Friendly. 

➤ CSV. The report is formatted as a comma-separated values (CSV) text file 
that can be displayed in a spreadsheet.

➤ Excel. The report is formatted as an .xls (Excel) file that can be displayed 
in a spreadsheet. 

➤ XML. The report is formatted as an XML file that can be opened in a text 
or XML editor. 

➤ Printer-Friendly. The report is saved in HTML format for printing 
purposes.

 4 Enter a login name and password which enable the user to log in to 
HP Business Availability Center, view the report, and log out. 
34



Chapter 2 • Sharing and Storing Reports
Note: 

➤ The default login name and password are those with which you logged in 
to HP Business Availability Center in the current session. 

➤ Do not publish the report with administrator permissions. We 
recommend that you create a login name and password for the user with 
less permissions than for an administrator. For details, see “User 
Management Overview” in Platform Administration. 

➤ If you include your own user name and password in the URL or the 
HTML file, when the user closes the report, you are simultaneously 
logged out of HP Business Availability Center. 

➤ The user name and password are encrypted in the URL or the HTML file.

➤ The log in and log out steps are transparent to the user.

 5 Choose whether to send the URL of the report (recommended) or to send 
the report as an HTML file. Click Generate URL or Generate HTML: 

➤ Generate URL. HP Business Availability Center generates the URL and 
displays it in the window. Click Copy to select the URL, then paste the 
URL into an e-mail to send to the user. It is recommended that the URL 
does not exceed a maximum length of 2,000 characters (~2K), to ensure 
that the URL can be read by all systems. 

Note: Do not modify the URL string. If necessary, make changes to the 
report itself, then publish the report again.

➤ Generate HTML. The File Download window opens and you can choose 
to open or save the file. Click Open to open the report in a browser in the 
selected format. Click Save, and, in the Save As dialog box that opens, 
locate the directory where you want to save the file, and click Save.
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Tip: To extract HTML code from the published report, choose the XML 
format and click Generate URL or Generate HTML. Continue with the 
relevant procedure to publish the report. Click Open to display the report in 
HTML markup in a browser. Save the file as HTML, open the file in an HTML 
editor, and copy the relevant table into the target file. 

Saving a Report to the Report Repository
You can save the data of certain reports to a report repository, for viewing on 
other occasions, or for sending to other users. The report is saved with data 
valid at the time the report is saved. This is the case even if data 
subsequently changes, or more data accrues to the report. You access the 
report through Dashboard, Service Level Management, or End User 
Management (Triage report only). 

For a list of reports that you can save to the repository, see the list of 
customizable reports in “Defining a Default Header and Footer” in Custom 
Reporting and Alerting. You can also view a list of these reports in the Report 
Types window accessed from the Report Repository page. For details, see 
“Searching for a Report in the Report Repository” on page 126.

Note: The Report Repository icon is enabled only on the pages of reports 
that can be saved to the repository.

To save a report to the repository:

 1 Click the Save to Repository button to open a window displaying the report 
in PDF format.

 2 Enter a name for the report. 

 3 Choose whether the report should be available to all users (Public), or only 
to yourself and the administrators (Private).
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Public: any user can view, edit, or delete the report from the repository. 
Private: only the user or administrator can view, edit, or delete the report 
from the repository. (For HP Managed Software Solutions customers: Private: 
only the user, superuser, operator, customer superuser, and customer 
administrator can view, edit, or delete the report from the repository.) 

 4 Enter a description for the report.

 5 Click OK, or click Cancel to close the window without saving the report.

The report is displayed in the application page.
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Topology Map Printing Options

This chapter describes how to print the contents of the topology map and 
save a topology map to file.

Printing the Contents of the Topology Map

You can print the contents of the topology map. The result is similar to a 
screen capture. It is therefore recommended to define your print settings 
and arrange the contents of the topology map according to your 
requirements before printing.

To print the contents of the topology map:

 1 Select and display the contents of the topology map to be printed.

 2 Define your print settings. For details, see “Defining the Print Settings for a 
Map” on page 40.

 3 Arrange the contents of the topology map for print. You can use the Layout 
option and Layout Properties. For details about the layout options, see 
“Toolbar Options” on page 49. For details about layout properties, see 
“Layout Properties User Interface” on page 57. 

 4 From the toolbar, select Print Map > Print Map to open the Print dialog box.

This chapter describes: On page:

Printing the Contents of the Topology Map 39

Defining the Print Settings for a Map 40

Previewing the Topology Map Before Printing 41

Saving a Topology Map to File 41
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 5 In the Copies area, enter the number of copies you want to print.

 6 Click Properties to open the Document Properties dialog box.

 7 Define document properties as required and click OK to save your changes.

 8 Click OK in the Print dialog box to print the contents of the topology map.

Defining the Print Settings for a Map

This section describes how to define the print settings for a map.

To define the print settings for a map:

 1 Select Print Map > Map Printing Settings to open the Map Printing Settings 
dialog box.

 2 Select Print Entire Drawing to print the complete view.

 3 Select Print Current Window to print the part of the view that appears in the 
window.

 4 Select Print Current Selection to print the selected notes and their 
relationships.

 5 In the Scale By area:

➤ Select Pages and enter the number of columns and rows in the Page 
Columns and Page Rows boxes. 

➤ Select Actual Size to print the view as it really is.

➤ Select Zoom Level to print the view at the current zoom level.

 6 In the Caption area:

➤ Select Print Caption, enter the caption in the text area and click Font to 
select the required custom font.

➤ Select the position of the caption in the Position list.

 7 In the Multipage Printing area:

➤ Select Print Page Numbers to print the page numbers.

➤ Select Print Crop Marks to print the crop marks.
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 8 In the Other area:

➤ Select Print Border if you want the printed view to have a border and 
click Color to select the required border color.

➤ Select Print Background to print the background behind the view.

➤ Select Print Grid if you want to print a grid behind the printed view.

 9 Click Page Setup to set the printer settings.

 10 Click OK. These definitions are applied to your printouts.

Previewing the Topology Map Before Printing 

You can preview the content of the topology map before printing.

To preview the content of the topology map before printing:

 1 Select Print Map > Print Preview to open the Print Preview window.

 2 To define the print settings for the map, click Print Setup. For details, see 
“Defining the Print Settings for a Map” on page 40.

 3 Use the Zoom options to focus on specific details of the map. For details, see 
“Toolbar Options” on page 49.

 4 To fit the complete view in the window, click Fit in Window.

 5 To print the map, click Print. For details, see “Printing the Contents of the 
Topology Map” on page 39.

 6 Click Close to close the Print Preview window.

Saving a Topology Map to File

You can save a topology map to a file.

To save a topology map to a file:

 1 Select and display the topology map you want to save to file.

 2 Select Print Map > Export Graph to open the Export Graph dialog box.

 3 From the Type list, select the required file format.
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 4 In the File Name box, specify the required file name and location (or click 
Browse to search for the file and location).

 5 In the Image Content area:

 a Select Visible Window Only to save only the part of the graph that 
appears in the window.

 b Select Draw Grid to draw a grid in the graph.

 c Select Selected Objects Only to save only the nodes/CIs that you selected 
and their relationships.

 6 In the Image Characteristics area, enter a value in the Image Quality (0-100) 
window or move the indicator left or right to set the required quality of the 
printed map on the scale. 100 means that the quality is excellent.

 7 In the Size area, do the following:

 a Select Current Zoom Level to save the view as you see it on the topology 
map. For example, if you have used the Interactive Zoom mode to 
decrease the view magnification, the nodes also appear smaller in the 
saved view. For details, see “Interactive Zoom” on page 53.

 b Select Actual Size to save the view so that the node sizes are at maximum.

 c Select Fit in Canvas to expand or shrink the view so it fits in the window.

 d Select Custom to specify the size of the view you want to save in the 
Width and Height boxes. 

 8 Click OK.
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Working with Tables

This chapter describes how to customize tables.

Columns Dialog Box

This chapter describes: On page:

Columns Dialog Box 43

Customizing Columns 44

Select Columns Dialog Box 45

Set Page Number Dialog Box 46

Set Rows Per Page Dialog Box 46

Description Enables you to choose the information you are interested 
in displaying. You can change the display order of the 
columns, hide a column, or display a hidden column.

To access: Right-click a column header and select 
Customize or click  Customize Columns.
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The Columns dialog box includes the following elements (listed 
alphabetically):

Customizing Columns

GUI Element Description

Displays a hidden column. Moves the selected column 
from the Hidden Columns pane to the Visible Columns 
pane.

Hides a selected column. Moves the selected column from 
the Visible Columns pane to the Hidden Columns pane.

Note: Alternatively, you can right-click the required 
column in the table itself and select Hide Column.

Displays all hidden columns. Moves all the columns from 
the Hidden Columns pane to the Visible Columns pane 
(whether or not the columns are selected).

Note: Alternatively, you can right-click the required 
column in the table itself and select Show All Columns. 
This option only appears if at least one column has 
already been hidden.

Hides all selected columns. Moves all the columns from 
the Visible Columns pane to the Hidden Columns pane.

Moves one selected column up or down to determine the 
position of the column in the Statistics pane.

Hidden Columns The columns in this pane do not appear in the table.

Visible Columns The columns in this pane are visible in the table.

Description Enables you to customize tables by changing column 
width, changing the display order of the columns, or 
displaying only specific columns.
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The following options are available by right-clicking or clicking a table 
header (listed alphabetically):

Select Columns Dialog Box

The Select Column dialog box includes the following elements (listed 
alphabetically):

GUI Element Description

Click a column header to sort its contents. An upward arrow 
indicates ascending order and a downwards arrow indicates 
descending order.

Auto-resize 
Column

Right-click the column header to change the column width 
to fit the contents.

Customize Right-click the column header to change the display order of 
the columns. Opens the Columns dialog box.

Hide Column Right-click the column header of the column to hide the 
column.

Show All Columns Right-click the column header to display all hidden 
columns. Displayed when a column is hidden.

Description Enables you to select the columns to be displayed.

To access: Click the Select Columns  button in the 
Asset, Host Dependency, Change, and System reports.

GUI Element Description

Displays a column. Moves the selected column from the 
Available Columns pane to the Visible Columns pane.

Hides a selected column. Moves the selected column from 
the Visible Columns pane to the Available Columns pane.

Displays all hidden columns. Moves all the columns from 
the Available Columns pane to the Visible Columns pane.
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Set Page Number Dialog Box

The Set Page Number dialog box includes the following elements:

Set Rows Per Page Dialog Box

Available Columns The columns in this pane do not appear in the table. 
Select the columns to be included in the report.

Default Restores the report columns to their original status.

Visible Columns The columns in this pane are visible in the table.

Description Enables you to go directly to a required page.

A table can contain more than one page depending on 
how many rows can appear in each page of the table (for 
details, see the Set Rows Per Page dialog box). 

The numbers between the left and right arrows of a table 
indicate which page is currently being displayed. For 
example, 1/7 means that the 1st of 7 pages is displayed.

To access: Click the Go to page  button in a table.

Useful Links “Set Rows Per Page Dialog Box” on page 46

GUI Element Description

Page Enter the required page number to go to a different page.

Description Enables you to determine the number of node/CI 
instances that appear on a page. Enter the required 
number in the Set rows per page field.

To access: Click Set Rows Per Page  in a table.

GUI Element Description
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The Set Rows Per Page dialog box includes the following elements:

GUI Element Description

Set rows per page Enter the required number.
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Toolbar Options

The following table contains a description of each toolbar option, organized 
alphabetically.

Note: These toolbar options are relevant for Universal CMDB applications.
49



Chapter 5 • Toolbar Options
 

Button Option Name Use This Option to...

Add 
Background 
Image

Add a background image to a view. For details, see “Add 
Background Image Dialog Box” in IT World Model Management.

To access: Open the drop-down menu under Hierarchical 
Layout.

Note: This option is only active in IT Universe Manager and the 
Topology View application.

Additions 
Count

Calculate the number of instances that are created as a result of 
an Enrichment Rule. The number of TQL node instances and 
relationships that are created appear next to the Enrichment 
nodes/relationships, as seen in the figure below.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Candidates 
for Deletion

Identify the CIs in the current view which are candidates for 
deletion.

Note: This option appears in the toolbar in the Topology map in 
the Topology View application only.

Change 
labels size

Enter the maximum number of characters that the labels should 
contain.

To access: Open the drop-down menu under Drag Map.
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Clear 
Correlation

Clear the Topology View of the statuses of the trigger and 
affected CIs for the state Change. CI statuses only appear after 
using the Run Correlation dialog box to run an Impact Analysis 
report for the selected CIs on a set of the existing Correlation 
rules. For details, see “Run Correlation Dialog Box” in IT World 
Model Management. For details on Correlation rules, see 
“Correlation Manager User Interface” in IT World Model 
Management.

Note: This option appears in the toolbar in the Topology map in 
the Topology View application only.

Create 
Relationship

Create a relationship between two existing TQL nodes. For 
details, see “Adding Nodes and Relationships to a TQL Query” 
on page 189.

Create a relationship between existing CIs. For details, see 
“Attaching Existing CIs” in IT World Model Management. 

Delete Delete a CI from IT Universe Manager, a node from View 
Manager, a TQL node from Query Manager, Correlation 
Manager, Report Manager, or Enrichment Manager, or a CIT 
from CI Type Manager. 

Note: When you delete a CIT from the CI Type Manager, the 
CIT no longer appears in the CI Type Model, the View Manager, 
the Enrichment Manager, and the Query Manager. To restore it, 
you must redeploy the package that contains the deleted CIT. 
For details, see “Package Manager User Interface” in IT World 
Model Management.

Drag map Drag the view.

Export Graph Save the topology map to a file. For details, see “Saving a 
Topology Map to File” on page 41.

To access: Open the drop-down menu under Print Map.

Fit to 
Window

Fit the complete map in the window.

Button Option Name Use This Option to...
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Get Related 
CIs report

Display the Get Related CIs Report for the selected CI. For 
details, see “Get Related CIs Report” in IT World Model 
Management.

Note: This option appears in the toolbar in the Related CIs tab 
of IT Universe Manager and the Topology View application.

Go up one 
layer

Move up one level in the topology map. This option is enabled 
only if there is an additional CI, CIT, or TQL node layer above it, 
created by a parent or child organization rule defined in the 
View Manager. For information on how to set up organization 
rules, see “Adding Folding Rules to Relationships” in IT World 
Model Management. 

Hide All 
Inheritance_f 
From Map

Toggle between showing and hiding Inheritance_f relationships 
and their connecting node.

To access: Open the drop-down menu under Select All.

Note: This option appears in the topology map toolbar in CI 
Type Manager only.

Hide All Node 
Labels

Toggle between showing or hiding the CI/CIT/node/pattern 
labels.

To access: Open the drop-down menu under Select All.

Note: The icon appears only in Dashboard.

Hide All 
Relationship 
Labels

Toggle between showing or hiding the relationship labels.

To access: Open the drop-down menu under Select All.

Note: The icon appears only in Dashboard.

Hide All 
Relationships

Toggle between showing and hiding the relationships in the 
displayed map.

To access: Open the drop-down menu under Select All.

Button Option Name Use This Option to...
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Hierarchical 
Layout

Select the layout display from the list. The options are:

➤  Hierarchical. Enables you to display the precedence 
relations in the topology map.

➤  Symmetric. Enables you to display clear representations 
of complex networks.

➤  Circular. Groups a graph’s nodes into groups or clusters.

➤  Orthogonal. Enables you to display views of outstanding 
clarity that are achieved by employing only horizontal and 
vertical edge routing.

➤  Manual. Enables you to display the changes you have 
made manually to the topology map. 

Note: Click Save Layout to save the selected layout.

For further details about each of the options, see “Layout 
Properties User Interface” on page 57. 

Import Import XML files containing CI types into the CI Type Manager.

Note: This option appears in the topology map toolbar in CI 
Type Manager only.

Insert 
CI/Insert 
Related CI

Create a new CI. For details, see “Working with CIs” in IT World 
Model Management.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Interactive 
Zoom

➤ Decrease the view magnification by clicking and pushing the 
pointer upwards.

➤ Magnify the view by clicking and pulling the pointer 
downwards.

To access: Open the drop-down menu under Drag Map.

Layout 
Properties

Define the view’s layer layout, by assigning positions for the 
nodes and relationships of the view. For details, see “Layout 
Properties User Interface” on page 57. 

To access: Open the drop-down menu under Hierarchical 
Layout.

Layout Select the layout display from the list as described in 
Hierarchical Layout. For further details about each of the 
options, see “Layout Properties User Interface” on page 57. 

Button Option Name Use This Option to...
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Map 
overview

Open a small window with a copy of the topology map. This is 
useful in large views when zooming in.

To access: Open the drop-down menu under Drag Map.

Map Printing 
Settings

Define print settings for printing the topology map. For details, 
see “Topology Map Printing Options” on page 39.

To access: Open the drop-down menu under Print Map.

Navigation Take the pointer to the next connected CI/CIT/TQL node in a 
clockwise direction.

➤ Left-click to move in a clockwise direction.

➤ Right-click to point to the next CI/CIT/node/pattern in a 
clockwise direction. 

To access: Open the drop-down menu under Drag Map.

Note: You can use this option only on CI/CIT/nodes/patterns 
that are connected by relationships.

Place in 
Center

Places the selected CI/node/CIT/pattern in the center of the 
map.

To access: Open the drop-down menu under Drag Map.

Print Map Print the contents of the topology map. For details, see 
“Topology Map Printing Options” on page 39.

Print Preview Preview the contents of the map before printing.

To access: Open the drop-down menu under Print Map.

Rediscover 
View

Rediscover all the CIs in a selected view by manually starting the 
Discovery jobs that originally discovered them.

Remove 
Enrichment 
Results

Remove the instances created from an Enrichment rule from the 
CMDB.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Reorganize 
Layer

Reorganize the CIs/CITs/ TQL nodes according to the selected 
layer. This is used when CIs/CITs/TQL nodes have been moved 
around.

Button Option Name Use This Option to...
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Save Save new and changed definitions in each of the following 
managers:

➤ TQL queries in Query Manager. 

➤ Views in View Manager. 

➤ Correlation rules in Correlation Manager. 

➤ Enrichment rules in Enrichment Manager.

➤ System Reports in the Report Manager. 

Save Layout Save changes to the layout. To retrieve the layout you have 
saved, select Manual Layout. For details, see “Hierarchical 
Layout” on page 53.

To access: Open the drop-down menu under Hierarchical 
Layout.

Note: This option appears in the toolbar in IT Universe Manager 
and Topology View application only.

Show 
Schedule Info

Display the scheduling information for the selected job. For 
details, see “Discovery Scheduler Dialog Box” in Discovery.

Note: This option appears in the toolbar in the Dependency 
Map tab of Discovery. For details, see “Dependency Map Tab” in 
Discovery.

Select All Select all the CIs and relationships in a selected layer.

Select All 
Nodes

Select all the nodes in a selected layer.

To access: Open the drop-down menu under Select All.

Select Mode Select a CI/CIT/TQL node or multiple CIs/CITs/TQL nodes.

System Type 
Manager

Create a predefined list whose values define an attribute type. 
For details, see “System Type Manager User Interface” in 
CI Attribute Customization. 

Note: This option is specific to the toolbar in CI Type Manager.

Button Option Name Use This Option to...
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TQL result 
count

Calculate the number of instances found for each TQL 
node/relationship.

Zoom Zoom in on a specific section of the topology map by clicking 
and drawing a selection rectangle around the part to magnify. 
The area you select is displayed at the highest percentage that 
fits in the topology map.

To access: Open the drop-down menu under Drag Map.

Button Option Name Use This Option to...
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Layout Properties User Interface

This chapter includes the pages and dialog boxes that are part of the Layout 
Properties user interface.

Circular Tab

This chapter describes: On page:

Circular Tab 57

Disconnected Tab 61

General Tab 64

Hierarchical Tab 65

Layout Properties Dialog Box 76

Orthogonal Tab 77

Routing Tab 79

Symmetric Tab 83

Description Enables you to group a graph’s nodes into groups or 
clusters based on the grouping options you select. It is 
particularly suited for visualizing ring and star network 
topologies, and for link analysis. 

To access: Click the Circular tab in the Layout Properties 
dialog box.
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This tab consists of the following areas:

➤ “Clustering Area” on page 58

➤ “Cluster Layout Style Area” on page 58

➤ “Layout Quality Area” on page 59

➤ “Spacing Area” on page 60

Clustering Area

The Clustering area includes the following elements (listed alphabetically):

Cluster Layout Style Area

Description Specifies the ratio between the average cluster size and 
the number of clusters as well as the minimum and 
maximum number of clusters in a layer. 

GUI Element Description

Cluster Size 
Multiplier

Specifies the ratio between the average cluster size and 
the number of clusters. The size of a cluster is defined as 
the sum of the weights of all nodes in the cluster. You can 
assign a weight value to each node.

Max Number of 
Clusters

The maximum number of clusters in a layer.

Min Number Of 
Clusters

The minimum number of clusters in a layer.

Description Displays clusters either in a symmetric or circular layout 
style.
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The Cluster Layout Style area includes the following elements (listed 
alphabetically):

Layout Quality Area

The Layout Quality area includes the following elements (listed 
alphabetically):

GUI Element Description

Circular Displays clusters in a circular layout style.

Symmetric Displays clusters in a symmetric layout style.

Description Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

GUI Element Description

Draft Sets the layout to draft quality.

Default Sets the layout to default quality.

Proof Sets the layout to proof quality.
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Spacing Area

The Spacing area includes the following elements (listed alphabetically):

Description  Sets the spacing around each node within the same 
cluster and between clusters.

GUI Element Description

Cluster Spacing Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

This illustration shows larger cluster spacing.

Node Spacing Sets the spacing around each node within the same 
cluster. The larger the spacing, the more nodes there are 
on the cluster boundary. 

Default value: 10

This illustration shows smaller node spacing.

This illustration shows larger node spacing.
60



Chapter 6 • Layout Properties User Interface
Disconnected Tab 

This tab consists of the following areas:

➤ “Aspect Ratio Area” on page 62

➤ “Components Area” on page 62

➤ “Disconnected Nodes” on page 63

Description Enables you to define general layout parameters for 
disconnected nodes and connected components. 

➤ A disconnected node is a node that is not connected to 
any other node.

➤ A disconnected component is a component that is not 
connected to any other component. It contains a set of 
nodes that can be connected to each other.

The following example illustrates a connected 
component with five nodes:

The following example illustrates a connected 
component with two nodes:

The following example illustrates four disconnected 
components, each made up of a single, disconnected 
node:

To access: Click the Disconnected tab in the Layout 
Properties dialog box. 
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Aspect Ratio Area

The Aspect Ratio area includes the following elements (listed 
alphabetically):

Components Area

The Components area includes the following elements (listed 
alphabetically):

Description Sets the layout’s proportions. This setting affects the 
placement of components with respect to each other 
only, and not the layout of each individual component. 
The setting has no effect if the graph is connected.

GUI Element Description

Automatic The layout is performed automatically.

Custom Sets a specific aspect ratio.

Default value: 1.0

Description The spacing between the components in a disconnected 
graph consists of both a constant value and a 
proportional value based on the sizes of the components.

GUI Element Description

Constant Spacing Set constant spacing (horizontal and vertical) around 
each disconnected component. 

Default value: 20
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Disconnected Nodes

The Disconnected Nodes area includes the following elements (listed 
alphabetically):

Detect Components Select this option to view the disconnected components. 
You can specify that all components be laid out together 
or individually, regardless of the other components. If the 
grouping for components is selected, each component is 
laid out, and the resulting components are packed 
together.

Proportional Spacing Set spacing (horizontal and vertical) that is proportional 
to the size of the component around each disconnected 
component. 

Default value: 0.05

Description The spacing between the nodes in a disconnected graph 
consists of both a constant value and a proportional value 
based on the sizes of the nodes.

GUI Element Description

Constant Spacing Sets constant spacing (horizontal and vertical) around 
each disconnected node. 

Default value: 20

Detect Disconnected 
Nodes 

Select this option to view the disconnected nodes. You 
can specify that disconnected nodes be grouped into one 
component or laid out individually.

Proportional Spacing Set spacing (horizontal and vertical) that is proportional 
to the size of the component, around each disconnected 
node. 

Default value: 0.05

GUI Element Description
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General Tab

The tab consists of the following areas:

➤ “Margin Spacing Area” on page 64

➤ “Nested View Spacing” on page 65

Margin Spacing Area

The Margin Spacing area includes the following elements (listed 
alphabetically):

Description Enables you to define a general layout for all layout types. 
The General tab settings are available with all layout 
styles. If the layout contains more than one graph, each 
graph is laid out separately, and the intergraph edges (the 
relationships between the graphs) are routed.

To access: Click the General tab in the Layout Properties 
dialog box.

Description The layout’s proportions. This only affects the placement 
of components with respect to each other, not the layout 
of each individual component. It has no effect if the 
graph is connected. 

GUI Element Description

Bottom The size of the space under the display. 

Default value: 20

Left The size of the space to the left of the display. 

Default value: 20

Right The size of the space to the right of the display. 

Default value: 20

Top The size of the space above the display. 

Default value: 20
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Nested View Spacing

The Nested View Spacing area includes the following elements (listed 
alphabetically):

Hierarchical Tab

Description Enables you to enclose a child graph inside a parent node, 
thereby creating a nesting hierarchy. When expanded, the 
parent node is resized to fit the child graph and, no 
matter what its shape, is represented as a rectangle large 
enough to accommodate the geometry of the nested 
graph. Nested View Spacing is the thickness of the 
expanded node’s border.

GUI Element Description

Bottom The thickness of the expanded node’s bottom border.

Default value: 10

Left The thickness of the expanded node’s left border.

Default value: 10

Right The thickness of the expanded node’s right border.

Default value: 10

Top The thickness of the expanded node’s top border.

Default value: 10

Description The hierarchical layout shows the precedence 
relationships that can represent organizational or 
information management system dependencies, as well 
as process models, software call graphs, and work flows. 
The hierarchical layout emphasizes dependencies by 
placing the nodes at different levels.

To access: Click the Hierarchical tab in the Layout 
Properties dialog box. 
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The Hierarchical tab includes the following elements (listed alphabetically):

GUI Element Description

Variable Level 
Spacing

Variable level spacing adjusts the spacing between pairs of 
neighboring levels according to the density of edges 
between the levels. 

If the drawing’s edges are orthogonally routed, this 
ensures the desired vertical spacing between horizontal 
edges (in a top-to-bottom or bottom-to-top layout) routed 
between levels. 

If the routing is polyline, variable level spacing makes it 
easier to distinguish among edges in very dense drawings.

Undirected Layout Edge direction is not used to build the levels of the 
hierarchical drawing.
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The tab consists of the following areas:

➤ “Horizontal Spacing Area” on page 67

➤ “Layout Quality Area” on page 70

➤ “Level Alignment Area” on page 70

➤ “Orientation Routing Area” on page 71

➤ “Polyline Routing Area” on page 73

➤ “Routing Area” on page 74

➤ “Vertical Spacing Area” on page 76

Note: Orthogonal Routing is currently not supported.

Horizontal Spacing Area

Description Enables you to set the minimum horizontal distance 
between two neighboring nodes at each level.
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The Horizontal Spacing area includes the following elements (listed 
alphabetically):

GUI Element Description

Spacing Between 
Edges

This setting is available only when you select Routing > 
Orthogonal. It sets a horizontal space between edges in 
the graph.

Default value: 12

This illustration shows smaller edge spacing.

This illustration shows larger edge spacing.
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Spacing Between 
Nodes

Sets a space around each node horizontally in the layer. 
Default value: 20

This illustration shows smaller node spacing.

This illustration shows larger node spacing.

GUI Element Description
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Layout Quality Area

The Layout Quality area includes the following elements (listed 
alphabetically):

Level Alignment Area

Description Enables you to adjust the quality of the layout produced 
to fit your application’s needs. The quality reflects the 
number of steps or the method used to produce the 
layout. For example, high quality is sharper but takes 
more time to set the layout.

GUI Element Description

Default Sets the layout to default quality.

Draft Sets the layout to draft quality.

Proof Sets the layout to proof quality.

Description Enables you to set the way nodes are vertically aligned.
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The Level Alignment area includes the following elements (listed 
alphabetically):

Orientation Routing Area

GUI Element Description

Bottom This illustration shows that the bottom of the nodes at 
the same level of the hierarchy are aligned.

Center This illustration shows that the center of the nodes at the 
same level of the hierarchy are aligned.

Top This illustration shows that the top of the nodes at the 
same level of the hierarchy are aligned.

Description Enables you to set the orientation of the hierarchy
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The Orientation area includes the following elements (listed alphabetically):

GUI Element Description

Bottom To Top The children are located below the parent (in the 
example, Alignment = Center).

Left To Right The children are located to the left of the parent (in the 
example, Alignment = Center).
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Polyline Routing Area

Right To Left The children are located to the right of the parent (in the 
example, Alignment = Center).

Top To Bottom The children are located above the parent (in the 
example, Alignment = Center).

Description Routes edges as one or more straight line segments with 
arbitrary angles. Polyline routed edges are prevented from 
overlapping by adding extra segments.

GUI Element Description
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The Polyline Routing area includes the following elements:

Routing Area

GUI Element Description

Spacing Between 
Ends (connecting 
lines)

This setting is available only when you select Routing > 
Polyline. Polyline routing routes edges (connecting lines) 
as one or more straight line segments with arbitrary 
angles. Path nodes are added automatically to prevent 
the edges (connecting lines) from overlapping.

Default Value: 12

Description Enables you to set the type of relationship between CIs. 
This option is useful when layers have nodes with a very 
large number of connecting relationships.
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The Routing area includes the following elements (listed alphabetically):

GUI Element Description

Orthogonal For orthogonal lines between nodes/CIs.

Polyline For straight lines between nodes/CIs.
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Vertical Spacing Area

The Vertical Spacing area includes the following elements (listed 
alphabetically):

Layout Properties Dialog Box

Description Enables you to set the minimum vertical distance 
between two neighboring nodes on different levels. 

GUI Element Description

Spacing Between 
Edges

This setting is available only when you select Routing > 
Orthogonal. It sets a vertical space between edges in the 
graph.

Default value: 12

Spacing Between 
Nodes

Sets a vertical space around each node in the level. 

Default value: 28

Description Enables you to customize the layout of a specific layer in 
a view, to achieve the clearest presentation possible and 
to better understand and monitor the managed data.

You define the layout of a view’s layers by assigning 
logical positions for the nodes and relationships that 
appear in a layer. You customize the layer layouts by 
modifying the default values.

Note: You set layout definitions for a specific layer only. 
The definitions cannot be saved for a different layer or a 
different view.

To access: From the toolbar of the Editing pane, select 
Layout > Layout Properties.

Important 
Information

Parameter values are in pixels.
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Orthogonal Tab

This tab consists of the following areas:

➤ “Aspect Ratio Area” on page 62

➤ “Horizontal Spacing Area” on page 78

➤ “Layout Quality Area” on page 78

➤ “Vertical Spacing Area” on page 78

Aspect Ratio Area

The Aspect Ratio area includes the following elements (listed 
alphabetically):

Description Enables you to set orthogonal layout route relationships 
horizontally and vertically. This results in relationships 
bending at 90-degree angles only.

Note: The Fix Node Sizes option is currently not 
supported.

Description Enables you to set the layout’s proportions. This only 
affects the placement of components with respect to each 
other, not the layout of each individual component. The 
layout’s proportions have no effect if the graph is 
connected. 

GUI Element Description

Automatic The layout is performed automatically.

Custom Specify the aspect ratio.

Default value: 1.0

Disabled Disables the aspect ratio.
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Horizontal Spacing Area

The Horizontal Spacing area includes the following elements (listed 
alphabetically):

Layout Quality Area

The Layout Quality area includes the following elements (listed 
alphabetically):

Vertical Spacing Area

Description Enables you to set the minimum horizontal distance 
between nodes.

GUI Element Description

Spacing Between 
Nodes

Set a space around each node in the layer. 

Default value: 20

Spacing Between 
Edges

Set a space between elements in the layer. 

Default value: 12

Description Enables you to adjust the quality of the layout produced 
to fit your application’s needs. The quality reflects the 
number of steps or the method used to produce the 
layout. For example, high quality is sharper but takes 
more time to set the layout.

GUI Element Description

Default Set the layout to default quality.

Draft Set the layout to draft quality.

Proof Set the layout to proof quality.

Description Enables you to set the minimum vertical distance 
between nodes.
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The Vertical Spacing area includes the following elements (listed 
alphabetically):

Routing Tab

GUI Element Description

Spacing Between 
Nodes

Sets a space around each node in the layer. 

Default value: 20

Spacing Between 
Edges

 Set a space between elements in the layer. 

Default value: 12

Description Enables you to produce drawings that leave nodes 
essentially where they are, and reroute the lines 
orthogonally. 

To access: Click the Routing tab in the Layout Properties 
dialog box.
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The Routing tab includes the following elements (listed alphabetically):

This tab consists of the following areas:

➤ “Horizontal Spacing Area” on page 80

➤ “Vertical Spacing” on page 82

Horizontal Spacing Area

The Horizontal Spacing area includes the following elements (listed 
alphabetically):

GUI Element Description

Fix Node Positions Maintain the position of all the nodes in the display. 
Clear this option for the layout to move the nodes if it is 
necessary to improve the layout. The movement is 
minimal, avoids overlaps, and minimizes bend points.

Fix Node Sizes Maintain the size of a node. Clear this option if you want 
the layout to increase the size of a node if it is necessary 
to maintain the specified relationship spacing when more 
than one relationship is attached to the same node side.

Description Enables you to set the horizontal space around each node.
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GUI Element Description

Spacing Between 
Edges

Sets the horizontal space between any two neighboring 
parallel lines. Line spacing can also affect the size of a 
node to which many lines are attached, unless the node is 
set to remain fixed at its current size. The settings for line 
spacing are constant values.

Default value: 12

The following illustrates smaller line spacing:

The following illustrates larger line spacing:
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Vertical Spacing

Spacing Between 
Nodes 

Sets the horizontal space around each node in the layer.

Default value: 20

The following illustrates smaller node spacing:

The following illustrates larger node spacing:

Description Enables you to set the vertical space around each node.

GUI Element Description
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The Vertical Spacing area includes the following elements (listed 
alphabetically):

Symmetric Tab

This tab consists of the following areas:

➤ “Layout Quality Area” on page 83

➤ “Spacing Options Area” on page 84

Layout Quality Area

GUI Element Description

Spacing Between 
Edges

Set the vertical space between any two neighboring 
parallel lines. Spacing between lines can also affect the 
size of a node to which many edges are attached, unless 
the node is set to remain fixed at its current size. The 
settings for edge spacing are constant values. 

Default value: 12

Spacing Between 
Nodes

Set the vertical space around each node in the layer. 

Default value: 20

Description Displays a clear representation of complex networks. The 
symmetric layout emphasizes the symmetries that may 
occur in a graph. 

To access: Click the Symmetric tab in the Layout 
Properties dialog box.

Description Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.
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The Layout Quality area includes the following elements (listed 
alphabetically):

Spacing Options Area

The Spacing Options area includes the following elements:

GUI Element Description

Default Set the layout to default quality.

Draft Set the layout to draft quality.

Proof Set the layout to proof quality.

Description Enables you to adjust the spacing around each node in 
the layer. 

GUI Element Description

Node Spacing Allows you to set constant horizontal and vertical 
spacing around each node in the layer. The value you 
specify is a guideline for the layout, so that it is possible 
that the spacing for a particular pair of nodes might be 
different from the one you specified. The larger the node 
spacing, the farther apart the nodes are spaced in the 
final layout.

Default value: 10

The following figure illustrates smaller and larger spacing.
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Regular Expression Examples

➤ Enter a regular expression to define an IP address (aa.yy.zz.mm):

➤ Enter a regular expression to create the label by the first or last letters of the 
selected attribute:

To: In the First Field 
Enter:

In the Second Field 
Enter:

Create label by aa (.*)([.].*[.].*[.].*) 1

Create label by yy (.*[.])(.*)([.].*[.].*) 2

Create label by zz (.*[.].*[.])(.*)([.].*) 2

Create label by mm (.*[.].*[.].*[.])(.*) 2

To: In the First Field 
Enter:

In the Second Field 
Enter:

Create label by the first letter (.)(.*) 1

Create label by the last letter (.*)(.) 2

Create label by the first two 
letters

(..)(.*) 1

Create label by the last two 
letters

(.*)(..) 2
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Naming Conventions

This chapter describes the conventions that should be followed when 
naming entities in HP Business Availability Center.

General Guidelines

Keep in mind the following general guidelines when naming entities:

➤ Due to certain Web browser limitations, the names of server machines 
running the HP Business Availability Center servers should only consist of 
alpha-numeric characters (a-z, A-Z, 0-9), hyphens (-), and periods (.). For 
example, if the names of the machines running the servers contain 
underscores, it may not be possible to log into the HP Business Availability 
Center Web site when using Microsoft Internet Explorer 6.0 or later. (To 
access the web site in this case, use the machine’s IP address instead of the 
machine name containing the underscore.)

➤ The HP Business Availability Center program directory, named HPBAC by 
default, cannot contain non-English characters.

➤ Names must begin with a letter.

➤ Name length should not exceed 50 characters (except for transaction names, 
which can be up to 1024 characters), for both the User name and Login 
name fields.

This chapter describes: On page:

General Guidelines 87

Allowed Characters 88
87



Chapter 8 • Naming Conventions
➤ Entity names in HP Business Availability Center for CMDB-based 
applications follow the conventions described below: 

➤ CIT attributes values. All primitive types are supported: long, double, 
float, string, and so on.

➤ CIT attributes values-type string. All special characters are supported. The 
maximum length is 4000 characters.

➤ CIT names and attributes names. The following are permitted: a-z, A-Z, 
and underscore (_). The length is limited to 200 characters. The CIT 
name must be in English.

➤ CIT attribute length. The total length of all the attributes in one CIT 
cannot exceed 8K due to a SQL Server limitation.

Allowed Characters

Allowed characters are a-z, A-Z, 0-9, and the special characters described in 
the following table:

 

Entity Special Characters Allowed

CMDB-Based Components

IT Universe All

View Manager All

Discovery All; For IP addresses only digits and *

Source Manager All

CI Type Manager All characters except:
" \ / [ ] : | < > + = ; , ? *

Dashboard All

Service Level Management All

CMDB alerts All

Platform Administration

Management database name _ @ $ #
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Management user schema (Oracle) None

Management user schema password 
(Oracle)

None

User name All characters except:
" \ / [ ] : | < > + = ; , ? *

User login All characters except:
" \ / [ ] : | < > + = ; , ? *

User password All characters

User group name All characters except:
" \ / [ ] : | < > + = ; , ? *

Alert name ` ~ ! @ # $ % ^ & * ( ) - + = [ ] { } \ | / ? . , 
" ' : ; < > 

Recipient name ` ~ ! @ # $ % ^ & * ( ) - + = [ ] { } \ | / ? . , 
" ' : ; < > 

Message sender name in alerts ` ~ ! # $ % ^ * _ - + = { } \ | / ? . ' <space>

SMTP server name in alerts _ . -

Scheduled report name ` ~ ! @ # $ % ^ & * ( ) _ - + = [ ] { } \ | / ? 
. , " ' : ; < > <space>

Downtime/Event Schedule name All characters except:
" < >

System Availability Management and End User Management Administration

Transaction name ` ~ ! @ # $ % ^ & * ( )_ - + { } ; <space>

Script name !_ <space>

Profile name ~ ! @ # $ % ^ & ( )_ - { } .

Views ` ~ ! @ # $ % ^ & * ( ) _ - + { } ; <space>

Categories ` ~ ! @ # $ % ^ & * ( ) _ - + { } ; <space>

Data Collectors

Entity Special Characters Allowed
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Business Process Monitor host name ` ~ ! @ # $ % ^ & * ( )_ - + = [ ] { } \ | / ? . 
, " ' : ; < > <space>

Business Process Monitor host location ` ~ ! @ # $ % ^ & * ( ) _ - + = [ ] { } | / ? . : 
; <space>

SiteScope group name _ . -

Real User Monitor entities, including 
Engine

` ~ ! @ # $ % ^ & * ( ) _ - + { } ; <space>

Custom Reporting

Custom report title _ - + = | [ ] { } , . : ; <space>

Custom report menu name _ - + = | [ ] { } , . : ; <space>

Custom report component title _ - + = | [ ] { } , . : ; <space>

Trend report title _ - + = | [ ] { } , . : ; <space>

Trend report menu name _ - + = | [ ] { } , . : ; <space>

Entity Special Characters Allowed
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Using the JMX Console

This chapter describes how to deploy, undeploy, or display currently 
displayed packages using the JMX console.

JMX Console Overview

You can use the JMX console to deploy, undeploy, or display currently 
displayed packages. For more information on packages, see “Package 
Manager” in IT World Model Management.

➤ A deployed package is a package whose resources are imported into the 
system and available for use.

➤ An undeployed package is a package whose resources are not in the system, 
but can be imported by deployment.

Note: It is recommended that you use the Package Manager to perform these 
tasks instead of the JMX console. For details, see “Package Manager User 
Interface” in IT World Model Management.

This chapter describes: On page:

JMX Console Overview 91

Deploying a Package 92

Undeploying a Package 93

Displaying Currently Deployed Packages 94
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Deploying a Package

This section explains how to deploy a package using the JMX console.

To deploy a package:

 1 Launch your Web browser and enter the following address: 
http://<server_name>:8080/jmx-console, where <server_name> is the name 
of the machine on which HP Business Availability Center is installed.

 2 Under MAM, click service=Package manager to open the JMX MBEAN View 
page. 

 3 Locate java.lang.String deployPackages and enter the following 
information:

 a In the ParamValue box for the parameter customerId, enter 1.

 b In the ParamValue box for the parameter dir, enter the name of the folder 
that contains the package’s zip file.

Include the full path to the folder.

Note: To deploy the package from the default package directory, leave 
this box empty. The default package directory is located in <HP Business 
Availability Center root directory>\mam_lib\packages.

 c In the ParamValue box for the parameter packagesNames, enter the 
name of the package. 

The rules for entering a package name are as follows:

➤ The package name can contain a wildcard character (*).

➤ The package name is case sensitive. 

➤ The package name must have a .zip extension.

Note: You cannot deploy a package whose time stamp is older than a 
package with the same name that already exists in the CMDB. 
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 d In the ParamValue box for the parameter ignoreTimestamp, select one of 
following:

➤ True. Ignore the time stamp and deploy the package.

➤ False. Do not deploy the package if the date of the package is older 
than an existing package with the same name in the CMDB.

 4 Click Invoke to deploy the package.

Undeploying a Package

This section describes how to undeploy a package using the JMX console.

To undeploy a package:

 1 Launch the Web browser and navigate to: http://<server_name>:8080/jmx-
console, where <server_name> is the name of the machine on which 
HP Business Availability Center is installed.

 2 Under MAM, click service=Package manager to open the JMX MBEAN View 
page.

 3 Locate java.lang.String undeployPackages and enter the following 
information:

➤ In the ParamValue box for the parameter customerId, enter 1.

➤ In the ParamValue box for the parameter packagesNames, enter the 
name of the package you want to remove.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive. 

 4 Click Invoke to undeploy the package.
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Displaying Currently Deployed Packages

This section describes how to display currently deployed packages using the 
JMX console.

To display currently deployed packages:

 1 Launch the Web browser and navigate to: http://<server_name>:8080/jmx-
console, where <server_name> is the name of the machine on which 
HP Business Availability Center is installed.

 2 Under MAM, click service=Package manager to open the JMX MBEAN View 
page.

 3 Locate java.lang.String displayDeployedPackages and enter the following 
information:

In the ParamValue box for the parameter customerId, enter 1.

 4 Click Invoke to display the packages that are currently deployed.
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Relationship Definitions

This chapter defines relationships used throughout HP Business Availability 
Center documentation.

backbone

A physical connection between two switches. The relationship is 
discovered by the Discovery layer 2 service. 

bcastdomain

The relationship between an elan (emulated LAN) and a switch.

bridgebackbone

A physical connection between two switches connecting a switch port 
to a switch bridge. The relationship is discovered by the Discovery 
base service. 

brother

The relationship among elements which share the same parent.

chassiselanmap

The relationship between a chassis and an elan (emulated LAN).

chassisvlanmap

The relationship between a chassis and a vlan (virtual LAN).
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clientserver

A row of data from the tcpConnLocalAddress table in the Management 
Information Base (MIB) tree. This data contains information about the 
TCP connection between the ports of two hosts when a differentiation 
can be made between the server port and the client port. The 
tcpConnLocalAddress table lies in the MIB address 1.3.6.1.2.1.6.13.1.2. 
The clientserver relationship is discovered by the Discovery TCP 
connection collector. 

contained

The relationship between two CIs whereby a second CI is included in 
the first CI. This relationship exists only between an IP and host.

container_f

The functional relationship between a parent and a child. The child 
does not inherit any properties.

contains

The relationship between two CIs whereby a second CI is included in 
the first CI.

dbclient

The relationship between a process and a database.

dblink

The relationship between a database and a database link object.

depend

The relationship wherein one CI needs the functionality of 
another CI.

dependency

The relationship wherein one CI needs the functionality of 
another CI.

deployed

The relationship wherein one CI is put into action by another CI.
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elanvlanmap

The relationship between elan (emulated LAN) and vlan (virtual LAN) 
network components.

execute

The relationship between an agent and the job it deploys.

j2eesocket

The relationship between a server and a remote client.

layertwo

The physical connection between a switch and a host. The layertwo 
relationship is discovered by the Discovery layer 2 service. 

member

The relationship between two CIs whereby one CI is included in 
another CI.

mqalias

The relationship between an alias queue and a local queue.

mqchannelof

The relationship between a channel and its transmission queue.

mqmqilink 

The relationship between client and server channels for Message Queue 
Interface (MQI) calls. 

mqmsglink

The relationship between two channels for message transfer.

mqrepository

The relationship between a message queue cluster and a message 
queue queue manager.

mqresolve

The relationship between a remote queue and the local queue to 
which it is mapped.

nfs

Network file server.
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owner 

The user of a resource.

parent

The relationship between elements where one element is parent of the 
other. For example, ip is the parent of interface.

pnniconnection

The relationship between two ATM ports.

resource

The relationship between elements where one element is the resource 
of the other. For example, dbsnapshot is the resource of dblinkobject.

route

A row of data from the routing table in the Management Information 
Base (MIB) tree, containing the data of the next_hop IP address and the 
destination network address. The routing table lies in the MIB address 
1.3.6.1.2.1.4.21.1.7. The relationship is discovered by the Discovery 
route collector. 

sap_rfc_connection

The relationship between a SAP system and a host. The host may be 
another SAP system or a non-SAP system.

share

The relationship between two drives.

talk

The relationship between two hosts.

tcp

A row of data from the tcpConnLocalAddress table in the Management 
Information Base (MIB) tree. This data contains information about the 
TCP connection between the ports of two hosts when a differentiation 
can be made between the server port and the client port. The 
tcpConnLocalAddress table lies in the MIB address 1.3.6.1.2.1.6.13.1.2. 
The relationship is discovered by the Discovery TCP connection 
collector. 
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traffic

Represents all network flow, regardless of protocol, between two IPs.

uniconnection

The relationship between an ATM port and an IP.

unnumbered

A row of data from the routing table in the Management Information 
Base (MIB) tree. This data contains information about the next_hop IP 
address and the destination network address. The routing table lies in 
the MIB address 1.3.6.1.2.1.4.21.1.7. Unnumbered relationships are 
discovered by the base collector. 

usb

The relationship between two interfaces.

use

The relationship between elements whereby one element uses the 
other. For example, process uses file.

virtual

The relationship between a router and its virtual IP.

vlanmembership

The relationship between a vlan (virtual LAN) and a physical port.

vlantobridge

The relationship between a vlan (virtual LAN) and a bridge.
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View Explorer

This chapter includes the main concepts, tasks, and reference information 
for View Explorer.

This chapter describes: On page:

Concepts

View Explorer Overview 102

Displaying a View 103

Using the Search Tool 104

View Explorer Configuration 106

Tasks

Search for Configuration Items 106
101



Chapter 11 • View Explorer
View Explorer Overview

View Explorer presents the elements of the IT universe model in HP Business 
Availability Center through the medium of views. HP Business Availability 
Center displays View Explorer in the left pane of applications and pages, for 
example, Dashboard, Service Level Management, and IT Universe Manager.

When you select a view in View Explorer, the configuration items (CIs) 
contained in the view are displayed in a hierarchical tree format according 
to the relationships defined between the CIs. A view may be empty if no CIs 
have been added to it (for an instance view), or if no CIs were found 
matching the TQL query (for a pattern view). For details on pattern and 
instance views, see “View Manager Overview” in IT World Model 
Management.

You can use View Explorer to select views and to locate CIs. You can select a 
view and browse through the list of CIs, or you can search for a CI if you do 
not know in which view the CI is included. 

The interaction between the View Explorer pane and the information 
presented in the right pane varies, according to the context. For example, in 
IT Universe Manager, information is presented for the CI selected in View 
Explorer; in Dashboard, information is presented for the view selected in 
View Explorer; in Service Level Management, and in other dialog boxes, CIs 
can be selected in View Explorer and added to the right pane.

The functionality available for searching and browsing in View Explorer, 
and the menu options available for the CIs, also vary with the context.

For information on the components of View Explorer, see “View Explorer 
User Interface” on page 109.
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Displaying a View

When View Explorer is set to Browse mode, you can display the contents of 
a selected view. The name of the selected view is shown in the View box, 
and repeated again in the lower part of the View Explorer pane with the CI 
tree beneath it. When you move to other applications in HP Business 
Availability Center, the selected view remains the same.

Unavailable Views and CIs
The View list in View Explorer may not display all views in the CMDB, or it 
may not display the contents of a view, for any of the following reasons:

➤ The View list includes only the views for which you have the necessary 
permissions set in Admin > Platform > Users and Permissions > Permissions. 
For more information, see “Granting and Removing Permissions” in 
Platform Administration.

➤ When using View Explorer in IT Universe Manager, Dashboard, or Service 
Level Management, the View list includes only those views that are assigned 
to that application. 

➤ Views that are currently inactive appear in red in the View list, but they 
cannot be selected.

➤ Out-of-the-box views for which you do not have a license may appear in the 
View list, but these views do not contain CIs. For information on the out-of-
the-box views, see “Predefined Folders and Views” in IT World Model 
Management.

Note: After deleting one or more nodes from a TQL, it can take time for 
changes to be updated to the view; meanwhile, the removed CIs appear in 
the view. If you select one of these CIs before it is updated, an error message 
is displayed. Use the Refresh button to update the view.
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Using the Search Tool

The View Explorer search tool enables you to find the CI you need, so that 
you can shift the focus, in the application in which you are working, on to 
that CI. Searches can be set up based on any number and combination of 
the following filter criteria.

This section includes the following topics:

➤ “Searching by CI Name” on page 104

➤ “Searching in Views or the CMDB” on page 104

➤ “Searching by Related Configuration Item” on page 105

➤ “Searching by Configuration Item Type” on page 105

Searching by CI Name
When searching for CIs by name in View Explorer Search mode, you enter a 
string in the Search for box, representing the name of the CI, or part of the 
name. The search returns all CIs that contain the entered string somewhere 
in the name (within the boundaries of the other search criteria that you 
define).

When using this search option, note the following:

➤ The search by CI name option is not case sensitive.

➤ You can use the wildcard character asterisk (*) in the string to represent zero 
or more characters.

Searching in Views or the CMDB
All searches in View Explorer must specify the locations in which to search:

➤ The current view only. This option includes the view currently selected in 
Browse mode.

➤ All views. This option searches in the most recently accessed views. It does 
not include any views that are unavailable in the current application. For 
information on unavailable views, see “Unavailable Views and CIs” on 
page 103.
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➤ The entire CMDB. This option enables you to find CIs that are not included 
in any view, or that are part of a view that is unavailable in IT Universe 
Manager. This option is only available if you are working in IT Universe 
Manager, Change Report, or in the Instance View Editor in View Manager.

Searching by Related Configuration Item
You can search for CIs using the Related to box. This search returns CIs that 
have defined relationships to the CI specified in the Related to box. You can 
perform the same search by selecting the Show Related CIs option from the 
context menu when working in Browse mode. For details, see the context 
menu options under “Browse Mode” on page 110.

You cannot manually enter a CI in the Related to box – you define the 
required CI by selecting it in a view.

Note: The results list does not include relationships that exist in the CMDB, 
but are not included in any view.

After defining a CI in the Related to box, HP Business Availability Center 
remembers your selection until you move to a different application, or until 
you define a different value. The selection is shown inactive – you activate it 
again for a search by selecting the check box.

Searching by Configuration Item Type
You can search for CIs using the CI type box. This search returns CIs that are 
of the type specified in the CI type box.

You cannot manually enter a CIT in the CI type box – you define the 
required CIT by selecting it from a list.

After defining a CI in the CI type box, HP Business Availability Center 
remembers your selection until you move to a different application, or until 
you define a different value. The selection is shown inactive – you activate it 
again for a search by selecting the check box.
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View Explorer Configuration

You can modify display options for View Explorer. These options are 
configured in the Infrastructure Settings Manager.

Important: Many of the settings in the Infrastructure Settings Manager 
should not be modified without first consulting Customer Support or your 
HP Professional Services representative. Modifying certain settings can 
adversely affect the performance of HP Business Availability Center.

To access the Infrastructure Settings Manager, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings. Select the Foundations 
context and choose View Explorer from the list.

The following settings can be modified:

➤ Immediate Children Count. Number of children immediately displayed 
when expanding their parent’s node in View Explorer.

➤ Maximal Children Count. Maximum number of children displayed under 
their parent’s node in View Explorer.

➤ Maximal search results size. Maximum number of CMDB instances that can 
be returned in one search operation.

➤ Recently Used Views List size. Maximal number of recently used views to 
store per user.

Search for Configuration Items

Follow these steps to search for configuration items:

Define the Search
In the View Explorer pane, go to Search mode and define the criteria for 
your search. For details, see “View Explorer” on page 110.
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Run the Search and Sort the Results
Run the search. The results are listed in the lower part of the View Explorer 
pane, showing the CI name and the name of the view that the CI appears in, 
for each entry. You can sort the search results by clicking the appropriate 
heading.

When you select the required CI from the results list, the right pane displays 
details for the CI you selected, in the context in which you are working. To 
see a CI in the context of its view, right-click the CI and select Locate CI in 
View. View Explorer reverts to Browse mode and displays the view that 
contains the CI, with the CI selected in the view tree.
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View Explorer User Interface

This chapter includes a description of the pages and dialog boxes that are 
part of the View Explorer user interface.

This chapter describes: On page:

View Explorer 109
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View Explorer

Browse Mode
The View Explorer window includes the following elements in Browse mode 
(listed alphabetically):

Description Enables you to select views and to locate CIs.

To access: Appears in the left pane of the window, for 
example, the left pane of the IT Universe Manager 
window, the left pane of Dashboard, and the left pane of 
Service Level Management.

Important 
Information

The interaction between the View Explorer pane and the 
information presented in the right pane varies, 
according to the context. For example, in IT Universe 
Manager, information is presented for the CI selected in 
View Explorer; in Dashboard, information is presented 
for the view selected in View Explorer; in Service Level 
Management, and in other dialog boxes, CIs can be 
selected in View Explorer and added to the right pane.

View Explorer consists of two functional formats: 
Browse mode and Search mode.

➤ In Browse mode you can search for and display a view, 
and browse through the view to locate a particular CI. 
You can also perform operations for the CI from a 
context menu.

➤ In Search mode you can search for one or more CIs in 
the views or the CMDB, search for all occurrences of a 
CI, or filter the list of CIs that is displayed.

GUI Element Description

Click the Refresh button to refresh the list of CIs (if new 
CIs have been added to a view) or to refresh the View list 
(if views have been newly defined).

The Related CIs tree structure/CI type tree structure 
enables you to change the way the CIs in a view are 
displayed.
110



Chapter 12 • View Explorer User Interface
Click the Menu option button to display a 
context-sensitive menu containing the options you can 
perform on a selected CI. You can also display the menu 
by right-clicking a CI.

Click the Help button to display the help for View 
Explorer.

Click the Close/Open button to hide or display the View 
Explorer pane.

Click the Select view from the folder tree button to the 
right of the View box, to open the Select View dialog 
box. You can browse through the folder tree to locate 
the view you want to display.

<CIs> The CIs contained in the currently selected view.

<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.

View The View box displays the currently selected view. To 
select a view to display, click the down arrow on the 
right side of the View box; this displays an abridged list 
of views, containing the most recently accessed views. 
Click the arrow at the bottom of the list to scroll 
through the entire list.

Alternatively, place the cursor in the list and begin 
typing the view name. HP Business Availability Center 
completes the view name, if the first few letters that you 
type match an existing entry. If the names of several 
views begin with those letters, all matching views are 
displayed in the list.

GUI Element Description
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Search Mode
The View Explorer window includes the following elements in Search mode 
(listed alphabetically):

GUI Element Description

Click the Help button to display the help for View 
Explorer.

In the Related to window, click to open the Select 
Configuration Item dialog box, where you select the 
required CI.

In the CI type window, click to open the Select 
Configuration Item Type dialog box, where you select 
the required CIT to search for.

<Search results> After you run the search, the results are listed in the 
lower part of the View Explorer pane. The results are 
shown in two columns:

➤ Name. Contains the name of the CI.

➤ View. Contains the name of the view in which the CI 
appears.

If the CI or view name is abbreviated, hold the pointer 
over the entry to see the full name. You can sort the 
search results by clicking the appropriate heading.

CI type To search for CIs related to a specified CI type, select the 
CI Type check box and click the ellipsis button to select 
a CI from the Select Configuration Item dialog box.

Name filter box Enter a CI name or part of a name in the filter box under 
the Name column of the results and press Enter to filter 
the results by name.

Related to To search for CIs of a specified CI, select the Related to 
check box and click the ellipsis button to select a CI 
from the Select Configuration Item dialog box.

Search Click to run the search.The results are listed in the lower 
part of the View Explorer pane, showing the CI name 
and the name of the view that the CI appears in, for 
each entry. 
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Context Menu Options

Search for In the Search for box, enter the name of the CI (or part 
of the name). For more information, see “Searching in 
Views or the CMDB” on page 104.

Search in Specify the scope of your search. You can limit your 
search to the current viewor search in the most recently 
accessed views (by selecting All views). In IT Universe 
Manager, Change Report, and the Instance View Editor 
in View Manager, you also have an option to search the 
entire CMDB. The default option is Current view. Select 
the required option.

For more information, see “Searching in Views or the 
CMDB” on page 104.

View filter box Enter a view name or part of a name in the filter box 
under the View column of the results and press Enter to 
filter the results by view.

GUI Element Description

<Context sensitive 
menu options>

The View Explorer context menu contains different 
options in each of the windows in which it appears. For 
example, in Dashboard you can open reports for the CI, 
and in IT Universe Manager you can attach new CIs to 
the CI.

For details on the context menu options specific to a 
particular application, see the User Interface Help for 
that application.

Locate CI in View When this is selected for a CI, View Explorer reverts to 
Browse mode and displays the view that contains the CI, 
with the CI selected in the view tree.

Note: This option is only available in Search mode.

GUI Element Description
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Properties Opens the Properties page for the selected CI. For details, 
see “Properties Tab” on page 279.

Show Related CIs When this option is selected, View Explorer changes to 
Search mode and displays a list of the CIs that have a 
relationship to the original CI. This is the same as 
defining the original CI in the Related to box when 
performing a search in all views.

Note: This option is not available in IT Universe 
Manager.

GUI Element Description
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Topology Query Language

This chapter includes the main concepts, tasks, and references of Topology 
Query Language (TQL).

Topology Query System Overview

Topology Query System includes Topology Query Language (TQL). TQL is a 
language and tool for discovering, organizing, and managing IT 
infrastructure data. It is used to create queries that retrieve specific data from 
the configuration management database (CMDB) and display that data. For 
details on CMDB, see “Configuration Management Database (CMDB) 
Concepts” on page 193.

TQL queries constantly search the CMDB for changes that occur in the state 
of managed resources, and inform and update the relevant subsystems.

The CMDB is the core information repository. It contains the CI Type model 
and the custom tailored business service model, and stores and handles the 
infrastructure data collected and updated by the Discovery process. For more 
information on the Discovery process, see “Discovery Overview” in 
Discovery. For details on the CI Type model, see CI Attribute Customization.

The Topology Query System enables you to create a TQL query. For details, 
see “Query Manager User Interface” in IT World Model Management.

This chapter describes: On page:

Topology Query System Overview 115

TQL Query Validation Restrictions 117
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Topology Query Language
TQL extends the standard SQL language by adding two important 
capabilities:

➤ TQL enables you to draw conceptual relationships between configuration 
items (CIs), which represent their actual interdependencies. Using 
predefined operators, the different types of interconnections that exist 
between CIs can be established, and consequently the infrastructure design 
and performance are more accurately represented. This representation serves 
as a basis and a model for the discovery, arrangement, query, and 
management of complex infrastructures.

➤ TQL contains a graphical aspect, consisting of visual symbols and syntax 
that represent the resources and their interconnections. This visualization of 
an IT infrastructure simplifies the understanding, monitoring, and 
managing of the IT business operations.

The Roles of TQL
TQL plays several roles:

➤ Builds a business service model that defines and delineates the 
interconnection between IT assets that function together as business 
services. The business service model guides the discovery and identification 
of these business services, from the ever-increasing number and complexity 
of infrastructure resources. After the resources that comprise the business 
services are discovered, the business service model structures the way they 
are organized and managed in the CMDB.

➤ Creates queries that retrieve business service data from the CMDB, and 
displays the data in a visual representation that facilitates data monitoring 
and managing.

➤ Constantly searches the CMDB for changes that occur in the state of 
managed resources. When such changes are detected, the relevant 
subsystems are informed and updated.
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TQL Query Validation Restrictions

For TQL queries to be valid, they must comply with certain restrictions.

This section includes the following topics:

➤ “Understanding Validation Restrictions” on page 117

➤ “Correlation TQL Validation” on page 119

➤ “Enrichment TQL Validation” on page 120

Understanding Validation Restrictions
For Correlation, Enrichment, and Discovery TQL types to be valid, they 
must comply with the following restrictions:

➤ Self Relationships. A TQL must not contain self relationships, that is, a 
relationship must not lead from a node to itself, as the following example 
illustrates:
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➤ Cyclic Graph. The TQL structure cannot be a closed circle, as shown in the 
following example:

➤ Separate Nodes and Groups. All the TQL nodes must be linked to one 
another, that is, the TQL cannot contain separate nodes or groups, as the 
following example illustrates:

Note: This restriction also applies to Report TQLs.
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Correlation TQL Validation
A Correlation TQL must also comply with the following restrictions:

➤ Number of nodes. A Correlation TQL must consist of at least two nodes.

➤ Trigger and affected nodes must be connected. There must be a path of 
relationships from the triggered node to the affected nodes.

➤ Selecting nodes to function as Correlation triggers. When selecting nodes 
to function as Correlation triggers, the nodes must comply with the 
following restrictions:

➤ You can select more than one node as a trigger. However, you cannot 
define a node as affected and as a trigger.

➤ If a node has a relationship whose minimum limit is 0 (meaning that one 
of its ends does not necessarily have a node linked to it), the node that is 
linked to its other end cannot be a root cause node (because it may or 
may not exist in the TQL). For details about minimum limits, see 
“Cardinality Tab” on page 159. For example, IT Universe cannot be either 
a root cause or affected node because it is connected to the host with a 
Min limit of 0. 

Note: A node that is not visible cannot be a root cause or an affected node.

➤ The connection between trigger and affected nodes. The trigger node and 
affected nodes you define must be connected by a path of relationships 
from the triggered node to the affected nodes.
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Enrichment TQL Validation
Enrichment TQL queries must comply with the following restriction:

➤ Required elements. You cannot perform Enrichment on a non-required 
node, that is, a node that does not necessarily appear in the TQL results.

Example 1. In this example, the TQL results can be either A and B or A and 
C. Therefore, you cannot add an Enrichment node to nodes B or C because 
they are not required elements. You can add an Enrichment node to node A 
because it always appears in the TQL results. For details on how to add 
Enrichment nodes and relationships, see “Adding Enrichment Nodes and 
Relationships to an Enrichment TQL Query” on page 190.
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Example 2. In this example, both A and B are required elements that always 
appear in the TQL results. Only C is not a required element because it has a 
cardinality of 0. Therefore, you cannot add an Enrichment node to it.
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Topology Query Language User Interface

This chapter includes the pages and dialog boxes that are part of the 
Topology Query Language user interface in Correlation Manager, 
Enrichment Manager, Query Manager, Report Manager, View Manager, and 
Trigger TQL Editor in Discovery.

This chapter describes: On page:

Add Compound Relationship Dependency Dialog Box 124

Add Dependency Dialog Box 126

Add Relationship Dialog Box 128

Attribute Condition Dialog Box 140

Change CI Type Dialog Box 142

Element Instances Dialog Box 143

Filter CI Instances Dialog Box 146

Join Relationship Condition Dialog Box 147

Layout Settings Dialog Box 148

Node/Relationship Condition Dialog Box 150

Relationship Cardinality Dialog Box 161

Subgraph Dialog Box 164

Subgraph Condition Definition Dialog Box 168

TQL Node Wizard 171
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Add Compound Relationship Dependency Dialog Box

The Add Compound Relationship Dependency dialog box includes the 
following elements (listed alphabetically):

Description Enables you to create a compound relationship 
definition. The compound definition appears in the 
Compound Definition area in the Add Relationship 
dialog box.

To access: In the Add Relationship dialog box, click the 
Advanced link, choose Function Relationship, select 
Virtual - Compound relationship, and then click the Add 

 button in the Compound Definition area.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Relationship Select an available relationship connecting the two 
nodes. The list of available relationships appears only 
after defining both nodes. 

Relationship 
Direction

Select the required direction. Setting different 
relationship directions can achieve different query 
results. For an example, see “Setting Different 
Relationship Directions for Compound Definitions” 
below.

Note: The Relationship list remains empty until you have 
selected a Source and Target.

Source Select the required source node.

Target Select the required target node.
124



Chapter 14 • Topology Query Language User Interface
Setting Different Relationship Directions for Compound 
Definitions

You can achieve different TQL results by setting different relationship 
directions. For example, in your business world, as illustrated below, you 
want to create a compound relationship that connects between a node of 
the CIT a and a node of the CIT b. Depth is defined at 5 (for details, see 
“Depth” on page 165). 

In the Add Compound Relationship Dependency dialog box, you can create 
compound definitions to link nodes a and b using different relationship 
directions.

➤ Compound definitions 1 and 2 result in the following query:

Compound 
Definition

Source Target Relationship Relationship 
Direction

#1 node a node c <relationship> source --> target

#2 node c node b <relationship> source --> target

#3 node c node b <relationship> source <-- target
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➤ Compound definitions 1 and 3 result in the following query:

➤ Compound definitions 1, 2, and 3 result in the following query:

Add Dependency Dialog Box

Description Enables you to create a dependency graph definition. 
Select the nodes and relationships to be included in the 
dependency graph.

To access: In the Subgraph dialog box, click   Add.. 

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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The Add Dependency dialog box includes the following elements (listed 
alphabetically):

GUI Element Description

Define attribute conditions for the source and target 
nodes you selected. Opens the Subgraph Condition 
Definition dialog box.

Note: The Condition button is enabled only after you 
select a node from the Source or Target lists.

Relationship Select an available relationship connecting the source and 
target nodes. The list of available relationships appears 
only after defining both the required source and target 
nodes.

Source Select the desired source node.

Target Select the required target node.
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Add Relationship Dialog Box

Description Enables you to define the connection between two nodes 
in a query.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
➤ Right-click the required nodes in the Editing pane in 

Report Manager, Enrichment Manager, Correlation 
Manager, Query Manager, View Manager and select 
Add Relationship.

or

➤ Click the Create Relationship  icon and draw a line 
between the required nodes.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Add 
Relationship option.

To access in Resource Configuration in Discovery:
1  Click the  button to the right of the Input TQL box, 

located in the Pattern Signature tab, to open the Input 
TQL Editor.

2  Right-click the required node and select Add 
Relationship.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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The Add Relationship dialog box includes the following elements (listed 
alphabetically):

GUI Element Description

Advanced Click Advanced to select one of the following:

➤ Select Relationship to define the connection between 
two nodes using a child of the relationship in the 
Relationship Type box.

➤ Select Function Relationship to define the connection 
between two CIs using either a join or compound 
relationship. 

➤ For details on defining join relationships, see “Join 
Definition Area” on page 131. 

➤ For details on defining Compound relationships, see 
“Compound Definition Area” on page 135. 

Allow relationships Define how to handle relationships between identical 
nodes or self relationships in the query results. A self 
relationship is a relationship that leads from a node to 
itself. 

Note: This list appears only when you select one node or 
two identical nodes.

Click the Advanced link and select one of the following 
options:

➤ Allow all relationships. All relationships appear in the 
query results.

➤ Allow self-relationships only. Only self relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Discard self-relationships. Self-relationships do not 
appear in the query results.

Direction The direction of the relationship that indicates which 
node is dependent on the other.

Node Label The label of the selected nodes.

Relationship Type A valid relationship that defines the connection between 
the selected nodes.
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Relationship Area

The Relationship area includes the following elements:

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, an invisible box  appears to 
the left of the of the relationship’s name in the Editing 
pane. Any query results pertaining to the relationship are 
not displayed in the topology map.

Description Enables you to define a valid relationship that defines the 
connection between the selected nodes.

To access: Click Advanced and select Relationship from 
the Relationship list on the left.

GUI Element Description

<List of relationships 
from which to 
choose>

Select the relationship that defines the connection 
between two nodes using a child of the relationship in 
the Relationship Type box.

GUI Element Description
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Join Definition Area

Description Enables you to define join relationships. A join 
relationship is a logical connection, which appears only 
in the topology view containing the TQL query results, 
and represents the relationship between two CIs. It does 
not exist in the CMDB. A join relationship is created by 
defining an attribute for each node, whose values are used 
for comparison.

The TQL results retrieve all CIs whose attribute values 
meet the conditions defined in the join definition.

For example, you can create a join definition that links all 
Host CIs connected to IP CIs whose Created by attribute 
values are equal (see the example below).

Each row in the Join Definition area represents one 
condition defined for the join relationship. 

Note: You can define multiple conditions.

For an example of a compound definition, see “Sample 
Join Relationship” on page 132.

To access the Join Definition area: 
1  In the Add Relationship dialog box, click Advanced.

2  Select Function Relationship from the Relationship list 
on the left.

3  Select Virtual - Join Relationship.
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The Join Definition area includes the following elements (listed 
alphabetically):

Sample Join Relationship

This section explains how to define a join relationship that links Host CIs 
that are linked to IP CIs whose Created by attribute values are equal.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Define a join definition. Opens the Join Relationship 
Condition dialog box.

Delete the selected row in the Join Definition area.

Edit the selected row in the Join Definition area. Opens 
the Join Relationship Condition dialog box.

<Selected node1> A selected node. The first attribute applies to <end_1>. 

<Selected node2> A selected node. The second attribute applies to <end_2>.

And All join definitions are linked by the And operator.

Operator The operator selected in the Join Relationship Condition 
dialog box. For details about operator definitions, see 
“Attribute Operator Definitions” on page 185.
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To define a join relationship that links all IP and Host CIs whose Created by 
attribute values are equal:

 1 Create a TQL query and drag the following nodes from the CI Types pane 
onto the Editing pane:

➤ Host

➤ IP

 2 Select the Host and IP nodes and right-click to open the Add Relationship 
dialog box.

 3 Click Advanced.

 4 From the list under Advanced, select Function Relationship.

 5 Select Virtual - Join Relationship.

 6 Click the Add button to open the Join Relationship Condition dialog box 
and do the following:

➤ In the Host Attribute box, select Created by.

➤ In the Operator box, select Equal.

➤ In the IP Attribute box, select Created by.

 7 Click OK to save your changes.

The Join Definition area now looks like this.

 8 Click OK to save your changes in the Add Relationship dialog box.
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The TQL query in the Editing pane now looks like this:

Go to the required view in IT Universe to view the results. Double-click the 
Virtual - Join relationship in IT Universe to open the Link Map (as seen 
below), which displays all the Host CIs that are connected to an IP CI whose 
Created by attribute values are equal.
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Compound Definition Area

Description Enables you to define the connection between two nodes 
using a compound relationship. A compound 
relationship represents a path in the topological graph. 
You use a compound relationship to define the allowed 
steps in the path between the source and the target CIs.

Each row in the Compound Definition area represents 
one of the allowed steps in the path leading from the 
source CI to the target CI in the topology map.

Note: For an example of a compound definition, see 
“Sample Compound Relationship” on page 137.

To access the Compound Definition area: 
1  In the Add Relationship dialog box, click Advanced.

2  Select Function Relationship from the Relationship list 
on the left.

3  Select Virtual - Compound Relationship.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

Important 
Information

You can create as many compound definitions as 
necessary.
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The Compound Definition area includes the following elements (listed 
alphabetically):

GUI Element Description

Add a Compound definition. Opens the Add Compound 
Dependency dialog box. 

Delete the selected Compound definition.

Edit the selected Compound definition. Opens the 
Change CI Type dialog box.

Max steps Enter a number that represents the longest path allowed 
between the two CIs in the CMDB to be included in the 
Discovery process.

Default is: 5

Min steps Enter a number that represents the shortest path allowed 
between the two CIs in the CMDB to be included in the 
Discovery process.

Default is: 1

Relationship The relationship connecting the two nodes. 

Source The required source node.
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Sample Compound Relationship

This section describes how to define the allowed steps that form a 
Compound relationship between a Network and an IP CI.

To define a compound relationship between a Network CI and a IP CI:

 1 Create a TQL query and drag the following nodes from the CI Types pane 
onto the Editing pane:

➤ Network

➤ IP

 2 Right-click the Network and IP nodes and select Add Relationship to open 
the Add Relationship dialog box.

 3 Click Advanced.

 4 From the list under Advanced, select Function Relationship.

Stop at first 
compound level

Select this option if you want the system to stop looking 
for TQL results once it reaches the first target in the path. 

In the following sample compound link definition, Depth 
is defined as 10 and Stop at first compound level is 
selected.

The TQL results include the Target 1, Target 3, and Target 
4 because they are all at level 1 (the first CI found in the 
path). Target 2 is not included in the TQL results because 
it is at level 2 (the second CI found in the path).

Target The required target node.

GUI Element Description
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 5 Select Virtual - Compound Relationship.

 6 Click the Add button to open the Add Compound Relationship Dependency 
dialog box and do the following:

➤ From the Source list, select Host.

➤ From the Target list, select IP.

➤ From the Relationship list, select Contained.

➤ Select the required Relationship direction.

 7 Click OK to save your changes.

 8 Click the Add button to open the Add Compound Relationship Dependency 
dialog box and do the following.

➤ From the Source list, select Network.

➤ From the Target list, select Host.

➤ From the Relationship list, select Member.

➤ Select the required Relationship direction.

 9 Click OK to save your changes.

The Compound Definition area now looks like this.

 10 Click OK to save your changes in the Add Relationship dialog box.
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The TQL query in the Editing pane now looks like this:

Go to the required view in IT Universe to view the results.

You can double-click the Virtual - Compound relationship in IT Universe to 
open the Link Map, which displays the CIs and relationships that comprise 
the allowed steps used to link the Network and IP CIs.

In this example, the 16.59.42.0 (Network) CI is linked to the 16.59.42.241 
(IP) CI through the Otubman2-il (Host) CI.
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Attribute Condition Dialog Box

The Attribute Condition dialog box includes the following elements (listed 
alphabetically):

Description Enables you to choose the attribute name, operator, and 
value required for the attribute definition.

To access: Click the Add an attribute condition  
button in the Node/Relationship Condition dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Attribute name Choose an attribute from the list.
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Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 185.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Select one of the following options:

Fixed value. You cannot change the value of the 
parameter.

Parameterized value. Enables you to change the value of 
the parameter.

➤ When a parameterized value is selected in View 
Manager, an option called Set View Element 
Parameters is included in the right-click menu. For 
details on how to change the value when using the 
TQL, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 308.

Note: If you select this option, you can enter a value 
here that is saved in the view. If you do not enter a 
value here, you are forced to enter one before saving 
the view. 

➤ When a parameterized value is selected in Report 
Manager, a Set parameters values option is displayed 
at the top right of a generated System report, enabling 
you to edit the predefined parameters of node 
conditions in a System report. For details, see “System 
Report User Interface” in IT World Model Management.

GUI Element Description
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Change CI Type Dialog Box

The Change CI Type dialog box includes the following elements:

Description Enables you to change the CI type of the TQL node after 
you have created a TQL query.

To access: Right-click the required node and select 
Change Type.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the 
Change Type option.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

Important 
Information

You can change the CI type to a type from one of the 
CIT’s sub-CITs, if one exists. If one does not exist, this 
option does not appear.

GUI Element Description

List of CI types from 
which to choose

Select the required CI type.
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Element Instances Dialog Box

Description Display all of the CI instances found for the selected TQL 
node in a table.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
In the Editing pane, right-click the required node and 
select Show Element’s Instances.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Show 
Element’s Instances option.

To access in Discovery:
1  In Resource Configuration, click the  button to the 

right of the Input TQL box, located in the Pattern 
Signature tab, to open the Input TQL Editor.

2  Right-click the required node and select Show 
Element’s Instances.
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The Element Instances dialog box includes the following elements (listed 
alphabetically):

Important 
Information

The columns displayed in the report vary according to the 
CI type selected. 

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see “Attributes Page” in CI Attribute 
Customization. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
“Attributes Page” in CI Attribute Customization.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Filter the CI instances you want to display for the 
selected node. Opens the Filter CI Instances dialog box.

Clear the filter definitions you created in the Filter CI 
Instances dialog box.

Hide or display specific columns. Opens the Columns 
dialog box.

Update the table.

Determine the number of CI instances that appear on a 
page. Opens the Set Rows Per Page dialog box.
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Go to first page

Go to previous page.

The list of CIs are divided into pages. The number 
indicates which page is currently being displayed. For 
example, 2/7 means that it is the second out of seven 
pages. Click this button to go to a different page. The Set 
Page Number dialog box opens.

Note: For details on how to determine the number of CI 
instances that appear on a page, see “Set Rows Per Page 
Dialog Box” on page 46.

Go to next page.

Go to last page.

Toggle between hiding and displaying columns.

<CI type attributes> The attributes of the CIT of the selected CI.

<Click a column 
header>

For details, see “Working with Tables” on page 43.

<Right-click a column 
header>

For details, see “Working with Tables” on page 43.

CI Type The CIT of the selected CI.

Display Label The name of the CI instance as it appears in the topology 
map.

GUI Element Description
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Filter CI Instances Dialog Box

The Filter CI instances dialog box includes the following elements (listed 
alphabetically):

Description Enables you to reduce the number of CI instances to be 
displayed in a list by selecting a condition and a value for 
a specific CI.

To access: 

➤ Click the Filter  button in the Element Instances 
dialog box.

➤ In Discovery, click the Filter button in the CIs 
Discovered by [Module Name] dialog box. 

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Condition Select the required operator. For details, see “Attribute 
Operator Definitions” on page 185.

Display Name The display name of the Configuration Item type to 
which the CI belongs.

Value Select or enter the required value.
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Join Relationship Condition Dialog Box

The Join Relationship Condition dialog box includes the following elements 
(listed alphabetically):

Description Enables you to define the connection between two nodes 
using a join relationship. The join definition appears in 
the Join Definition area.

To access: Click the Add a Join definition  button in 
the Join Definition area in the Add Relationship dialog 
box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

<Selected node1> A selected node. The first attribute applies to <end_1>.
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Layout Settings Dialog Box

<Selected node2> A selected node. The second attribute applies to <end_2>.

Operator Select one of the following operators: 

➤ Equal. The system checks whether two selected 
attributes are equal.

➤ Not equal. The system checks whether two selected 
attributes are not equal.

➤ Sub string. The system checks whether the value of the 
first attribute is a substring of the value of the second 
attribute.

➤ Sub string ignore case. The system checks whether the 
value of the first attribute is a substring of the value of 
the second attribute regardless of the string’s case.

Important: When using the operator Not equal, ensure 
that both sides of the join relationship have a limited 
result size. It is recommended to define more specific 
conditions so as not to overload the system with large 
results.

Description Enables you to determine which attributes are used in the 
calculation of the TQL query when using the UCMDB 
API. For details, see “Working with the HP Universal 
CMDB API” in Solutions and Integrations.

To access: Click the Advanced layout settings link in the 
Node/Relationship condition dialog box.

GUI Element Description
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The Layout Settings dialog box includes the following elements (listed 
alphabetically):

Important 
Information

➤ Since this option is only relevant when querying the 
CMDB API, the query results in the user interface is not 
impacted by the attributes you select in this dialog 
box.

➤ Once you have selected the required attributes and 
clicked OK, you cannot clear the selections you have 
made.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the 
query’s calculation.
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Node/Relationship Condition Dialog Box

Description Enables you to define the attribute conditions for the 
selected TQL node/relationship.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager: 
➤ In the Editing pane, right-click the required node and 

select Node/Relationship Condition.

or

➤ Click the Edit Definition  button in the 
Information pane.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Node 
Condition option.

To access in Discovery:
1  In Resource Configuration in Discovery, click the  

button to the right of the Input TQL box, located in 
the Pattern Signature tab, to open the Input TQL 
Editor.

2  Right-click the required node and select 
Node/Relationship Condition.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management 
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The Node/Relationship dialog box includes the following elements (listed 
alphabetically):

GUI Element Description

Advanced layout 
settings

Enables you to determine which attributes are used in the 
calculation of the TQL query when querying the CMDB 
using third-party or custom tools. 

Opens the Layout Settings dialog box. For details, see 
“Layout Settings Dialog Box” on page 148.

Element name (Optional) The Element name box contains the name of 
the selected node/relationship. By default, the CIT type is 
assigned as the element’s name. You can rename a TQL 
node in the Element name box giving it a unique label. 
This can be helpful when there is more than one node of 
the same CIT type in the TQL query.
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This dialog box contains the following tabs:

➤ “Attribute Tab” on page 153

➤ “Qualifier Tab” on page 155

➤ “Element ID Tab” on page 157

➤ “Cardinality Tab” on page 159.

Include subtypes Display both the selected CI and its descendents in the 
topology map.

Visible Select Visible to display the selected TQL node in the 
Editing pane. When Visible is cleared, an invisible box  
appears to the right of the selected TQL node in the 
Editing pane.

Any query results pertaining to that TQL node are not 
displayed in the topology map. This can be useful when 
certain relationships or TQL nodes are required to build 
the query but are not needed in the results. For example, 
Windows are connected to the network by defining 
specific IPs, but in any query results you may want to 
view the IP elements only and not the Windows 
elements.

GUI Element Description
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Attribute Tab

The Attribute tab includes the following elements:

Description ➤ Add an attribute condition to a node or relationship.

➤ Filter the query results. For details, see “Attribute Area” 
on page 154.

To access: Click the Attribute tab in the 
Node/Relationship Condition dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Add an attribute definition. Opens the Attribute 
Condition dialog box. 

Note: The attribute condition you define appears in the 
Attribute area. For details, see “Attribute Area” on 
page 154.

Delete an attribute condition.

Edit an attribute condition. Opens the Element Instances 
Dialog Box.

Insert an attribute condition before a selected row.

Move a selected row up.

Move a selected row down.
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Attribute Area

The Attribute area includes the following elements (listed alphabetically):

Description Enables you to create an expression defining conditions 
that restrict the number of nodes that appear in the 
query.

To access: 

➤ Click the Attribute tab in the Node/Relationship 
Condition dialog box.

or

➤ Click Next in the New TQL Relationship Page wizard 
page.

GUI Element Description

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets

Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.
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Qualifier Tab

Description Enables you to define qualifier conditions for the selected 
node or relationship. For example, you can use a qualifier 
to define a CIT as abstract, meaning you cannot create 
instances from it.

To access: Click the Qualifier tab in the 
Node/Relationship Condition dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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The Qualifier tab includes the following element:

GUI Element Description

<Qualifiers> Following are the qualifier definitions: 

➤ ABSTRACT_CLASS. You cannot create instances of this 
CIT.

➤ BLE_LINK_CLASS. A relationship that has been 
assigned this qualifier is loaded by an online BLE 
engine TQL and becomes part of the Dashboard status 
calculations.

➤ CONTAINER. This qualifier is assigned to relationships 
that signify a containment relationship, such as 
Member, Container link, Contains, or Contained.

➤ HIDDEN_CLASS. Instances of this CIT do not appear 
anywhere in the application.

➤ ITU_HIDDEN_CLASS. Instances of this CIT do not 
appear in the topology map application.

➤ MAJOR_APP. CITs which are assigned this qualifier 
appear in the Major Application Type Breakdown 
overview report for details, see “Major Application 
Type Breakdown” in IT World Model Management). 

➤ NETWORK_DEVICES. A qualifier common to all the 
CITs that represent a network device. It can be used for 
TQL queries related to network devices and serves as a 
replacement for CITs in a query.

➤ ProtocolDialog. For internal use only.

➤ READ_ONLY_CLASS. This CIT cannot be edited.

➤ TRACK_LINK_CHANGES. Changes that occur on the 
specified relationship appear in Change reports. For 
details, see “Change Report User Interface” in IT World 
Model Management.

Important: Multiple selection links the conditions with 
the Or operator.
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Element ID Tab

The Element ID tab includes the following elements :

Description Enables you to filter the TQL results according to the 
element ID of the instances found for the selected TQL 
node. 

Move the required element from the TQL node instances 
pane on the left to the to the Filtered TQL results pane on 
the right to define what you want included in the TQL 
results using the double right arrows.

The Element ID dialog box has the following panes:

➤ TQL Node Instances Pane

➤ Filtered TQL Results Pane

To access: Click the Element ID tab in the Node 
Condition dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Filter the CI instances you want to display for the selected 
node. Opens the Filter CI Instances dialog box.

Clear the filter definitions you created in the Filter CI 
Instances dialog box.

Hide or display specific columns. Opens the Columns 
dialog box.

Update the table.
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TQL Node Instances Pane

The TQL node instances pane includes the following elements (listed 
alphabetically):

Determine the number of CI instances that appear on a 
page. Opens the Set Rows Per Page dialog box.

Go to first page

Go to previous page.

The list of CIs are divided into pages. The number 
indicates which page is currently being displayed. For 
example, 2/7 means that it is the second out of seven 
pages. Click this button to go to a different page. The Set 
Page Number dialog box opens.

Note: For details on how to determine the number of CI 
instances that appear on a page, see “Set Rows Per Page 
Dialog Box” on page 46.

Go to next page.

Go to last page

Description Displays all the instances found for the selected TQL 
node in a table.

To access: Click the Element tab in the Node Condition 
dialog box.

GUI Element Description

CI Type The CI type

Display label The label that is displayed for the node’s instance.

ID The unique ID for the node’s instance.

GUI Element Description
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Filtered TQL Results Pane

The Filtered TQL Results pane includes the following elements (listed 
alphabetically):

Cardinality Tab

Description Displays the elements that are used to define what should 
be included in the TQL results.

To access: Click the Element tab in the 
Node/Relationship dialog box.

GUI Element Description

CI Type The CI type

Display label The label that is displayed for the node’s instance.

ID The unique ID for the node’s instance.

Description Enables you to define how many CI instances you expect 
to have at the end of a relationship in your query result.

To access: Click the Cardinality tab in the 
Node/Relationship dialog box.

Important 
Information

This tab appears only when a node is selected.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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The Cardinality tab includes the following elements:

Cardinality Area

The Cardinality area includes the following elements (listed alphabetically):

GUI Element Description

Add a cardinality definition. Opens the Relationship 
Cardinality dialog box.

Note: The relationship cardinality you define appears in 
the Cardinality area.

Delete a cardinality definition from the Cardinality area.

Edit a cardinality definition. Opens the Relationship 
Cardinality dialog box.

Insert a cardinality definition before a selected row.

Move a selected row up.

Move a selected row down.

Description Enables you to define relationship conditions that enable 
the relationship’s connecting node to be included in the 
TQL query results. In the Cardinality area, you can create 
an expression defining that condition. For an example, 
see “Example of a Relationship Condition” on page 162.

GUI Element Description

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex logical statements.
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Relationship Cardinality Dialog Box

Criteria Contains the cardinality definition as defined in the 
Relationship Cardinality dialog box. 

Not Select NOT if you want the cardinality definition to do 
the opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that are not assigned a value. For 
example, let us assume that your system contains three 
hosts. Host1 is assigned the value A, Host2 is assigned the 
value B and Host3 is not assigned a value. If you create a 
query in which you want to retrieve all hosts that are 
equal to A and you select NOT, the results of your query 
only include Host2 because Host3 is not assigned a value.  

Description Enables you to define a relationship cardinality. Select the 
required relationship to which the selected node is 
attached. Then define the lower and upper limits for 
including the node at the other end of the relationship in 
the query results.

To access: Click the Add a cardinality definition  
button in the Cardinality tab in the Node/Relationship 
Condition dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description
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The Relationship Cardinality dialog box includes the following elements 
(listed alphabetically):

Example of a Relationship Condition

The example of relationship conditions is based on the following TQL 
query:

 

GUI Element Description

Max Enter the value that defines the upper limits for 
including the node at the other end of the relationship in 
the query results. 

Note: You can use an asterisk (*) in the Max box to 
represent an infinite value.

Min Enter the value that defines the lower limits for including 
the node at the other end of the relationship in the query 
results.

For example, if <end_1> is IP and <end_2> is Windows, 
entering 1 in the Min box and asterisk (*) in the Max box 
instructs the system to retrieve only those IPs that are 
connected to at least one Windows operating system. 
(The asterisk indicates an infinite value.) Entering 3 in 
the Min box and asterisk (*) in the Max box instructs the 
system to retrieve only those Windows operating systems 
that are connected to at least three IPs.

Node Select the required relationship to which the selected 
node is attached. The list contains all the relationships 
that are linked to the selected node.
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In the Relationship Cardinality dialog box, the following relationship 
conditions are defined for the TQL:

➤ Member – Min: 1, Max: *

➤ Contained – Min: 2, Max: 4

The definitions appear in the Cardinality section, as follows:

➤ [member (Network, Host)] OR [contained (Host, IP)] means that the host must 
either have between two and four IPs OR be a member of the network.

➤ [member (Network, Host)] AND [contained (Host, IP)] means that the host must 
have between two and four IPs AND ALSO be a member of the network.
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Subgraph Dialog Box

Description Enables you to create a graph that represents additional 
TQL query data related to a specific CI. The Discovery job 
searches for the results from both the TQL query and the 
dependency graph definitions. The query recursively 
retrieves all the related CIs by a defined depth.

In the graph, you can define the relationship that is 
connected to a specific node. For example, if one of the 
nodes is a host, you can specify different relationships for 
Windows, router, and IP. You can also define attribute 
conditions for nodes. For details, see “Subgraph 
Condition Definition Dialog Box” on page 168.

The Discovery job retrieves data that meets the criteria 
that is defined in the dependency graph.

For an example, see “Sample Subgraph Definition” on 
page 165.

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
In the Editing pane, right-click the required node and 
select Add Subgraph.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane to display the Show 
Subgraph option.

To access in Resource Configuration in Discovery:
1  Click the  button to the right of the Input TQL 

box, located in the Pattern Signature tab, to open the 
Input TQL Editor.

2  Right-click the required node and select Add 
Subgraph.

Important 
Information

The following icon is displayed next to the icon for 
which you define a subgraph:
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The Subgraph dialog box includes the following elements (listed 
alphabetically):

Sample Subgraph Definition

This section describes how to create a subgraph definition. In this example, 
the TQL query results retrieve all CIs that are connected to a host whose 
host’s display label is <host display label> by either a Container link or a 
Contained relationship.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management

GUI Element Description

Add a dependency definition to the Dependencies area. 
Opens the Add Dependency dialog box.

Delete a dependency definition from the Dependencies 
area.

Edit a dependency definition. Opens the Add 
Dependency dialog box.

Depth A number that represents the longest path (that is, the 
most connecting nodes) allowed between two CIs in the 
CMDB that should be included in the Discovery process.

Default: 5.

Node1 The required node selected in the Add Dependency 
dialog box.

Node2 The required node selected in the Add Dependency 
dialog box.

Relationship The relationship selected in the Add Dependency dialog 
box connecting <node1> to <node2>.
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To create this sample subgraph definition:

 1 Create a TQL query and drag a Host node from the CI Types pane onto the 
Editing pane.

 2 Right-click the Host node and select Add Subgraph to open the Subgraph 
dialog box.

 3 Select the default subgraph definition that appears and delete it.

 4 Click the Add button to open the Add Dependency dialog box and do the 
following:

➤ From the Source list, select IT Universe.

➤ From the Target list, select IT Universe.

➤ From the Relationship list, select Contained.

 5 Click OK to save your changes.

 6 Click the Add button to open the Add Dependency dialog box and do the 
following:

➤ From the Source list, select IT Universe.

➤ From the Target list, select IT Universe.

➤ From the Relationship list, select Container link.

 7 Click OK to save your changes.

 8 Click the Add button to open the Add Dependency dialog box and do the 
following:

➤ From the Source list, select IT Universe.

➤ From the Target list, select IT Universe.

➤ From the Relationship list, select Contains.

 9 Click OK to save your changes.
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The Add Dependency dialog box now looks like this.

 10 Click OK in the Subgraph dialog box.

 11 Right-click the Host node and select Node Condition to open the Node 
Condition dialog box.

 12 Click the Attribute tab.

 13 Click the Add an attribute condition button to open the Attribute 
Condition dialog box.

 14 From the Attribute Name list, select Display Label.

 15 From the Operator list, select Equal.

 16 Select Fixed Value.

 17 In the box under Value cannot be changed, enter <host display label>.

 18 Click OK to save your changes.

The Attribute tab now looks like this.
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Go to the required view in IT Universe to view the results.

The results show that the labm1amrnd06 (Host) CI is linked to the 
16.59.61.134 (IP) CI by the Contained relationship and to the 
0016353E6EA2 (Interface) CI by the Container link relationship.

Subgraph Condition Definition Dialog Box

Description Enables you to:

➤ Define attribute conditions for nodes and 
relationships.

➤ Filter the query results. For details, see “Attribute Area” 
on page 169.

To access: Click Condition  in the Add Dependency 
dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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The Subgraph Condition Definition dialog box includes the following 
elements (listed alphabetically):

Attribute Area

GUI Element Description

Define the attribute condition name, the operator and 
the value necessary to create the condition. Opens the 
Element Instances Dialog Box. 

Note: The condition definition appears in the Attribute 
area. For details, see “Attribute Area” on page 169.

Edit an existing attribute condition. Opens the Element 
Instances Dialog Box.

Delete an attribute condition.

Insert an attribute condition before a selected row.

Move a selected row up.

Move a selected row down.

CIT Contains the CIT selected from the Source and Target 
lists.

Description Displays an expression defining conditions that restrict 
the number of nodes that appear in the query.

To access: Click Condition  in the Add Dependency 
dialog box.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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The Attribute Area includes the following elements (listed alphabetically):

GUI Element Description

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, let us assume that your system contains three 
hosts. Host1 is assigned the value A, Host2 is assigned the 
value B and Host3 is not assigned a value. If you create a 
query in which you want to retrieve all hosts that are 
equal to A and you select NOT, the results of your query 
only include Host2 because Host3 is not assigned a value.
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TQL Node Wizard

Description Enables you to build a TQL query. 

To access in Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, and View 
Manager:
In the Editing pane, right-click the required node and 
select TQL Node Wizard.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the Editing pane.

To access in Job Configuration in Discovery:
1  Select a job in the Discovery Modules pane. Select a 

Trigger TQL in the Properties pane. Click the Open the 
TQL Editor button to open the Trigger TQL Editor.

2  Right-click the required node and select TQL Node 
Wizard.

To access in Resource Configuration in Discovery:
1  Select a pattern in the Discovery Resources pane. In the 

Pattern Signature tab, click the Edit  button to the 
right of the Input TQL box to open the Input TQL 
Editor.

2  Right-click the required node and select TQL Node 
Wizard.

Important 
Information

If the TQL query is empty, drag the required TQL nodes 
on to the Editing pane from the tree displayed in the CI 
Types pane.

Included in Tasks ➤ “Define a Report Rule” in IT World Model Management

➤ “Create a Correlation Rule” in IT World Model 
Management

➤ “Define an Enrichment Rule” in IT World Model 
Management

➤ “Define a TQL Query” in IT World Model Management

➤ “Pattern View Workflow” in IT World Model 
Management
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New TQL Node Page

Useful Links “Topology Query Language” on page 115

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Condition Page > Element Instances Page

Description Enables you to add a node to the TQL query.

Important 
Information

If the TQL query is empty, drag the required TQL node on 
to the Editing pane from the tree displayed in the 
Configuration Item Types pane.

For general information on the TQL Node Wizard, see 
“TQL Node Wizard” on page 171.

Useful Links “Topology Query System Overview” on page 115

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > 
TQL Node Condition Page > Element Instances Page
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The New TQL Node wizard page includes the following elements (listed 
alphabetically):

GUI Element Description

<node> is required Define the relationship cardinality. For details, see 
“Relationship Cardinality Dialog Box” on page 161.

➤ Select the <node> is required check box for each node 
to include a minimum of one instance of the node at 
the other end of the relationship in the query results. 
Selecting the check box gives the relationship a 
cardinality value of 1*.

➤ Clear the <node> is required check box to give the 
relationship a cardinality value of 0*.

Element name (Optional) Contains the name of the selected node. By 
default, the CIT type is assigned as the element’s name

You can rename a TQL node in the Element name box 
giving it a unique label. This can be helpful when there is 
more than one node of the same CIT type in the TQL 
query.

Show only CITs with 
instances

Select this check box to display only the CITs of which 
there are instances in the CMDB.

Note: The Show only CITs with instances check box is 
selected by default.

TQL Node hierarchy 
tree

Select the required node. The node you select appears in 
the Element name box.

This list only includes the nodes of the CIT type that have 
valid relationships to the selected (source) node. 

To the right of each node, the number of CI instances 
that exist in the CMDB for that CIT type is displayed. The 
number of instances is only updated after you close the 
TQL Node Wizard and open it again.

Note: The first node in the hierarchy tree is selected by 
default.
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New TQL Relationship Page

The New TQL Relationship wizard page includes the following elements 
(listed alphabetically):

TQL Node Condition Page

Description Enables you to add a relationship to a TQL query.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Condition Page > Element Instances Page.

GUI Element Description

Direction Select the required relationship direction. The direction 
indicates which node is dependent on the other.

Node Label The label of the node you selected in the New TQL Node 
page.

Note: This field appears in the Node Label box on the 
right hand side of the page.

Relationship Type A valid relationship that defines the connection between 
the selected nodes. The box displays the relationship you 
selected in the relationship hierarchy tree.

Show only 
relationships with 
instances

Display only the relationships of which there are 
instances in the CMDB.

TQL Relationship 
hierarchy tree

Select the required relationship. The node you select 
appears in the Relationship Type box.

Description Enables you to define the attribute conditions for the 
selected TQL node.

Useful Links “Topology Query System Overview” on page 115.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Condition Page > Element Instances Page
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The TQL Node Condition wizard page includes the following elements 
(listed alphabetically):

GUI Element Description

Add an attribute definition. Opens the Attribute 
Condition dialog box.

Note: The attribute condition you define appears in the 
Attribute Area. For details, see “Attribute Area” on 
page 154.

Delete an attribute condition.

Edit an attribute condition. Opens the Element Instances 
Dialog Box.

Insert an attribute condition before a selected row.

Move a selected row up.

Move a selected row down.
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Element Instances Page

Include subtypes Display both the selected CI and its descendents in the 
topology map.

Visible Select Visible to display the selected TQL node in the 
editing pane. When Visible is cleared, an invisible box  
appears to the right of the selected TQL node in the 
Editing pane.

Any query results pertaining to that TQL node are not 
displayed in the topology map. This can be useful when 
certain relationships or TQL nodes are required to build 
the query but are not needed in the results. For example, 
Windows are connected to the network by defining 
specific IPs, but in any query results you may want to 
view the IP elements only and not the Windows 
elements.

Description Displays all the instances found for the selected TQL node 
in a table. 

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Condition Page > Element Instances Page.

GUI Element Description
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The Element’s instances dialog box includes the following elements (listed 
alphabetically):

GUI Element Description

Update the table.

Determine the number of CI instances that appear on a 
page. Opens the Set Rows Per Page dialog box.

Go to first page

Go to previous page.

The list of CIs are divided into pages. The number 
indicates which page is currently being displayed. For 
example, 2/7 means that it is the second out of seven 
pages. Click this button to go to a different page. The Set 
Page Number dialog box opens.

Note: For details on how to determine the number of CI 
instances that appear on a page, see “Set Rows Per Page 
Dialog Box” on page 46.

Go to next page.

Go to last page

<CI type attributes> The attributes of the CIT of the selected CI.

<Click a column 
header>

For details, see “Working with Tables” on page 43.

<Right-click a column 
header>

For details, see “Working with Tables” on page 43.

CI Type The CIT of the selected CI.

Display Label The name of the CI instance as it appears in the topology 
map.
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15
Topology Query Language Context Menu 
Options

This chapter includes a list of TQL context menu options (listed 
alphabetically):

GUI Element Description

Add Relationship ➤ Displays the Add Relationship dialog box, enabling 
you to create a relationship for your nodes by selecting 
it from a predefined list.

➤ In Enrichment Manager, this option adds an 
Enrichment relationship to the rule when working in 
Enrichment mode. Applicable for regular and 
Enrichment nodes. For details, see “Enrichment 
Manager User Interface” in IT World Model Management

Note: Added relationships are displayed by an added 
 indicator.

For details, see “Add Relationship Dialog Box” on 
page 128.
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Add Rule Enables you to add folding rules to a relationship. Right-
click the relationship for which you want to define a 
folding rule. Select one of the following options to define 
the organizational structure between the two CI types 
connected by the selected relationship:

➤ Parent. Select this option to display Node1 as the 
parent of Node2. That is, double-clicking the Node1 
element on one map level displays a new map level 
with Node2 elements.

➤ Right Sibling. Select this option to display Node1 
elements wherever Node2 elements are displayed. That 
is, both CIs are displayed on the same map level.

➤ Left Sibling. Select this option to display Node2 
elements wherever Node1 elements are displayed. That 
is, both CIs are displayed on the same map level.

➤ Child. Select this option to display Node1 as the child 
of Node2. That is, double-clicking a Node2 element on 
one map level displays a new map level with Node1 
elements.

➤ None. Do not define any folding rules for this 
relationship.

Note: Only relevant for View Manager.

Add Subgraph Displays the Subgraph dialog box, where you can create a 
graph that represents additional TQL query data related 
to a specific node. For details, see “Subgraph Dialog Box” 
on page 164.

Add to Applications Click to create an application CI and link it to all CIs of 
the type selected. For details, see “Link Nodes to 
Application CI” in IT World Model Management.

Note: Only relevant for View Manager.

Change Type Displays the Change CI Type dialog box. Enables you to 
change the CI type of the node after you have created it. 
For details, see “Change CI Type Dialog Box” on 
page 142.

Note: This option appears only when the selected CI type 
has descendants.

GUI Element Description
180



Chapter 15 • Topology Query Language Context Menu Options
Clear Available by right-clicking a node or relationship when 
working in Enrichment mode in the Enrichment 
Manager. Clears the node/relationship’s Enrichment rule 
definition. For details, see “Enrichment Manager User 
Interface” in IT World Model Management.

Appears only if you have updated or deleted a 
node/relationship using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

Clear Node 
Definition

Deletes the report definition for the selected Report node. 
For details, see “Report Manager User Interface” in 
IT World Model Management.

Note: Only relevant for Report Manager.

Copy/Paste Copy/paste an existing TQL node/relationship in the 
same query or into another TQL query.

The copied TQL node/relationship includes all TQL 
definitions.

You can copy and paste relationships provided that the 
TQL nodes to which the relationships are connected are 
also selected. A relationship on its own cannot be copied 
without its connecting TQL nodes.

You can select multiple TQL nodes/relationships as well.

Note: This option is available only after using the Copy 
option to copy an existing TQL node/relationship.

Define Affected Define which node in the TQL query is the trigger 
Correlation node and which nodes are affected by the 
changes that occur in the system. For details, see 
“Affected Nodes Dialog Box” on page 317.

Note: Only relevant for Correlation Manager.

Delete Deletes the selected node/relationship/CI.

GUI Element Description
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Delete 
Relationship/Node

Available by right-clicking a node or relationship when 
working in Enrichment mode.

Creates a specific Enrichment rule that is designed to 
delete CIs/relationships from the CMDB. Applicable to 
regular nodes and relationships only. You can use this 
option, for example, for removing unnecessary data from 
the CMDB. For details, see “Enrichment Manager User 
Interface” in IT World Model Management.

Deleted nodes are displayed by a removed  indicator.

Note: Only relevant for Enrichment Manager.

Edit Relationship 
Type

Displays the Edit Relationship Type dialog box. For 
details, see “Add Relationship Dialog Box” on page 128.

Note: This option appears only when the selected 
relationship has descendants.

Node Order Displays the Set Node Order dialog box, enabling you to 
determine the order in which Report node information is 
displayed in the report, that is, the order of the report’s 
columns. For details, see “Set Node Order Dialog Box” in 
IT World Model Management.

Note: Only relevant for Report Manager.

Node/Relationship 
Condition

Displays the Node/Relationship Condition dialog box, 
enabling you to define the attribute conditions for the 
selected TQL node/relationship. For details, see 
“Node/Relationship Condition Dialog Box” on page 150.

Remove from 
Applications

Click to remove a business service item from a business 
service view. For details, see “Link Nodes to Application 
CI” in IT World Model Management.

Note: Only relevant for View Manager.

Remove Subgraph Only appears if you have defined a dependency graph. 
For details, see “Subgraph Dialog Box” on page 164.

GUI Element Description
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Report Node 
Definition

Displays the Report Node Definition dialog box, enabling 
you to determine the content of the report. For details, 
see “Report Node Definition Dialog Box” in IT World 
Model Management.

Note: Only relevant for Report Manager.

Reset Affected Removes the Define Affected definition applied to that 
node. For details on the Define Affected definition, see 
“Affected Nodes Dialog Box” in IT World Model 
Management.

Note: Only relevant for Correlation Manager.

Reset Inner 
Relationship

Redraws a self-referential relationship in the Topology 
map as a square for ease of viewing.

Note: Only relevant for self-referential relationships 
which are not square.

Set View Element 
Parameters

Appears only when a parameterized condition is defined 
for the selected CI. 

Displays the Set View Element Parameters dialog box 
where you can edit the parameter of each condition. For 
details, see “Set View Parameters/Set View Element 
Parameters Dialog Box” in IT World Model Management.

Note: Only relevant for View Manager and for views in 
IT Universe Manager and Change Report.

Show Element’s 
instances

Displays the Element Instances dialog box which displays 
all the instances found for each node in a table. For 
details, see “Element Instances Dialog Box” on page 143.

Straighten Straightens the relationship between two nodes. This 
option is only available for relationships that have angles.

TQL Node Wizard Displays the TQL Node Wizard dialog box which enables 
you to build a TQL query. For details, see “TQL Node 
Wizard” on page 171.

GUI Element Description
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Update 
Relationship/Node

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. Opens the Node Definition 
- Attributes dialog box. For details, see “Node Definition – 
Attributes Dialog Box” in IT World Model Management. 
This is applicable for both regular and Enrichment nodes. 

Updated nodes are displayed by an updated  indicator.

Note: Only relevant for Enrichment Manager.

View 
Node/Relationship 
Definition

Displays the Condition dialog box which enables you to 
group CIs in the topology map. For details, see 
“Condition Dialog Box” in IT World Model Management.

Note: Only relevant for View Manager.

GUI Element Description
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Attribute Operator Definitions

This chapter contains a list of operators that define attribute conditions.

Operator Description

Changed during (Displayed only when you select the Create Time 
attribute.) Displays only the instances that changed 
during the period specified in the Value comparison 
box.

Equal Checks whether the attribute value is equal to the 
value specified in the Value Comparison box.

Equal ignore case Checks whether the attribute value is equal to the 
value specified in the value box regardless of the 
case.

Great than or equal Checks whether the attribute value is greater than 
or equal to the value specified in the Value 
comparison box.

Greater Checks whether the attribute value is greater than 
the value specified in the Value comparison box.

In Displays only the instances where this attribute 
value equals one of the selected values. For 
example, for CIs that have a Change state that 
equals Plan and New, select the operator In from the 
Operator list and select both Plan and New from 
the Value box.

In list Equals one of the elements that appears in the list, 
for example: 320,4445,3483.

Is null Checks whether the attribute value is null.
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Less Checks whether the attribute value is less than the 
value specified in the Value comparison box.

Less than or equal Checks whether the attribute value is less than or 
equal to the value specified in the Value comparison 
box.

Like Uses a wildcard (%). Use Like when you are not sure 
of the complete name for which you are searching.

Like ignore case Uses a wildcard (%). Use Like ignore case when you 
are not sure of the complete name for which you 
are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to 
the value specified in the Value Comparison box.

Unchanged during (Displayed when you select a date type attribute.) 
Displays only the instances that did not change 
during the period specified in the Value comparison 
box.

Operator Description
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Note: 

➤ For Not equal or Not like operators, query results do not include data 
from the CI instances that are not assigned a value. For example, a 
system contains three hosts: Host1 is assigned the value A, Host2 is 
assigned the value B, and Host3 is not assigned a value. If you create a 
query to retrieve all hosts that are Not equal to A, the results of your 
query include Host2 only, because Host3 is not assigned a value.

➤ HP Business Availability Center supports both Microsoft SQL Server and 
Oracle Server servers. Microsoft SQL Server is not case sensitive by default 
(unlike Oracle Server which is case sensitive). Consequently, if you are 
using Microsoft SQL Server, the Equal operator retrieves the same query 
results as the Equal ignore case operator. For example, if you select the 
attribute City, the operator Equal, and type NEW YORK in the Value 
comparison box, case differences are ignored and query results include 
NEW YORK, New York and new york. 
187



Chapter 16 • Attribute Operator Definitions
188



17
Adding Nodes and Relationships to a TQL 
Query

This chapter explains how to add nodes and relationships to a TQL query. It 
is relevant for View Manager, Query Manager, Correlation Manager, 
Enrichment Manager, and Report Manager.

Note: For TQL queries to be valid, they must comply with certain 
restrictions. For details, see “TQL Query Validation Restrictions” on 
page 117.

Adding Nodes and Relationships to a TQL Query

This section describes how to add nodes and relationships to a TQL query in 
Query Manager, Correlation Manager, Report Manager, and View Manager.

To add nodes and relationships to a TQL query:

 1 From the tree in the left pane, select the required query or create a new one. 
For details, see “Create New TQL/TQL Properties Dialog Box” in IT World 
Model Management.

This chapter describes: On page:
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Adding Enrichment Nodes and Relationships to an Enrichment TQL 
Query
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 2 From the tree displayed in the CI Types pane, click and drag one or more 
required TQL nodes on to the Editing pane. These are the TQL nodes that 
are included in the query.

 3 To add a relationship between two nodes:

➤ Select the required TQL node(s) by holding down CTRL and clicking the 
TQL nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the required 
nodes.

The Add Relationship dialog box opens. For details, see “Add Relationship 
Dialog Box” on page 128.

 4 Click OK. The selected nodes are linked by the relationship you have 
selected.

Adding Enrichment Nodes and Relationships to an 
Enrichment TQL Query

This section describes how to add Enrichment nodes and relationships to an 
Enrichment TQL query in the Enrichment Manager. For more information 
on Enrichment Manager, see “Enrichment Manager User Interface” on 
page 361.

To add Enrichment nodes and relationships to a TQL query:

 1 From the tree in the Enrichment Rules pane, select the Enrichment rule to 
which you want to add Enrichment nodes and relationships or create a new 
one. For details, see “Create New Enrichment Rule/Properties Dialog Box” in 
IT World Model Management.

 2 From the TQL/Enrichment list at the top of the Enrichment Manager 
window, select Enrichment mode.

 3 From the tree displayed in the CI Types pane, click and drag the nodes you 
want to function as an Enrichment node on to the Editing pane. These are 
the TQL nodes that are included in the query. Added Enrichment nodes are 
displayed by an added indicator.
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Note: You can add more than one Enrichment node to a rule.

 4 The next step is to link the Enrichment node to an existing TQL node or 
nodes, to provide the Enrichment node with the needed context for its 
operation.

Following are the Enrichment rule validations:

➤ You must link the new Enrichment node to at least one of the existing 
TQL nodes in the rule.

➤ Enrichment nodes can only be linked to one another with an 
Enrichment relationship.

➤ If the new Enrichment node must be contained (according to its CIT 
definition) in another node, you must use the Container link relationship 
to connect this Enrichment node to an existing TQL node.

➤ You cannot link an Enrichment node to a TQL node that is not visible.

 5 To add a relationship between two nodes:

➤ Select the required node(s) by holding down CTRL and clicking the TQL 
nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the required 
nodes.

Added Enrichment relationships are displayed by an added indicator. 

The Add Relationship dialog box opens. For details, see “Add Relationship 
Dialog Box” on page 128.

 6 Click OK. The selected nodes are linked by the relationship you have 
selected.
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18
Configuration Management Database 
(CMDB) Concepts

This chapter describes the main CMDB concepts.

Understanding the CMDB

The CMDB is the central repository for the configuration information that is 
gathered from the Discovery process and the various third-party 
applications and tools.

The CMDB contains all the configuration items (CIs) and relationships 
created in HP Business Availability Center, whether created automatically 
from the Discovery process or source adapters, or manually using 
IT Universe Manager. The CIs and relationships together represent a model 
of all the components of the IT Universe in which your business functions. 
The CMDB stores and handles the infrastructure data collected and updated 
by the Discovery process. For more information about the Discovery 
process, see Discovery.

The IT Universe model can be very large, containing millions of CIs. To 
facilitate their management, you work with the CIs in a view that provides a 
subset of the overall components in the IT Universe world.

This chapter describes: On page:
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You use factory views or views defined in View Manager to display and 
manage the CIs and relationships in the CMDB. The views enable you to 
focus on specific IT areas and are available via View Explorer in different 
HP Business Availability Center applications, such as Dashboard and Service 
Level Management. An example of a view is shown in the following figure:

The CMDB also contains the TQL query definitions that are used to query 
and retrieve data from the CMDB, for presentation in the pattern views 
(views based on TQLs); and the configuration item type (CIT) model, a 
repository for the CI types used to define the CIs and relationships. For 
information on TQL queries, see “Topology Query Language” on page 115.

In addition, the CMDB contains the object repositories for the various 
additional data added to CIs in Dashboard and Service Level Management, 
such as KPIs, context menus, and tooltips. For more information on these 
repositories, see “Overview of the Repositories” in CI Attribute Customization.

Configuration Items (CI)
A configuration item (CI) is a component of the CMDB that represents a 
physical or logical entity in the system, for example, hardware, software, 
services, business processes, customers, and so on. The CIs are part of the 
IT Universe model in the CMDB, where they are organized into a 
hierarchical format based on the interdependencies in your organization’s 
IT environment. The interdependencies in HP Business Availability Center 
are called relationships.

Each CI belongs to a configuration item type (CIT). The CIT defines a 
category of CIs used in HP Business Availability Center. The CITs provide 
templates for creating the CIs and associated properties in each category.
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You view and manage the CIs in the CMDB using views. Each view shines a 
spotlight on part of the IT Universe model. Furthermore, changes that you 
make in the view are actually changes to the IT Universe model.

Nodes and Relationships
Nodes are the components from which TQL queries are built in the 
Enrichment Manager, View Manager, Correlation Manager, Report Manager, 
and Query Manager.

Relationships are connections defined between CIs. Relationships are 
defined one at a time for each pair of nodes in a TQL query.

CMDB Log Files
CMDB log files enable you to perform basic troubleshooting of common 
CMDB runtime problems. Additionally, tracking CMDB behavior in the log 
files enables you to examine the effects of changes made in the system. For 
details, see Chapter 27, “CMDB Logs.” 
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CMDB Configuration Parameters

This chapter describes configuration parameters used in the CMDB.

 

This chapter describes: On page:
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CMDB Configuration Parameters Overview

This chapter describes the parameters needed for configuring the CMDB. By 
changing the values of CMDB parameters, the administrator can change the 
runtime behavior of CMDB.

Note: Changed parameters may impact the entire system and not just the 
CMDB. In this chapter, parameters that can be changed by users are marked 
Y in the Change Value? (Y/N) column of each table. All other parameters 
should be changed by Customer Support only.

To modify a parameter, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Foundations, select cmdb and locate the 
parameter in the appropriate table. Click the Edit button and modify the 
parameter with the required value.

CMDB configuration parameters are located in the following contexts in the 
Infrastructure Settings Manager:

➤ Applications:

➤ MAMWeb  

➤ UCMDB GUI

➤ Foundations:

➤ CMDB

➤ MAMServer

➤ UCMDB common
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Aging Parameters 

This section describes the aging parameters: 

 

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

model.aging.i
s.aging.enable
d

Defines whether the 
aging mechanism is 
enabled.

boolean ➤ true. Aging is 
enabled. The 
scheduler runs and 
marks candidates 
(objects/links) for 
deletion.

➤ false. Aging is 
disabled. The 
scheduler does not 
run but the dates 
when candidates 
must be deleted and 
the actual deletion 
are set. This is the 
default.  

Y

model.aging.s
cheduler.hour
.of.first.run

The time when the 
aging parameter 
runs after startup.

integer Default: 2:00 AM N

model.aging.s
cheduler.inter
val.in.hours 

The interval in 
hours between aging 
parameter runs.

integer Default: 24 hours N

model.aging.t
ime.unit=day
s

model.max.re
moved.cis=50
0000
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Configuration Item Type Parameters

This section describes the CIT parameters: 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.classmodel.dao.typ
e

Defines the 
storage type of the 
CI Type Model.

string ➤ jdbc. Storage in 
the database.

➤ xml. Storage in 
an XML file.

N

dal.classmodel.filesyste
m.file.name

Defines the 
relative directory 
path where a CI 
Type is saved 
when the storage 
type is xml.

string The path is relative 
to the HP Business 
Availability Center 
home directory. 

N

dal.classmodel.deploy
ment.dao.type

Defines the 
storage type of a 
CI Type definition 
for initial 
deployment.

string xml. CMDB reads 
from the XML files 
and deploys the CI 
Type in CMDB.

N

dal.classmodel.deploy
ment.file.name

Defines the 
relative directory 
path to the CI 
Type XML files. 
These files are 
needed for CI 
Type deployment.

string All XML files must 
have the suffix 
_deployment.xml. 

N

dal.classmodel.db.nam
e

Defines the name 
of the schema for 
CMDB 
management. 
CMDB 
management 
includes two 
tables: ID gen and 
CMDB versions. 

string Relevant for MS SQL 
only. 

Y
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dal.classmodel.host.na
me

The IP address of 
the CMDB 
management 
database host.

string Y

dal.classmodel.user.na
me

User name to log 
into the CMDB 
management 
database. 

string In Oracle, it is also 
the schema name.

Y

dal.classmodel.passwor
d

Password to log 
into the CMDB 
management 
database.

string Y

dal.classmodel.server The same as 
dal.classmodel.hos
t.name. 

string Defined for DB 
context only. DB 
context is the name 
of a parameter in 
the connection 
pool.

Y

dal.classmodel.sid The sid of a CI 
Type Model.

string Relevant for Oracle 
database.

Y

dal.classmodel.port Defines a TCP port 
of database host.

integer Y

dal.classmodel.db.type The type of 
CMDB.

string ➤ ORACLE Server

➤ SQL Server

Y

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Configuration Item Type Setting Parameters

This section describes the CI Type settings parameters:

 

Data Model Parameters

This section describes the data model parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

classmodel.persistenc
y.file=/cmdb/classmo
del/persistency/class
model.xml

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.datamodel.
dao.type

Defines the type 
of continuous 
storage of a data 
model.

string ➤ jdbc. Continuous 
storage in the 
database.

➤ mock.  

N

dal.datamodel.
db.name

Defines the name 
of the schema.

string Relevant for MS SQL 
Server only.

Y

dal.datamodel.
host.name

The IP address of 
the CMDB 
database host.

Note: CMDB 
database includes 
CI Type Model 
and data model 
database.

string Y

dal.datamodel.
user.name

User name to log 
into the CMDB 
database. 

string In Oracle, it also denotes 
the schema name.

Y
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dal.datamodel.
password

Password to log 
into the CMDB 
database.

string Y

dal.datamodel.s
erver

The same as 
dal.datamodel.host
.name. 

string Defined for DB context 
only. DB context is the 
name of a parameter in 
the connection pool.

Y

dal.datamodel.s
id

If the CMDB 
database is Oracle, 
this parameter 
defines the sid of 
the CI Type 
Model.

string Y

dal.datamodel.
port

The TCP port of 
the database host.

integer Y

dal.datamodel.
db.type

The type of CMDB 
database.

string ➤ ORACLE Server

➤ SQL Server

Y

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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General Server Parameters

This section describes the general server parameters: 

 

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)

server.sync.sessio
n.timeout

The default time-out for 
executing synchronous 
CMDB operations. 

Does not affect 
asynchronous 
operations.

integer ➤ Value is in seconds. 

➤ If the CMDB 
operation runs longer 
than the defined 
value, a request time-
out exception is sent 
to the client.

N

upgrade.enabled Defines whether CMDB 
should perform an 
upgrade on startup.

boolean ➤ true. Perform an 
upgrade.

➤ false. Do not perform 
an upgrade.

N

upgrade.file=/cm
db/upgrade.dat

The file containing the 
date of the last upgrade 
for each customer.

/cmdb/upgrade.dat

task.threads.pool
.size.process

For internal HP use only. integer 20

task.threads.pool
.size.modeltopol
ogy

The number of threads 
dedicated to the CMDB 
model topology.

integer 10

task.threads.pool
.size.tqlcalculator

The number of threads 
dedicated to the TQL 
calculator.

integer 15

task.threads.pool
.size.tqlresultrep
ository

The number of threads 
dedicated to the TQL 
result repository.

integer 8

task.threads.pool
.size.modelquery

The number of threads 
dedicated to the CMDB 
model query.

integer 20
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task.threads.pool
.size.tqlnotificati
on

The number of threads 
dedicated to TQL 
notification.

integer 8

task.threads.pool
.size.tqlresultsutil
s

The number of threads 
dedicated to TQL results 
utilities.

integer 20

task.threads.pool
.size.tqlpatternsc
ache

The number of threads 
dedicated to the TQL 
query cache.

integer 6

task.threads.pool
.size.tqlpatterns
manager

The number of threads 
dedicated to the TQL 
query manager.

integer 2

task.threads.pool
.size.plugins

The number of threads 
dedicated to plug-ins

integer 1

task.threads.pool
.size.raw.event

The number of threads 
dedicated to raw events.

integer 1

task.threads.pool
.size.enrichment
admin

The number of threads 
dedicated to enrichment 
administration.

integer 1

task.threads.pool
.size.enrichment
definition

The number of threads 
dedicated to enrichment 
definitions.

integer 4

task.threads.pool
.size.enrichment
calculation

The number of threads 
dedicated to the 
enrichment calculation.

integer 4

task.threads.pool
.size.classmodel

The number of threads 
dedicated to the CIT 
model.

integer 1

task.threads.pool
.size.deployment

The number of threads 
dedicated to 
deployment.

integer 1

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)
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History Database Parameters

This section describes the History database parameters: 

task.threads.pool
.size.modelupdat
e

The number of threads 
dedicated to updating 
the CMDB model.

integer 1

task.threads.pool
.size.tqlresultrep
ositorycache

The number of threads 
dedicated to the TQL 
results repository cache.

integer 1

task.threads.pool
.size.tqlscheduler

The number of threads 
dedicated to the TQL 
scheduler.

integer 1

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.history.db.nam
e

Defines the 
name of the 
History schema.

string Relevant for MS SQL 
only. 

Y

dal.history.host.na
me

The IP address 
of the database 
host.

string Y

dal.history.user.na
me

User name to 
log into History 
database. 

string In Oracle, it also 
denotes the schema 
name.

Y

dal.history.passwor
d

Password to log 
into the data 
model database.

string Y

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)
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dal.history.server Defined for DB 
context only. 
DB context is 
the name of a 
parameter in 
the connection 
pool.

string The value must be the 
same as 
dal.history.host.name. 

Y

dal.history.sid If the CI Type 
database is 
Oracle, this 
parameter 
defines the SID 
of the CI Type.

string Y

dal.history.port The TCP port of 
the database 
host.

integer Y

dal.history.db.type The type of 
History 
database.

string ➤ ORACLE Server

➤ SQL Server 

Y

dal.history.data.tab
lespace.name

This parameter 
is relevant for 
the Oracle 
database only. 
The DBA can 
define the 
tablespace for 
the History 
data.

cmdbhistorydata

dal.history.index.ta
blespace.name

This parameter 
is relevant for 
the Oracle 
database only. 
The DBA can 
define the 
tablespace for 
indexes.

cmdbhistoryindex

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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History Database Purging Parameters

This section describes the History database purging parameters: 

 

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

history.purging.
days.to.save.bac
k

The minimum 
number of days 
to keep update 
and last create 
changes in the 
CMDB before 
purging those 
changes from 
the History 
database. 

Note: The last 
change of an 
attribute is not 
purged until a 
newer one 
overrides it. 

integer For example, if the value is 
90, changes that occur 
today remain in the 
History database for at 
least 90 days.

Y

history.purging.
scheduler.interv
al.in.hours

The interval of 
time between 
purges of the 
History 
database.

integer Value is in hours.

For example, if the value is 
24, the History database is 
purged every 24 hours.

Y

history.purging.
scheduler.hour.
of.first.run

The hour of the 
day, using a 24 
hour format, to 
begin purging. 
Purging is 
generally 
performed 
during the 
night hours.

integer For example, if the value is 
01, purging begins at 01:00 
every day.

Y
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Monitoring Parameters

This section describes the monitoring parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

monitor.scheduler.lo
ad.customer.number

Defines the number 
of customers to be 
monitored.

Relevant only for the 
Self-Alert Monitor of 
HP Business 
Availability Center 
with one customer 
installation.

integer If the value is -1, no 
customer is 
monitored. 

Values other than -1 
define the number 
of monitored 
customers.

N

monitor.performance
.warning

The minimum 
threshold to define 
CMDB performance 
as Warning.

The maximum 
threshold to define 
CMDB performance 
as Good.

long Value is in 
milliseconds.

N

monitor.performance
.error

The minimum 
threshold to define 
CMDB performance 
as Error. 

The maximum 
threshold to define 
CMDB performance 
as Warning.

long Value is in 
milliseconds.

N

monitor.scheduler.ti
mer.time

The interval of time 
to run a performance 
check.

long Value is in 
milliseconds.

N
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Notification Parameters

This section describes the notification parameters: 

 

monitor.scheduler.de
lay.time

The delay between 
system startup and 
the first performance 
check run.

long Value is in 
milliseconds.

N

task.threads.pool.size
.monitorQuery

The number of 
threads dedicated to 
the pool size monitor 
query.

1

task.threads.pool.size
.monitorCollector

The number of 
threads dedicated to 
the pool size monitor 
collector.

1

task.threads.pool.size
.customer.load

1

Parameter Name Parameter Description Type Value 
Description

Change 
Value? 
(Y/N)

notification.number.of.
publish.tasks

Number of single-
threaded tasks that 
publish CMDB changes 
to internal listeners.

integer N

notification.jms.connection.
factory

The JMS connection 
used for receiving 
notification.

N/A N/A N

notification.topic.jndi.name The JNDI name of the 
topic selected for 
notification.

N/A N/A N

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)
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Other Parameters

This section describes other data parameters: 

notification.sessions.
applications=DASHBOARD=3
;MAM_Viewing_system=3;
MAM_=10;CmdbExt=3;
AdaptersFramework=3;
MAM_AutoDiscovery=3;
sap=2;siebel=2;MAM_
Correlation_system=3

Defines a number of 
topic sessions for JMS 
subscribers per caller 
application.

string Definitions 
are 
separated by 
a semicolon 
(;).

N

notification.queue.size.max Maximum number of 
messages that can 
accumulate in the 
internal queue when 
the JMS server is down. 

integer N

notification.queue.flush.
interval

Interval of time to send 
any JMS messages 
accumulated in the 
queue.

integer Value is in 
seconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.datamodel.da
ta.tablespace.na
me

The tablespace name 
for the data model. 

string Relevant for Oracle 
database only.

Y

dal.datamodel.in
dex.tablespace.n
ame

The tablespace name 
for indexes.

string Relevant for Oracle 
database only.

Y

Parameter Name Parameter Description Type Value 
Description

Change 
Value? 
(Y/N)
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dal.in.clause.thre
shold

The maximum 
number of values in 
a SQL IN clause.

integer N

dal.num.of.in.ch
unks

The maximum 
number of chunks 
to be performed by a 
SQL IN clause.

integer For example: a SQL 
WHERE clause 
generates n number 
of values. If 
(dal.in.clause.
threshold * dal.num.of.
in.chunks) > n, a 
temporary table is 
used. If, however, n is 
larger, several SQL 
statements are 
executed with the 
SQL IN clause. 

N

dal.use.dirty.read Defines whether the 
database queries use 
dirty read. 

boolean Relevant only for 
certain queries.

➤ true. Queries use 
dirty read.

➤ false. Queries do 
not use dirty read.

N

dal.update.class.
model.enabled

Defines whether CI 
Type Model updates 
are permitted. This 
parameter is 
currently used for 
consolidated tables 
in HP Managed 
Software Solutions. 

boolean ➤ false. Tables are 
consolidated and 
an update of CI 
Type Model is not 
allowed.

➤ true. Tables are not 
consolidated and 
an update of CI 
Type Model is 
allowed.

N

dal.use.memory.i
nstead.temp.tabl
e.low.threshold=

 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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dal.use.memory.i
nstead.temp.tabl
e.high.threshold
=

 

dal.datamodel.m
ax.name.length.
allow

Maximum length of 
table and column 
names in database.

integer N

dal.classmodel.u
se.idgen

Defines whether to 
use the HP sequence 
ID generator for the 
database.

boolean ➤ true. Use ID 
generator.

➤ false. Do not use 
ID generator.

N

dal.datamodel.cr
eatetime.attribut
e.name

Name of the 
attribute with the 
creation time of the 
CI or relationship.

string N

dal.datamodel.u
pdatetime.attrib
ute.name

Name of the 
attribute with the 
last update time of 
the CI or 
relationship.

string N

dal.handle.statist
ics.on.startup=tr
ue

dal.statistics.start
up.percentage.th
reshold=5

dal.statistics.start
up.aging.thresho
ld.hours=36

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Plug-in Parameters

This section describes the plug-in parameters: 

 

Quota Parameters

This section describes the quota parameters:

 

Parameter Name Parameter Description Type Value Description Change Value? 
(Y/N)

plugins.raw.event.
qualifiers

The list of attribute 
qualifiers relevant for 
raw events. If an 
attribute has one of the 
qualifiers in the list, this 
qualifier is sent as a raw 
event to the 
HP Universal CMDB 
server, to the event 
system.

string Names of attribute 
qualifiers must be 
separated by a 
semicolon (;). 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

quota.name.custome
r.model.objects

The maximum 
number of CIs in a 
CIT. Every customer 
in MMS mode has a 
maximum number.

integer For example, if 
the value is 100 
and the CIT 
already includes 
100 CIs, no 
additional CIs 
can be added.

N

quota.name.custome
r.tql.active

The maximum 
number of active 
TQLs that can be 
run concurrently.

integer When the quota 
limit is reached, 
no further TQLs 
can be added.

N
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quota.name.server.m
odel.objects

The maximum 
number of CIs that 
the CMDB server 
can hold in a CIT for 
all customers 
combined.

integer ➤ In HP Business 
Availability 
Center, the 
value must be 
the same as 
quota.name.cu
stomer.model.o
bjects. 

➤ In 
HP Managed 
Software 
Solutions, the 
value must be 
greater than 
quota.name.cu
stomer.model.o
bjects. 

N

quota.name.server.tq
l.active

The maximum 
number of active 
TQLs that can run in 
the entire CMDB 
Server. 

integer ➤ In HP Business 
Availability 
Center, the 
value must be 
the same as 
quota.name.cu
stomer.tql.activ
e. 

➤ In 
HP Managed 
Software 
Solutions, the 
value must be 
greater than 
quota.name.cu
stomer.tql.activ
e. 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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quota.scheduler.inter
val.sec

The frequency in 
which the actual 
customer and server 
counts are checked 
against their defined 
quota value.

integer Value is in 
seconds.

N

quota.statistics.enabl
ed

Defines if quota 
counts should be 
returned to the Self-
Alert Monitor. This 
is relevant for 
HP Business 
Availability Center.

boolean ➤ false. Do not 
return the 
quota count. 
This value is 
relevant for 
HP Universal 
CMDB.

➤ true. Return 
the quota 
count to the 
Self-Alert 
Monitor. This 
value is 
relevant for 
HP Business 
Availability 
Center.

N

quota.check.enabled Defines whether to 
enforce quota 
checking.

boolean ➤ true. Perform 
quota 
checking.

➤ false. Do not 
perform quota 
checking.

N

quota.loader.name Defines where to 
load quota values.

string settings. Read 
from the 
HP Business 
Availability 
Center 
configuration 
file. 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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TQL Parameters

This section describes the TQL parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

tql.threads.pool.size Defines the number 
of threads to limit 
concurrent 
calculation of TQLs. 
This is done to 
prevent high CPU 
consumption.

integer N

tql.scheduler.timer.t
ime

Defines the interval 
of time to wait 
between wake up 
calls to the TQL 
State Machine 
manager.

long Value is in 
milliseconds. 

N

tql.scheduler.statisti
cs.logupdate.interva
l.time.millisec

The interval 
between updates of 
cmdb.pattern.statistic
s.log.

long Value is in 
milliseconds.

N

tql.resultrepository.t
imer.time

The length of time 
the ad hoc TQL 
results reside in 
memory before the 
results are purged 
from memory.

long Value is in 
milliseconds.

N

tql.resultutils.patter
ntakeover.timeout

10000

tql.resultutils.adhoc
.validate

Defines whether to 
perform pattern 
validation of ad hoc 
TQLs.

boolean ➤ true. Perform 
pattern 
validation.

➤ false. Do not 
perform 
pattern 
validation.

N
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tql.resultutils.chunk
.maxresultsize

The maximum 
number of CIs and 
relationships in a 
TQL result that can 
be retrieved together 
without dividing 
them into chunks 
for separate 
retrievals.

integer 100000 N

tql.resultutils.chunk
.maxnotificationsiz
e

The maximum 
number of CIs and 
relationships in a 
TQL result that can 
be sent to external 
clients, the 
applications that get 
notification service 
from CMDB. If this 
number is exceeded, 
a message is sent.

integer 50000 N

tql.resultutils.chunk
.keepingperiod.seco
nds

The length of time 
that a chunk of TQL 
results is resident in 
memory until the 
next chunk is 
received in memory.

integer Value is in 
seconds.

N

tql.conditionstatisti
cs.refresh.seconds

The time interval in 
which the total 
number of objects of 
each type in the 
CMDB is updated.

integer Value is in 
seconds.

N

tql.statemachine.fai
l.retries

Number of times to 
recalculate a TQL 
before the status is 
set to Fail.

integer N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.statemachine.fai
l.recover.time

Time interval to 
wait between a 
pattern calculation 
failure and the next 
attempt to 
recalculate. 

integer Value is in 
seconds.

N

tql.scheduler.statisti
cs.maxcalculation

The maximum 
number of a TQL’s 
recent calculations 
stored in the 
Scheduler statistics.

integer N

tql.group.all.active.
count

Maximum number 
of active TQLs 
permitted per 
customer in the 
appropriate group: 
all, collectors, view, 
topology, report, 
server data, path 
manager, and 
internal 
enrichment.

The name of the 
group is found in 
the name of the 
parameter after 
tql.group.

integer N

tql.group.collectors.
active.count

tql.group.view.activ
e.count

tql.group.topology.a
ctive.count

tql.group.report.acti
ve.count

tql.group.serverdata
.active.count

tql.group.pathmana
ger.active.count

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.group.all.result.s
ize

The maximum 
number of CIs held 
in a TQL result 
before the TQL is 
deactivated.

integer Values are 
assigned 
according to TQL 
group: all, 
collectors, view, 
topology, report, 
server data, path 
manager, and 
internal 
enrichment.

N

tql.group.collectors.
result.size

tql.group.view.resul
t.size

tql.group.topology.r
esult.size

tql.group.report.res
ult.size

tql.group.serverdata
.result.size

tql.group.pathmana
ger.result.size

EXPRESS_PRIORITY.
Min.CalculationTim
eInterval

Minimum length of 
time to wait until a 
full calculation is 
performed for some 
TQL query. 

The results are 
updated after 
calculation. 

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority. 

N

HIGH_PRIORITY.Mi
n.CalculationTimeI
nterval

MED_PRIORITY.Mi
n.CalculationTimeI
nterval

LOW_PRIORITY.Mi
n.CalculationTimeI
nterval

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Max.CalculationTi
meInterval

Maximum length of 
time to wait until a 
full calculation is 
performed for a TQL 
query. 

The results are 
updated after 
calculation. 

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.CalculationTimeI
nterval

MED_PRIORITY.Ma
x.CalculationTimeI
nterval

LOW_PRIORITY.Ma
x.CalculationTimeI
nterval

EXPRESS_PRIORITY.
Min.EventArrivalTi
meInterval

The minimum 
length of time to 
wait after the last 
event arrives before 
starting a full 
calculation. A full 
calculation is not 
started if the elapsed 
time from the last 
event is less than 
this value.

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Mi
n.EventArrivalTimeI
nterval

MED_PRIORITY.Mi
n.EventArrivalTimeI
nterval

LOW_PRIORITY.Mi
n.EventArrivalTimeI
nterval

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Max.EventArrivalTi
meInterval

The maximum 
length of time to 
wait after the last 
event arrives before 
starting a full 
calculation. A full 
calculation is started 
if this value is 
reached.

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.EventArrivalTimeI
nterval

MED_PRIORITY.Ma
x.EventArrivalTimeI
nterval

LOW_PRIORITY.Ma
x.EventArrivalTimeI
nterval

EXPRESS_PRIORITY.
Max.EventArrivalTi
meIntervalForImme
diate

The maximum 
length of time to 
wait after the last 
event arrives before 
starting an 
immediate 
calculation. An 
immediate 
calculation is started 
no later than this 
value.

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

MED_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

LOW_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Min.PendingEvents
Amount

Minimum number 
of events to 
accumulate to start 
a full calculation. A 
full calculation is 
not started if the 
number of pending 
events for some TQL 
is less than this 
value. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Mi
n.PendingEventsAm
ount

MED_PRIORITY.Mi
n.PendingEventsAm
ount

LOW_PRIORITY.Mi
n.PendingEventsAm
ount

EXPRESS_PRIORITY.
Max.PendingEvents
Amount

Maximum number 
of events to 
accumulate to start 
a full calculation. 

A full calculation 
starts when the 
number of pending 
events for a TQL 
equals, or is greater 
than, the value 
defined in this 
parameter. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.PendingEventsAm
ount

MED_PRIORITY.Ma
x.PendingEventsAm
ount

LOW_PRIORITY.Ma
x.PendingEventsAm
ount

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Max.PendingEvents
AmountForImmedi
ate

Maximum number 
of events to 
accumulate to start 
an immediate 
calculation. 

An immediate 
calculation starts 
when the number of 
pending events for a 
TQL equals, or is 
greater than, the 
value defined in this 
parameter. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

MED_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

LOW_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Creating an Impact Analysis Report Using 
a URL

This chapter describes how to create an Impact Analysis report using a URL.

Impact Analysis Report Creation Overview

HP Business Availability Center enables you to simulate how infrastructure 
changes can impact your system. For details, see “Correlation Manager 
Overview” in IT World Model Management. 

You can generate an Impact Analysis report that displays the trigger and the 
impacted CIs. For more details about what the report displays, see the 
Generate Report field in “Run Correlation Dialog Box” in IT World Model 
Management.

You can generate an Impact Analysis report in Topology View Application, 
or by building a URL that opens an Impact Analysis report directly in your 
browser, without being located in the HP Business Availability Center 
context. For details on creating a report, see “Topology View Application” in 
IT World Model Management.

This chapter describes: On page:

Impact Analysis Report Creation Overview 225

Generating an Impact Analysis Report Using a URL 226
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Generating an Impact Analysis Report Using a URL

This section explains the URL syntax for generating an Impact Analysis 
report directly in your browser.

Build the URL using the following syntax:

Note: The forward_url must go through URL encoding.

The parameters whose values must be provided are described below:

➤ <serverName>. The name of the HP Business Availability Center server.

➤ <impactCategory>. The name of the category to be analyzed.

➤ <impactSeverity>. The severity level of the category.

➤ <[xxx,yyy,zzz]>. The object ID of the CIs in the CMDB. The object IDs are 
separated by a comma (,).

➤ <userName>. Valid user login name.

➤ <userPassword>. Password for specified login name.

Note: Parameters are separated from the rest of the URL by a question 
mark (?). 

Configured URLs must use the ampersand character (&) as the parameter 
delimiter. 

http://<serverName>/topaz/TopazSiteServlet?createSession=true&requestType=login&
directLogin=true&directLoginEncrypted=true&userlogin=<userName>&userpassword=
<userPassword>&forward_url=/rfw/newReport.do?reportID=impact&populateAnyway=t
rue&autoGenerate=true&filter.objectIds=[xxx,yyy,zzz]&filter.impactCategory=<impactC
ategory>&filter.impactSeverity=<impactSeverity>
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For example:

http://bac/topaz/TopazSiteServlet?createSession=true&requestType=login&directLogin
=true&directLoginEncrypted=true&userlogin=admin&userpassword=admin&forward_ur
l=/rfw/newReport.do?reportID=impact&populateAnyway=true&autoGenerate=true&filte
r.objectIds=[700737a29899f4f66c70a67c6b9cb386,9a6faadff8b547a2c62fc454dfd3661
b,e5659759ed3b41cf01dfbb47191892fa]&filter.impactCategory=change>&filter.impact
Severity=2
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21
Data Samples

This chapter describes the data samples, and their fields, that are available in 
various contexts in HP Business Availability Center (including Custom 
Reports, Measurement Filters, and Custom Query Builder). These samples 
can also be used to create queries to extract data from the HP Business 
Availability Center profile database using the HP Business Availability 
Center API.

This chapter describes: On page:

Special Fields 232

Data Samples for Dashboard 233

Data Samples for SiteScope 235

Data Samples for Business Process Monitor 246

Data Samples for Real User Monitor 259

Data Samples for Alerts 298

Data Sample for Real Transaction Monitor 301

Data Samples for SOA 304

Data Samples for Business Process Insight (BPI) 308
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Special Fields

This section describes the special fields that are available in various 
HP Business Availability Center contexts.

IP Addresses
In some samples, IP addresses are returned as 32 bits representing an array of 
four bytes. Each byte represents a segment of the IP address. To get the 
standard text representation of an IP address, convert the returned value to 
binary and pad left with zeros to a length of 32. Convert each eight bits 
separately into decimal representation and concatenate the text 
representation of the resulting numbers together with decimal points 
between the numbers.

For example, 

The query returns: 167772247
The binary representation is: 1010000000000000000001010111
Pad to length of 32: 00001010000000000000000001010111
Split into bytes: 00001010.00000000.00000000.01010111
Convert each byte to decimal and present with the standard IP format: 10.0.0.87

Time Stamps
Time in queries and return data is a double data type representing seconds 
since January 1, 1970. For details on understanding date-time values 
returned by queries, see “Date-Time Values” in Solutions and Integrations.
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Data Samples for Dashboard

This section describes the samples and sample fields for Dashboard data 
(that is, data processed by the Business Logic Engine). These samples use the 
Universal Data Exchange (UDX) framework, and are thus available for 
filtering in the Measurement Filters page (for details, see “Working with 
Measurement Filters” in Platform Administration).

Limitation: There is currently no configuration item name field, and it is not 
possible to map CI names to their CMDB IDs (entity_id field). As such the 
value of these samples is limited.

Sample: KPI Statuses (bl_kpi_ot_ke)
The KPI Statuses sample (bl_kpi_ot_ke) contains data used when generating 
the KPIs Over Time report.

Field Display Name Data Type Units Description

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client). 

entity_id CMDB Entity 
id

BINARY Configuration ID of CI. 

heartbeat Heartbeat INT 0 or 1 If 0, data sample representing 
status change has been sent from 
the source.

If 1, no status change has been 
sent from the source in the last 24 
hours.

kpi_id Kpi instance 
cmdb id

BINARY Configuration ID of KPI instance.
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Sample: KPI Values (bl_kpi_ot_kt)
The KPI Values sample (bl_kpi_ot_kt) contains data used when generating 
the KPI Over Time report.

kpi_type Kpi type INT The ID of the KPI, as displayed in 
the Repositories page (Admin > 
Dashboard > Repositories > KPIs). 

sampletype STRING The name of the sample.

status Status INT The ID as defined in the From field 
in the Parameter Details window 
(Admin > Dashboard > 
Repositories > KPIs > 
clone/override KPI > click the Edit 
Entity button > Item Details > click 
the parameter to display the 
Parameter Details window)

time_stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970

TUID STRING Internal ID 

Field Display Name Data Type Units Description

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client). 

entity_id CMDB Entity 
id

BINARY Configuration ID of CI. 

kpi_id Kpi instance 
cmdb id

BINARY Configuration ID of KPI instance. 

kpi_type Kpi type INT The ID of the KPI, as displayed in 
the Repositories page (Admin > 
Dashboard > Repositories > KPIs). 

Field Display Name Data Type Units Description
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Data Samples for SiteScope

This section describes the samples and sample fields for SiteScope data:

➤ “Sample: SiteScope Monitor (ss_monitor_t)” on page 235

➤ “Sample: SiteScope Heartbeat (ss_heartbeat)” on page 238

➤ “Sample: Event (event)” on page 239

➤ “Event Sample Examples” on page 241

➤ “Sample: SiteScope Measurement (ss_t)” on page 242

➤ “Sample: SiteScope Measurement Aggregation (ss_hr_t)” on page 244

Sample: SiteScope Monitor (ss_monitor_t)
The SiteScope Monitor sample (ss_monitor_t) includes the monitor data 
measured by SiteScope.

sampletype STRING The name of the sample.

time_stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970. 

TUID STRING Internal ID 

Value Value DOUBLE Depends 
on 
related 
rule

The result of the business rule 
calculation.

Field Display Name Data Type/Units Description

cfg_frequency Configuration 
Frequency

DOUBLE The configuration frequency of the 
monitor

class_logical_name  STRING The monitor class display name (for 
example, CPU for CPU monitor)

Field Display Name Data Type Units Description
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class_real_name  STRING The monitor class name

class_type_id  U_INT The ID that corresponds to the 
monitor class name

strCustomerNam
e

Customer 
Name

STRING Customer name to which the sample 
belongs (for HP Managed Software 
Solutions, otherwise Default client)

dTime DOUBLE/milli-
seconds

Time stamp of when the 
measurement was taken

frequency Frequency DOUBLE The average frequency that the 
monitor was run

monitor_descriptio
n

STRING The description of the monitor (sent 
only in configuration sample)

monitor_full_id STRING The ID of the monitor, including the 
profile name and the full monitor ID 
(sent only in configuration sample)

monitor_full_path STRING The path of the monitor, including 
the groups in which the monitor is 
defined (sent only in configuration 
sample)

monitor_logical_na
me

Monitor Name STRING The display name of the monitor

profile_name Profile Name STRING Profile name

strCustomerName Customer 
Name

STRING Same as customer_name

szConnectionName STRING Name of the instance of the monitor 
that monitors the measurement

szMonitorName Monitor Type STRING Type of monitor that retrieved that 
measurement

szSessionName  STRING HP Business Availability Center 
session name to which the sample 
belongs

Field Display Name Data Type/Units Description
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szStatusMessage Status Message STRING In Normal status, field is empty; in 
No data status, field returns reason 
for No Data status (for example, 
monitor disabled or monitor 
suspended)

szTargetName Target Name STRING Name of the host that the monitor 
monitors

time_stamp DOUBLE/second
s since Jan 1 
1970

Time stamp in seconds since Jan 1 
1970

u_iConnectionId  U_INT ID of the instance of the monitor that 
monitors the measurement

u_iMonitorId  U_INT HP Business Availability Center ID of 
the monitor that retrieved the 
measurement

u_iQuality Quality U_INT Quality of the measurement from 0 to 
3 (3 is bad)

u_iSessionId  U_INT Profile ID as stored in the SESSIONS 
table in the management database

u_iStatus Status ID U_INT Status of the value. Value is valid = 0; 
error and the value is not valid = 1

u_iTargetId  U_INT ID of the host that the monitor 
monitors

Field Display Name Data Type/Units Description
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Sample: SiteScope Heartbeat (ss_heartbeat)
The SiteScope Heartbeat sample (ss_heartbeat) indicates that SiteScope is 
functioning properly and that its integration with HP Business Availability 
Center is healthy. The sample is only sent if SiteScope is in data reduction 
mode (in which case the sample is sent every minute).

Field Display 
NameDisplay 
Name

Data Type/Units Description

customer_name Customer 
Name

STRING Customer name to which the sample 
belongs (for HP Managed Software 
Solutions, otherwise Default client)

profile_name Profile Name STRING Profile name

time_stamp Time Stamp DOUBLE/second
s since Jan 1 
1970

Time stamp in seconds since Jan 1 
1970

sampletype  STRING The name of the sample.

status  INT The Worst Child status of the SiteScope 
health monitors

status_description  STRING The status value displayed in 
Dashboard (for example two out of 5 
monitors are in Error)

TUID STRING Internal ID

u_iSessionId  U_INT Profile ID as stored in the SESSIONS 
table in the management database
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Sample: Event (event)
The Event sample (event) includes data from integration monitors (external 
EMS data), SiteScope alerts, and SiteScope status changes. You can use these 
fields when configuring integration monitor field mappings. For details, see 
“Integration Monitor Field Mapping” in Using System Availability 
Management. This sample uses the Universal Data Exchange (UDX) 
framework, and is thus available for filtering in the Measurement Filters 
page. For details, see “Working with Measurement Filters” in Platform 
Administration.

 

Field Display Name Description

acknowledged_by Acknowledged By Name of user that acknowledged this event

attr1 Extra data slot

attr2 Extra data slot

attr3 Extra data slot

attr4 Extra data slot

attr5 Extra data slot for long strings

ci_type CI Type The type of configuration item that is 
monitored by the EMS monitor that captures 
the event

collector_host_ip Collector Host IP IP address of the machine running SiteScope

collector_host_name Collector Host Name Host name of the machine running 
SiteScope

customer_name Customer Name Customer name to which the sample 
belongs (for HP Managed Software Solutions, 
otherwise Default client)

data_source Data Source System that generated the event

description Description Textual description of event

event_id Event ID Unique identifier of this event

instance Instance Instance of subject that generated the event 
(e.g D:\ ). Lowest level of hierarchy 
describing the event source
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logical_group Logical Group Logical grouping of this event

monitor_group Monitor Group Monitor group that reported this event

object Object Optional level in the hierarchy describing 
the event source

orig_severity_name Original Severity Name Severity in external EMS terminology

owner Owner Name of user who owns this event

severity Severity One of the following severities:
SEVERITY_UNKNOWN
SEVERITY_INFORMATIONAL
SEVERITY_WARNING
SEVERITY_MINOR
SEVERITY_MAJOR
SEVERITY_CRITICAL

severity_name Severity Name Severity name

status Status Status of event in external EMS terminology

subject Subject Subject of event (e.g. CPU , SAP application, 
Hard Disk ), middle/high level hierarchy 
describing the event source. The hierarchy 
describing an event is in the following 
format:

monitor_group (optional) --> target_name --
> object (optional) --> subject --> instance.

More levels can be added above monitor 
monitor_group by using logical_group, and 
attr1 - 5.

target_ip Target IP IP of host or device that generated the event

target_name Target Name Name of device or host that generated the 
event

time_stamp Time Stamp Time stamp in seconds since Jan 1 1970

value Value Use to transfer numerical values from the 
event

Field Display Name Description
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Event Sample Examples
Infrastructure status change events (popular in EMS):

Ticketing system events:

Call center logs: 

Miscellaneous events (server backup log):

Timestamp IP Severity Alert name

11/5/2004 10:20 AM 192.168.82.74 Critical Server Unionville_1 is down

Ticket 
ID

Severity Region Product Open Date Close Date

2321 1 Europe HP Business Availability Center 11/5/2004 
11:38 AM

13/5/2004 
11:38 AM

Call ID Customer 
ID

Time Stamp Queue 
number

Response 
Time

Call 
Answered

Call Duration

43443 4344322 15/5/04 8:23 AM 4 32 Sec. Yes 284 Sec.

Time stamp IP Backup Start Time Backup Duration Errors

15/5/04 8:23 AM 192.168.82.74 15/5/04 8:23 AM 15/5/04 14:23 AM 0
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Sample: SiteScope Measurement (ss_t)
The SiteScope Measurement sample (ss_t) is sent from the SiteScope server to 
HP Business Availability Center for each metric that is measured. For 
example, if a CPU monitor measures utilization, for each run of the 
monitor, a sample is sent returning the value for this metric. If a monitor is 
configured to measure more than one metric, each run of the monitor sends 
a separate sample for each measured value. 

Field Display Name Data Type/Units Description

cfg_frequency Configuratio
n Frequency

DOUBLE The configuration frequency of the 
monitor

customer_name  STRING Customer name to which the sample 
belongs (for HP Managed Software 
Solutions, otherwise Default client)

dTime DOUBLE/milli-
seconds

Time stamp of when the measurement 
was taken

dValue Measurement 
Value

DOUBLE Value of the measurement taken

frequency Frequency DOUBLE The average frequency that the 
monitor was run

instance_id INT A unique id per instance that is set by 
the dispatcher

measurement_descr
iption

Measurement 
Description

STRING The description of the measurement

monitor_curr_quali
ty

INT The average frequency that the 
measurement was run 

profile_name Profile Name STRING Profile name

start_time DOUBLE The start time of the bulk report

szCategoryName Category 
Name

STRING Monitor type name

szConnectionName Connection 
Name

STRING Name of the instance of the monitor 
that monitors the measurement
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szErr Error Message STRING Error message if the sample has an 
error

szMeasurementNa
me

Measurement 
Name

STRING HP Business Availability Center 
measurement name

szMonitorName Monitor 
Name

STRING Type of monitor that retrieved that 
measurement

szMonitorTitle Monitor Title STRING Name given to the monitor upon 
creation

szSessionName  STRING HP Business Availability Center session 
name to which the sample belongs

szTargetName Target Name STRING Name of the host that the monitor 
monitors

time_stamp Time Stamp DOUBLE/second
s since Jan 1 
1970

Time stamp in seconds since Jan 1 
1970

u_iCategoryId  U_INT monitor type ID

u_iConnectionId  U_INT ID of the instance of the monitor that 
monitors the measurement

u_iMeasurementId  U_INT HP Business Availability Center 
measurement ID

u_iMonitorId  U_INT HP Business Availability Center ID of 
the monitor that retrieved the 
measurement

u_iMsmtQuality Measurement 
Quality

U_INT The measurement quality, indicating 
whether the value of the measurement 
represent a real value or an error value 
(helps to differentiate between 0 value 
that represents a real sample and 0 
value that represents a error)

u_iQuality Quality U_INT Quality of the measurement from 0 to 
3 (3 is bad)

Field Display Name Data Type/Units Description
243



Chapter 21 • Data Samples
Sample: SiteScope Measurement Aggregation (ss_hr_t)
The SiteScope Measurement Aggregation sample (ss_hr_t) contains the 
hourly aggregated data of the data in the SiteScope Measurement sample.

u_iSessionId  U_INT Profile ID as stored in the SESSIONS 
table in the management database

u_iStatus Status ID U_INT Status of the value. Value is valid = 0; 
error and the value is not valid = 1

u_iTargetId  U_INT ID of the host that the monitor 
monitors

Field Display Name Data Type/Units Description

customer_name Customer 
Name

STRING Customer name to which the sample 
belongs (for HP Managed Software 
Solutions, otherwise Default client)

dValue_max DOUBLE The maximum value of the 
measurements taken in the hour

dValue_min DOUBLE The minimum value of the 
measurements taken in the hour

dValue_sum DOUBLE Sum of the value of the measurements 
taken for the hour

dValue_sumsqr DOUBLE The sum of the squares of the value of 
the measurements taken for the hour. 
Can be used to calculate standard 
deviations

instance_id INT A unique id per instance that is set by 
the dispatcher

profile_name Profile Name STRING Profile name as stored in the SESSIONS 
table in the management database

szCategoryName Category 
Name

STRING The category of the measurement 
(what the measurement measures)

Field Display Name Data Type/Units Description
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szConnectionName Connection 
Name

STRING Name of the instance of the monitor 
that monitors the measurement

szMeasurementNa
me

Measurement 
Name

STRING HP Business Availability Center 
measurement name

szMonitorName Monitor 
Name

STRING Monitor type as known by HP Business 
Availability Center

szMonitorTitle Monitor Title STRING Name given to the monitor upon 
creation

szTargetName Target Name STRING Name of the host that the monitor 
monitors

time_stamp Time Stamp DOUBLE/second
s since Jan 1 
1970

Time stamp in seconds since Jan 1 1970

u_iCategoryId U_INT ID of the category

u_iConnectionId  U_INT ID of the instance of the monitor that 
monitors the measurement

u_iMeasurementId  U_INT HP Business Availability Center 
measurement ID

u_iMonitorId U_INT Index of the monitor type

u_iQuality_good_su
m

U_INT Number of samples in the hour with a 
good status

u_iQuality_poor_su
m

U_INT Number of samples in the hour with a 
poor status

u_iQuality_warn_su
m

U_INT Number of samples in the hour with a 
warning status

u_iSessionId U_INT Profile ID as stored in the SESSIONS 
table in the management database

u_iStatus_abnormal
_count

U_INT Number of samples with an abnormal 
value that passed in the hour.

u_iStatus_fail_count U_INT Number of samples with a non-valid 
value that passed in the hour. 

Field Display Name Data Type/Units Description
245



Chapter 21 • Data Samples
Data Samples for Business Process Monitor

This section describes the samples and sample fields for Business Process 
Monitor data:

➤ “Sample: Transactions (trans_t)” on page 246

➤ “Sample: Transactions Aggregation (trans_hr_t)” on page 251

➤ “Sample: Webtrace (trc_path_t)” on page 258

Sample: Transactions (trans_t)
The Transactions sample (trans_t) is used by Business Process Monitor to 
report transaction data for transactions in script monitors. It includes data 
on the transaction itself, as well as on the results of the specific run 
(duration, status, and so on).

u_iStatus_pass_cou
nt

U_INT Number of samples with a valid value 
that passed successfully in the hour. 

u_iTargetId  U_INT ID of the host that the monitor 
monitors

Field Display Name Data Type Units Description

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

dEndTime End Time DOUBLE milliseconds 
from 1970

Timestamp for the current 
management database time

dGreenThreshold Green 
Threshold

DOUBLE milliseconds Defined OK threshold value

dRedThreshold Red 
Threshold

DOUBLE milliseconds Defined Critical threshold value

Field Display Name Data Type/Units Description
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dResponseTime Response 
Time

DOUBLE milliseconds Response time (duration)

iComponentError
Count

Component 
Error Count

INT Number of component errors

instance_id Instance Id STRING A unique id per instance that is 
set by the dispatcher

trans_instance_id Instance ID STRING A unique id per transaction 
instance that is set by the 
dispatcher

profile_name Profile Name STRING Profile name

szHostName Host Name STRING Data collector host name

szLegacyTimeStri
ng

Legacy Time 
String

STRING The time at which the 
transaction ended, in the format 
%d/%m/%Y %H:%M:%S

szLocationName Location 
Name

STRING Data collector location name

szOrganizationNa
me

Organization 
Name

STRING Group name for the data 
collector in the profile

szScriptName Script Name STRING Script name

szStatusName Status Name STRING Status of the transaction 
(passed/failed/timed out)

szTransactionDes
c

Transaction 
Description

STRING Transaction description

szTransactionNa
me

Transaction 
Name

STRING Transaction name

szUniqueIdentifer Unique Id STRING A unique identifier for this 
transaction run from the 
specific data collector

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since 
Jan 1 1970

Field Display Name Data Type Units Description
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trans_instance_id Instance ID INT A unique ID per transaction in 
an instance set by the 
dispatcher

u_iHostId U_INT Data collector host ID

u_iLocationId U_INT Location ID

u_iOrganizationI
d

U_INT Group ID for the data collector 
in the profile

u_iScriptId U_INT Script ID

u_iSessionId U_INT Profile ID as stored in the 
SESSIONS table in the 
management database

u_iSize Download 
data size

U_INT kilobytes Total download size

u_iStatus U_INT Status ID of the transaction 
(passed/failed/timed out)

u_iSumConnectio
nTime

Summary 
Connection 
Time

U_INT milliseconds Sum of component connection 
times in the transaction 
breakdown. This data is not 
presented in the reports.

u_iSumDnsTime Summary 
DNS Time

U_INT milliseconds Sum of component DNS times 
in the transaction breakdown. 
This data is not presented in the 
reports.

u_iSumDownload
Time

Summary 
Download 
Time

U_INT milliseconds Sum of component download 
times in the transaction 
breakdown. This data is not 
presented in the reports.

u_iSumFirstBufTi
me

Summary 
Network First 
Buffer Time

U_INT milliseconds Sum of component 'time to first 
buffer' times in the transaction 
breakdown. This data is not 
presented in the reports.

Field Display Name Data Type Units Description
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u_iSumNetTime Summary 
Network 
Time

U_INT milliseconds Sum of component network 
times in the transaction 
breakdown. This data is not 
presented in the reports.

u_iSumRetryTime Summary 
Retry Time

U_INT milliseconds Sum of component retry times 
in the transaction breakdown. 
This data is not presented in the 
reports.

u_iSumServerTim
e

Summary 
Server Time

U_INT milliseconds Sum of component server times 
in the transaction breakdown. 
This data is not presented in the 
reports.

u_iSumSSLTime Summary SSL 
Time

U_INT milliseconds Sum of component SSL times in 
the transaction breakdown. This 
data is not presented in the 
reports.

u_iTransactionId U_INT Transaction ID

u_iWConnection
Time

Weighted 
Connection 
Time

U_INT milliseconds Connection time in the 
transaction breakdown, using a 
weighed aggregation algorithm. 
This is the data presented in the 
reports.

u_iWDnsTime Weighted 
DNS Time

U_INT milliseconds DNS time in the transaction 
breakdown, using a weighed 
aggregation algorithm. This is 
the data presented in the 
reports.

u_iWDownloadTi
me

Weighted 
Download 
Time

U_INT milliseconds Download time in the 
transaction breakdown, using a 
weighed aggregation algorithm. 
This is the data presented in the 
reports.

Field Display Name Data Type Units Description
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u_iWFirstBufTime Weighted 
Network First 
Buffer Time

U_INT milliseconds Time to first buffer in the 
transaction breakdown, using a 
weighed aggregation algorithm. 
This is the data presented in the 
reports.

u_iWNetTime Weighted 
Network 
Time

U_INT milliseconds Network time in the transaction 
breakdown, using a weighed 
aggregation algorithm. This is 
the data presented in the 
reports.

u_iWRetryTime Weighted 
Retry Time

U_INT milliseconds Retry time in the transaction 
breakdown, using a weighed 
aggregation algorithm. This is 
the data presented in the 
reports.

u_iWServerTime Weighted 
Server Time

U_INT milliseconds Server time in the transaction 
breakdown, using a weighed 
aggregation algorithm. This is 
the data presented in the 
reports.

u_iWSSLTime Weighted SSL 
Time

U_INT milliseconds SSL time in the transaction 
breakdown, using a weighed 
aggregation algorithm. This is 
the data presented in the 
reports.

Field Display Name Data Type Units Description
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Sample: Transactions Aggregation (trans_hr_t)
The Transactions Aggregation sample (trans_hr_t) contains the hourly 
aggregated data of the data in the Transactions sample. Although these 
calculations are done for only successful Transactions samples, this sample 
also includes count data on failed and timed out transactions.

Field Display Name Data Type Unit Description

dGreenThreshold Green 
Threshold

DOUBLE milliseconds Defined OK threshold value

dRedThreshold Red 
Threshold

DOUBLE milliseconds Defined Critical threshold value

dResponseTime_
max

DOUBLE milliseconds The maximum response time 
for the sample during the hour

dResponseTime_
min

DOUBLE milliseconds The minimum response time for 
the sample during the hour

dResponseTime_
nbd_sum

DOUBLE milliseconds

dResponseTime_
nbd_sumsqr

DOUBLE milliseconds

dResponseTime_o
bd_sum

DOUBLE milliseconds

dResponseTime_o
bd_sumsqr

DOUBLE milliseconds

dResponseTime_s
um

Response 
Time

DOUBLE milliseconds The sum of the response times 
(duration) for the hour

dResponseTime_s
umsqr

DOUBLE milliseconds The sum of the squares of the 
response times for the hour. Can 
be used to calculate standard 
deviations.

faile_count_cnt Integer Number of samples that failed 
during the hour

iComponentError
Count_sum

Component 
Error Count

Integer Number of component errors
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page_cbd_count_
sum

Integer

pass_count_cnt Integer Number of samples that passed 
successfully in the hour

pass_count_ndb_
cnt

Integer

pass_count_obd_
cnt

Integer Number of samples that passed 
successfully in the hour with a 
connection time that was not 
null

profile_name Profile Name STRING Profile name 

szLocationName Location 
Name

STRING Data collector location name

szOrganizationNa
me

Organization 
Name

STRING Group name for the data 
collector in the profile

szScriptName Script Name STRING Script name

szTransactionDes
c

Transaction 
Description

STRING Transaction description

szTransactionNa
me

Transaction 
Name

STRING Transaction Name

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

timed_out_cnt Integer Number of samples that timed 
out during the hour

transaction_insta
nce_id

Instance ID INT A unique id per transaction in 
an instance set by the 
dispatcher.

u_iLocationId U_INT Location ID

u_iOrganizationI
d

U_INT Group ID for the data collector 
in the profile

Field Display Name Data Type Unit Description
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u_iScriptId U_INT Script ID

u_iSessionId U_INT Profile ID as stored in the 
SESSIONS table in the 
management database

u_iSize_nbd_sum U_INT kilobytes

u_iSize_obd_sum U_INT kilobytes

u_iSize_sum Download 
data size

U_INT kilobytes The sum of the total download 
size

u_iSize_sumsqr U_INT kilobytes The sum of the squares of the 
total download size. Can be 
used to calculate standard 
deviations.

u_iSumConnectio
nTime_sum

Summary 
Connection 
Time

U_INT milliseconds The hourly sum of component 
connection times in the 
transaction breakdown. 

u_iSumConnectio
nTime_sumsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component 
connection times in the 
transaction breakdown. Can be 
used to calculate standard 
deviations.

u_iSumDnsTime_
sum

Summary 
DNS Time

U_INT milliseconds The hourly sum of component 
DNS times in the transaction 
breakdown. 

u_iSumDnsTime_
sumsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component DNS 
times in the transaction 
breakdown. Can be used to 
calculate standard deviations.

u_iSumDownload
Time_sum

Summary 
Download 
Time

U_INT milliseconds The hourly sum of component 
download times in the 
transaction breakdown. 

Field Display Name Data Type Unit Description
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u_iSumDownload
Time_sumsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component 
download times in the 
transaction breakdown. Can be 
used to calculate standard 
deviations.

u_iSumFirstBufTi
me_sum

Summary 
Network First 
Buffer Time

U_INT milliseconds The hourly sum of component 
'time to first buffer' times in the 
transaction breakdown. 

u_iSumFirstBufTi
me_sumsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component 'time 
to first buffer' times in the 
transaction breakdown. Can be 
used to calculate standard 
deviations.

u_iSumNetTime_s
um

Summary 
Network 
Time

U_INT milliseconds The hourly sum of component 
network times in the 
transaction breakdown. 

u_iSumNetTime_s
umsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component 
network times in the 
transaction breakdown. Can be 
used to calculate standard 
deviations.

u_iSumRetryTime
_sum

Summary 
Retry Time

U_INT milliseconds The hourly sum of component 
retry times in the transaction 
breakdown. 

u_iSumRetryTime
_sumsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component retry 
times in the transaction 
breakdown. Can be used to 
calculate standard deviations.

u_iSumServerTim
e_sum

Summary 
Server Time

U_INT milliseconds The hourly sum of component 
server times in the transaction 
breakdown.

Field Display Name Data Type Unit Description
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u_iSumServerTim
e_sumsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component 
server times in the transaction 
breakdown. Can be used to 
calculate standard deviations.

u_iSumSSLTime_s
um

Summary SSL 
Time

U_INT milliseconds The hourly sum of component 
SSL times in the transaction 
breakdown. 

u_iSumSSLTime_s
umsqr

U_INT milliseconds The sum of the squares of the 
hourly sum of component SSL 
times in the transaction 
breakdown. Can be used to 
calculate standard deviations.

u_iTransactionId U_INT Transaction ID

u_iWConnection
Time_sum

Weighted 
Connection 
Time

U_INT milliseconds The sum of the connection 
times in the transaction 
breakdown for the hour, using a 
weighed aggregation algorithm.

u_iWConnection
Time_sumsqr

U_INT milliseconds The sum of the squares of the 
connection times in the 
transaction breakdown for the 
hour, using a weighed 
aggregation algorithm. Can be 
used to calculate standard 
deviations.

u_iWDnsTime_su
m

Weighted 
DNS Time

U_INT milliseconds The sum of the DNS times in the 
transaction breakdown for the 
hour, using a weighed 
aggregation algorithm.

u_iWDnsTime_su
msqr

U_INT milliseconds The sum of the squares of the 
DNS times in the transaction 
breakdown for the hour, using a 
weighed aggregation algorithm. 
Can be used to calculate 
standard deviations.

Field Display Name Data Type Unit Description
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u_iWDownloadTi
me_sum

Weighted 
Download 
Time

U_INT milliseconds The sum of the download times 
in the transaction breakdown 
for the hour, using a weighed 
aggregation algorithm. 

u_iWDownloadTi
me_sumsqr

U_INT milliseconds The sum of the squares of the 
download times in the 
transaction breakdown for the 
hour, using a weighed 
aggregation algorithm. Can be 
used to calculate standard 
deviations.

u_iWFirstBufTime
_sum

Weighted 
Network First 
Buffer Time

U_INT milliseconds The sum of the times to first 
buffer in the transaction 
breakdown for the hour, using a 
weighed aggregation algorithm. 

u_iWFirstBufTime
_sumsqr

U_INT milliseconds The sum of the squares of the 
times to first buffer in the 
transaction breakdown for the 
hour, using a weighed 
aggregation algorithm. Can be 
used to calculate standard 
deviations.

u_iWNetTime_su
m

Weighted 
Network 
Time

U_INT milliseconds The sum of the network times in 
the transaction breakdown for 
the hour, using a weighed 
aggregation algorithm. 

u_iWNetTime_su
msqr

U_INT milliseconds The sum of the squares of the 
network times in the 
transaction breakdown for the 
hour, using a weighed 
aggregation algorithm. Can be 
used to calculate standard 
deviations.

Field Display Name Data Type Unit Description
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u_iWRetryTime_s
um

Weighted 
Retry Time

U_INT milliseconds The sum of the retry times in 
the transaction breakdown for 
the hour, using a weighed 
aggregation algorithm. 

u_iWRetryTime_s
umsqr

U_INT milliseconds The sum of the squares of the 
retry times in the transaction 
breakdown for the hour, using a 
weighed aggregation algorithm. 
Can be used to calculate 
standard deviations.

u_iWServerTime_
sum

Weighted 
Server Time

U_INT milliseconds The sum of the server times in 
the transaction breakdown for 
the hour, using a weighed 
aggregation algorithm. 

u_iWServerTime_
sumsqr

U_INT milliseconds The sum of the squares of the 
server times in the transaction 
breakdown for the hour, using a 
weighed aggregation algorithm. 
Can be used to calculate 
standard deviations.

u_iWSSLTime_su
m

Weighted SSL 
Time

U_INT milliseconds The sum of the SSL times in the 
transaction breakdown for the 
hour, using a weighed 
aggregation algorithm. 

u_iWSSLTime_su
msqr

U_INT milliseconds The sum of the squares of the 
SSL times in the transaction 
breakdown for the hour, using a 
weighed aggregation algorithm. 
Can be used to calculate 
standard deviations.

Field Display Name Data Type Unit Description
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Sample: Webtrace (trc_path_t)
The Webtrace sample (trc_path_t) is used by Business Process Monitor to 
report WebTrace data.

Field Display Name Data Type Units Description

iDnsTime DNS Time INT Not in use

iHostId INT ID of host machine from which 
WebTrace runs

iIsReachable Is Reachable INT True/False Indication of whether 
destination is reachable

iLocationId INT ID of location of host machine 
from which WebTrace runs

iRetries Retries INT The number of times a data 
packet tries, but fails, to reach 
its destination due to timeout, 
network difficulty, and so on

iRoundTrip Round Trip INT milliseconds The average time it takes for a 
packet of data to be sent from 
the host machine to the 
destination Web site

iSessionId INT ID of profile in which WebTrace 
is defined

profile_name Profile Name STRING Name of profile in which 
WebTrace is defined

szDstIp Destination 
IP

STRING Destination server IP defined in 
the profile (in the profile you 
declare an IP or a destination 
name; WebTrace resolves the 
other by itself)

szDstName Destination 
Name

STRING Destination server name defined 
in the profile (in the profile you 
declare an IP or a destination 
name; WebTrace resolves the 
other by itself)
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Data Samples for Real User Monitor

This section describes the samples and sample fields for Real User Monitor 
data. These samples use the Universal Data Exchange (UDX) framework, and 
are thus available for filtering in the Measurement Filters page (for details, 
see “Working with Measurement Filters” in Platform Administration).

This section describes the following samples and sample fields for Real User 
Monitor:

➤ “Sample: RUM Active End Users (rum_active_eu_t)” on page 260

➤ “Sample: RUM Broken Links (rum_bro_links_t)” on page 262

➤ “Sample: RUM End Users (rum_eu_t)” on page 263

➤ “Sample: RUM Events (rum_event_t)” on page 267

➤ “Sample: RUM Pages (rum_page_t)” on page 270

➤ “Sample: RUM Most Error Pages (rum_most_error_page_t)” on page 277

szHostName Host Name STRING Name of host machine from 
which WebTrace runs

szLegacyTimeStri
ng

Legacy Time 
String

STRING The time at which the 
transaction ended, in the format 
%d/%m/%Y %H:%M:%S

szLocationName Location 
Name

STRING Location name of host machine 
from which WebTrace runs

szLocationName Location 
Name

STRING Location name of host machine 
from which WebTrace runs

szSrcIp Source IP STRING IP of host machine from which 
WebTrace runs

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

trc_instance_id INT Internal ID

Field Display Name Data Type Units Description
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➤ “Sample: RUM Popular Pages (rum_pop_page_t)” on page 279

➤ “Sample: RUM Servers (rum_server_t)” on page 280

➤ “Sample: RUM Sessions (rum_session_t)” on page 282

➤ “Sample: RUM Session Statistics (rum_session_stats_t)” on page 285

➤ “Sample: RUM Slowest Components (rum_slow_comp_t)” on page 287

➤ “Sample: RUM Slowest End Users (rum_slow_eu_t)” on page 288

➤ “Sample: RUM Transactions (rum_trans_t)” on page 291

Sample: RUM Active End Users (rum_active_eu_t)
The RUM Active End Users sample (rum_active_eu_t) contains data about 
the end-users that were detected as having performed the most hits in the 
last interval. This interval is defined in End User Management 
Administration.

Field Display Name Data Type Units Description

application_id Application 
Id

INT HP Business Availability Center 
internal application ID number

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_id INT HP Business Availability Center 
internal end-user ID number
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eu_loc End User 
Location

STRING End-user location as configured 
in End User Management 
Administration

eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

new_tot_page_hit
s

New Total 
Page Hits

INT number of 
hits

Total number of pages hit by 
end-user

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_conn_hits Total 
Connection 
Hits

INT Currently not used

tot_http_bytes Total http 
bytes

DOUBLE bytes Total number of bytes sent and 
received by the end-user for 
http

tot_https_bytes Total https 
bytes

DOUBLE bytes Total number of bytes sent and 
received by the end-user for 
https

tot_latency Latency DOUBLE milliseconds total latency of all packets sent 
by end-user

Field Display Name Data Type Units Description
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Sample: RUM Broken Links (rum_bro_links_t)
The RUM Broken Links sample (rum_bro_links_t) contains data about a 
component that was missing. Only components that were accessed from 
within a site defined in End User Management Administration are reported.

tot_page_hits Total Page 
Hits

INT number of 
hits

Total number of pages hit by 
the end-user

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id Application 
Id

INT HP Business Availability Center 
internal application ID number

availability Availability INT 0 or 1 Always 0 (not available)

comp_url Component 
URL

STRING URL of component on page

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

Field Display Name Data Type Units Description
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Sample: RUM End Users (rum_eu_t)
The RUM End Users sample (rum_eu_t) contains data describing a specific 
end-user.

ref_url Referer URL STRING URL of page that requested 
component

sampletype STRING Currently not used

server_ip INT IP address of component server

server_name Server name STRING Name of component server

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_comp_hits Total 
Component 
Hits

INT number of 
hits

Total number of components 
hit

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

active_session_co
unt

Active 
Sessions 
Counter

DOUBLE Number of sessions that were 
active during the time frame to 
which the sample refers

application_id INT Monitored application internal 
ID number

closed_session_co
unt

Closed 
Sessions 
Counter

DOUBLE Number of sessions closed 
during the time frame to which 
the sample refers

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

Field Display Name Data Type Units Description
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engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

eu_domain_name End User 
Domain 
Name

STRING End-user group name as 
configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_id INT HP Business Availability Center 
internal end-user ID number

eu_loc End User 
Location

STRING End-user location as configured 
in End User Management 
Administration

eu_loc_city End User 
Location City

STRING End-user city as configured in 
End User Management 
Administration

eu_loc_country End User 
Location 
Country

STRING End-user country as configured 
in End User Management 
Administration

eu_loc_state End User 
Location 
State

STRING End-user state as configured in 
End User Management 
Administration

eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

Field Display Name Data Type Units Description
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new_tot_page_hit
s

New Total 
Page Hits

INT number of 
hits

Total number of pages hit by 
end-user

op_se_with_err_c
ount

Active 
Sessions With 
Errors 
Counter

DOUBLE Number of active sessions in 
which an error event occurred 
during the time frame to which 
the sample refers

op_se_with_perf_
count

Active 
Sessions With 
Performance 
Event 
Counter

DOUBLE Number of active sessions in 
which a performance event 
occurred during the time frame 
to which the sample refers

open_session_cou
nt

Opened 
Sessions 
Counter

DOUBLE Number of sessions opened 
during the time frame to which 
the sample refers

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

reporter INT Currently not used

sampletype STRING Currently not used

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_available_pag
e_hits

Total 
available 
page hits

DOUBLE Total number of available pages 
hit by the end-user

tot_conn_b_lth Connections 
Below 
Latency 
Warning 
Threshold

INT Currently not used

Field Display Name Data Type Units Description
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tot_conn_o_lth Total 
Connections 
over latency 
threshold

INT Currently not used

tot_http_bin Total http 
bytes in

DOUBLE bytes Total size of all end-user http 
requests

tot_http_bout Total http 
bytes out

DOUBLE bytes Total size of all end-user http 
replies

tot_https_bin Total https 
bytes in

DOUBLE bytes Total size of all end-user https 
requests

tot_https_bout Total https 
bytes out

DOUBLE bytes Total size of all end-user https 
replies

tot_latency Latency DOUBLE milliseconds Total latency of all packets sent 
by end-user

tot_latency_b_lth Latency 
Below 
Latency 
Warning 
Threshold

DOUBLE milliseconds Total latency time that was less 
than the threshold configured 
in End User Management 
Administration

tot_latency_color DOUBLE number 
representing 
color

Color of end-user status in 
Dashboard

tot_latency_o_lth Latency Over 
Latency 
Threshold

DOUBLE milliseconds Total latency time that was 
more than the threshold 
configured in End User 
Management Administration

tot_page_b_lth Number Of 
Pages Hits 
Below 
Latency 
Threshold

INT number of 
hits

Number of pages hit that had a 
latency less than the threshold 
configured in End User 
Management Administration

tot_page_hits Total Page 
Hits

INT number of 
hits

Total number of pages hit by 
the end-user

Field Display Name Data Type Units Description
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Sample: RUM Events (rum_event_t)
The RUM Events sample (rum_event_t) contains data about a defined event 
that was detected. The different event types are configured in End User 
Management Administration.

tot_page_o_lth Number Of 
Page Hits 
Over Latency 
Threshold

INT number of 
hits

Number of pages hit that had a 
latency more than the threshold 
configured in End User 
Management Administration

tot_pages_with_e
rr

Pages with 
availability 
problems

DOUBLE Number of pages that had 
availability problems

tot_pages_with_p
erf

Pages with 
perf problems

DOUBLE Number of pages that had 
performance problems

tot_unavailable_p
age_hits

Total 
unavailable 
page hits

DOUBLE Total number of unavailable 
pages hit by the end-user

total_conn Total 
Connection 
Hits

INT Currently not used

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id Application 
Id

INT HP Business Availability Center 
internal application ID number

bb_guid BB GUID STRING An internal, unique session ID 
from the Real User Monitor 
probe

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

Field Display Name Data Type Units Description
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engine_id Engine Id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

eu_domain_name End User 
Domain 
Name

STRING End-user group name as 
configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_host_name End User 
Host Name

STRING Host machine name of the end-
user

eu_id End User Id INT HP Business Availability Center 
internal end-user ID number

eu_ip End User IP INT IP address of end-user

eu_loc STRING End-user location as configured 
in End User Management 
Administration

eu_loc_city End User 
Location City

STRING End-user city as configured in 
End User Management 
Administration

eu_loc_country End User 
Location 
Country

STRING End-user country as configured 
in End User Management 
Administration

eu_loc_state End User 
Location 
State

STRING End-user state as configured in 
End User Management 
Administration

eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

Field Display Name Data Type Units Description
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eu_subnet_name End User 
Subnet Name

STRING Currently not used

eu_user_name End User 
Login Name

STRING Login name of end-user

event_category Event 
Category

INT Category of event configured in 
End User Management 
Administration (for example, 
informational, error, http, 
performance)

event_data Event Extra 
Data

STRING alpha-
numeric

Actual values returned from 
event

event_id Event Id INT HP Business Availability Center 
internal event ID number

event_name Event Name STRING Name of event as configured in 
End User Management 
Administration

event_type Event Type INT number (of 
event type)

Event type as configured in End 
User Management 
Administration

page_id Page Id INT HP Business Availability Center 
internal page id of the page 
configured in End User 
Management Administration, 
on which the event occurred (-1 
used for pages that have not 
been configured)

page_name Page Name STRING Name of page as configured in 
End User Management 
Administration

page_url Page URL STRING URL of the page configured in 
End User Management 
Administration, on which the 
event occurred

Field Display Name Data Type Units Description
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Sample: RUM Pages (rum_page_t)
The RUM Pages sample (rum_page_t) contains data about a monitored page. 
The sample contains performance, availability, and general measurements 
regarding the page. Only pages that match one of the page definitions in 
End User Management Administration are reported to HP Business 
Availability Center.

profile_id Profile Id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

server_ip Server IP INT IP address of component server

server_name Server Name STRING Name of server

session_comp_se
q

Component 
Sequence 
Number in 
Session

INT number Last component sequence 
number on the page on which 
the event occurred

time_stamp End Time DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id INT HP Business Availability Center 
internal application ID number

availability Availability INT number of 
pages

number of available pages (of 
the monitored page) during the 
time frame

Field Display Name Data Type Units Description
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bb_guid BB GUID STRING An internal, unique session ID 
from the Real User Monitor 
probe

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_id INT HP Business Availability Center 
internal end-user ID number

eu_ip End User IP INT IP address of end-user

eu_loc End User 
Location

STRING End-user location as configured 
in End User Management 
Administration

eu_loc_city End User 
Location City

STRING End-user city as configured in 
End User Management 
Administration

eu_loc_country End User 
Location 
Country

STRING End-user country as configured 
in End User Management 
Administration

eu_loc_state End User 
Location 
State

STRING End-user state as configured in 
End User Management 
Administration

Field Display Name Data Type Units Description
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eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

eu_subnet_name End User 
Domain And 
Subnet Range

STRING Currently not used

http_err_bad_c HTTP Error 
Bad Request 
Category

INT Currently not used

http_err_nfound_
c

HTTP Error 
Request Not 
Found 
Category

INT Currently not used

http_err_ref_c HTTP Error 
Request 
Refused 
Category

INT Currently not used

http_err_serr_c HTTP Error 
Server Errors 
Category

INT Currently not used

main_http_err HTTP 
Response 
Code

INT number http response code for the 
requested page

max_client_time Maximum 
Client Time

Double

max_dl_time Maximum 
Download 
Time

Double

max_net_time Maximum 
Network 
Time

Double

Field Display Name Data Type Units Description
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max_server_time Maximum 
Server Time

Double

min_client_time Minimum 
Client Time

Double

min_dl_time Minimum 
Download 
Time

Double

min_net_time Minimum 
Network 
Time

Double

min_server_time Minimum 
Server Time

Double

page_id INT HP Business Availability Center 
internal page id of the page 
configured in End User 
Management Administration

page_name Page Name STRING Name of page as configured in 
End User Management 
Administration

page_url Page URL STRING URL of the page configured in 
End User Management 
Administration

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

reporter INT Currently not used

squares_sum_clie
nt_time

Squares Sum 
Client Time

DOUBLE

squares_sum_dl_t
ime

Squares Sum 
Download 
Time

DOUBLE

Field Display Name Data Type Units Description
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squares_sum_net
_time

Squares Sum 
Network 
Time

DOUBLE

squares_sum_serv
er_time

Squares Sum 
Server Time

DOUBLE

sampletype STRING Currently not used

server_ip Server IP INT IP address of server

server_name Server Name STRING Name of server

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_avail_color DOUBLE number 
representing 
color

Color representing status of 
page in Dashboard

tot_client_time Client Time DOUBLE milliseconds Amount of time of total 
processing time between 
components

tot_components Number of 
Page 
Components

INT number Total number of components on 
the page

tot_dl_b_dth Download 
Time Below 
Download 
Warning 
Threshold

DOUBLE milliseconds Amount of download time less 
than the download warning 
threshold configured in End 
User Management 
Administration

tot_dl_o_dth Download 
Time Over 
Download 
Threshold

DOUBLE milliseconds Amount of download time more 
than the download warning 
threshold configured in End 
User Management 
Administration

tot_dl_time Download 
Time

DOUBLE milliseconds Total download time of page

Field Display Name Data Type Units Description
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tot_event_app_er
ror

Application 
Errors Events

INT number of 
error events

Total number of application 
error events on page

tot_event_http_er
ror

HTTP Errors 
Events

INT number of 
http errors

Total number of http errors on 
page

tot_event_info Non Error 
Events

INT number of 
info events

Total number of informational 
event on page

tot_frstbffr_b_fbt
h

Total time of 
time to first 
buffer below 
the threshold

Double

tot_frstbffr_o_fbt
h

Total time of 
time to first 
buffer over 
the threshold

Double

tot_frstbffr_time Sum of total 
time to first 
buffer

Double

tot_hits_b_dth Hits Below 
Download 
Warning 
Threshold

INT number of 
hits

Total number of hits with a 
download time less than the 
threshold configured in End 
User Management 
Administration

tot_hits_b_fbth Total hits 
below the 
time to first 
buffer 
threshold

Double number of 
hits

tot_hits_b_sth Hits Below 
Server 
Warning 
Threshold

INT number of 
hits

Total number of hits with server 
time less than the threshold 
configured in End User 
Management Administration

Field Display Name Data Type Units Description
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tot_hits_o_dth Hits Over 
Download 
Threshold

INT number of 
hits

Total number of hits with a 
download time more than the 
threshold configured in End 
User Management 
Administration

tot_hits_o_fbth Total hits 
over the time 
to first buffer 
threshold

Double number of 
hits

tot_hits_o_sth Hits Over 
Server 
Threshold

INT number of 
hits

Total number of hits with server 
time more than the threshold 
configured in End User 
Management Administration

tot_net_time Network 
Time

DOUBLE milliseconds Total network time

tot_page_color DOUBLE number 
representing 
color

Color representing status of 
page in Dashboard

tot_page_size Page Size DOUBLE bytes Total page size

tot_server_b_sth Server Time 
Below Server 
Warning 
Threshold

DOUBLE milliseconds Amount of server time less than 
the threshold configured in End 
User Management 
Administration

tot_server_color DOUBLE number 
representing 
color

Color representing status of 
server in Dashboard

tot_server_o_sth Server Time 
Over Server 
Threshold

DOUBLE milliseconds Amount of server time more 
than the threshold configured 
in End User Management 
Administration

tot_server_time Server Time DOUBLE milliseconds Total server time

tot_stopped Number Of 
Stopped 
Pages

INT number of 
pages

Total number of pages stopped 
before their download was 
completed

Field Display Name Data Type Units Description
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Sample: RUM Most Error Pages (rum_most_error_page_t)
The RUM Most Error Pages sample (rum_most_error_page_t) contains data 
about the pages that were detected as having the most HTTP and 
application errors occur on them in the last interval. The pages detected do 
not have to be defined in End User Management Administration.

total_hits Hits INT number of 
hits

Total number of hits on page

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id Application 
ID

INT HP Business Availability Center 
internal application ID number 
for the page

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

page_id INT HP Business Availability Center 
internal page id of the page 
configured in End User 
Management Administration

page_hits INT number of 
hits

Total number of hits of the page

page_name Page Name STRING The meaningful name assigned 
to the page, if configured.

Field Display Name Data Type Units Description
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page_url Page URL STRING URL of the page on which most 
errors occurred

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_app_errors Application 
Errors

INT number of 
application 
errors

Total number of application 
errors that occurred on the page

tot_errors Total Errors INT total 
number of 
application 
and HTTP 
errors

Total number of application and 
HTTP errors that occurred on 
the page

tot_http_errors HTTP Errors INT number of 
http errors

Total number of http errors that 
occurred on the page

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description
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Sample: RUM Popular Pages (rum_pop_page_t)
The RUM Popular Pages sample (rum_pop_page_t) contains data about the 
pages that were detected as having the highest number of hits in the last 
interval. The interval is defined in End User Management Administration. 
The pages detected do not have to be defined in End User Management 
Administration.

Field Display Name Data Type Units Description

application_id Application 
ID

INT HP Business Availability Center 
internal application ID number

availability Availability INT Currently not used

comp_url Page URL STRING URL of component on page

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

page_id INT HP Business Availability Center 
internal page id of the page 
configured in End User 
Management Administration

page_name Page Name STRING Name of page as configured in 
End User Management 
Administration

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)
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Sample: RUM Servers (rum_server_t)
The RUM Servers sample (rum_server_t) contains data about a server whose 
traffic the Real User Monitor is listening to.

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_page_hits INT number of 
hits

Total number of hits of the page

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id Application 
ID

INT HP Business Availability Center 
internal application ID number

availability Availability INT # of requests Number of requests successfully 
handled by server, or with HTTP 
denial codes not in the range of 
500-599

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

Field Display Name Data Type Units Description
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profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

reporter INT Currently not used

sampletype STRING Currently not used

server_ip Server IP INT IP address of component server

server_name Server Name STRING Name of server

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_avail_color DOUBLE number 
representing 
color

Color representing status of 
page in Dashboard

tot_comp_hits Total 
Component 
Hits

INT number of 
hits

Total number of components 
hits

tot_conn_hits Total 
Connection 
Hits

INT Currently not used

tot_http_bin Total Http 
Bytes In

DOUBLE bytes Total size of all end-user http 
requests

tot_http_bout Total Http 
Bytes Out

DOUBLE bytes Total size of all end-user http 
replies

tot_https_bin Total Https 
Bytes In

DOUBLE bytes Total size of all end-user https 
requests

tot_https_bout Total Https 
Bytes Out

DOUBLE bytes Total size of all end-user https 
replies

Field Display Name Data Type Units Description
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Sample: RUM Sessions (rum_session_t)
The RUM Sessions sample (rum_session_t) contains information about a 
user session. This sample is sent only after the session has ended. The 
rum_session_t is always sent with the rum_session_id_t sample.

tot_ok_comp_hits Total OK 
Component 
Hits

INT number of 
hits

Total number of hits on 
components that were 
successfully downloaded

tot_page_hits Total Page 
Hits

INT number of 
hits

Total number of pages hit on 
the server

total_hits Total 
Component 
Hits

INT number of 
hits

Total number of all component 
hits

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id Application 
ID

INT HP Business Availability Center 
internal application ID number

availability Availability INT number of 
pages

number of all available pages in 
the session

bb_guid BB GUID STRING An internal, unique session ID 
from the Real User Monitor 
probe

browser Browser STRING Type of browser used for the 
session

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

download_time Download 
Time

DOUBLE milliseconds Total download time of all pages 
in the session

Field Display Name Data Type Units Description
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dwell_Time Dwell Time DOUBLE Currently not used

engine_id Engine ID INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

eu_domain_name End User 
Domain 
Name

STRING End-user group name as 
configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_host_name End User 
Host Name

STRING Host machine name of the end-
user

eu_id End User Id INT HP Business Availability Center 
internal end-user ID number

eu_ip End User IP INT IP address of end-user

eu_loc STRING End-user location as configured 
in End User Management 
Administration

eu_loc_city End User 
Location City

STRING End-user city as configured in 
End User Management 
Administration

eu_loc_country End User 
Location 
Country

STRING End-user country as configured 
in End User Management 
Administration

eu_loc_state End User 
Location 
State

STRING End-user state as configured in 
End User Management 
Administration

eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

Field Display Name Data Type Units Description
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eu_subnet_name End User 
Subnet Name

STRING Currently not used

eu_user_name End User 
Login Name

STRING Login name of end-user

http_version Http Version STRING http version used for session

os Operating 
System

STRING Operating system used for 
session

profile_id Profile ID INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

server_ip Server IP INT IP address of component server

session_size Session Size DOUBLE bytes Total size of all pages included 
in the session

start_time Session Start 
Time

DOUBLE seconds 
since Jan 1 
1970

Time that the session started

time_stamp Session End 
Time

DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_event_app_er
ror

Application 
Errors

INT number of 
events

Total number of application 
events that occurred in the 
session

tot_event_http_er
ror

HTTP Errors INT number of 
events

Total number of http error 
events that occurred in the 
session

tot_event_info Informationa
l Events

INT number of 
events

Total number of information 
events that occurred in the 
session

Field Display Name Data Type Units Description
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Sample: RUM Session Statistics (rum_session_stats_t)
The RUM Session Statistics sample (rum_session_stats_t) contains aggregated 
data about open sessions over a five minute period for a specific application 
on a specific Real User Monitor engine.

tot_event_perfor
mance

Performance 
Events

INT number of 
events

Total number of performance 
events that occurred in the 
session

tot_latency Latency DOUBLE milliseconds total latency of all packets sent 
by end-user in session

tot_pages Pages Hits INT number of 
pages

Total number of pages in the 
session

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

active_session_co
unt

Active 
Sessions 
Counter

DOUBLE Number of sessions that were 
active during the time frame to 
which the sample refers

application_id INT Monitored application internal 
ID number

application_name STRING Monitored application name

closed_session_co
unt

Closed 
Sessions 
Counter

DOUBLE Number of sessions closed 
during the time frame to which 
the sample refers

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

Field Display Name Data Type Units Description
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engine_name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

op_se_with_err_c
ount

Active 
Sessions With 
Errors 
Counter

DOUBLE Number of active sessions in 
which an error event occurred 
during the time frame to which 
the sample refers

op_se_with_perf_
count

Active 
Sessions With 
Performance 
Event 
Counter

DOUBLE Number of active sessions in 
which a performance event 
occurred during the time frame 
to which the sample refers

open_session_cou
nt

Opened 
Sessions 
Counter

DOUBLE Number of sessions opened 
during the time frame to which 
the sample refers

probe_ip INT The IP of the probe machine

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description
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Sample: RUM Slowest Components (rum_slow_comp_t)
The RUM Slowest Components sample (rum_slow_comp_t) contains data 
about the pages that were detected as having the longest download time in 
the last interval. The interval is defined in End User Management 
Administration. The pages do not have to be defined in End User 
Management Administration.

Field Display Name Data Type Units Description

application_id INT Monitored application internal 
ID number

availability Availability INT numeric 
value 
between 0 
and 1

Availability of page in requested 
time frame

comp_url Page URL STRING URL of component on page

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

page_id INT HP Business Availability Center 
internal page id of the page 
configured in End User 
Management Administration

page_name Page Name STRING Name of page as configured in 
End User Management 
Administration
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Sample: RUM Slowest End Users (rum_slow_eu_t)
The RUM Slowest End Users sample (rum_slow_eu_t) contains data about 
the slowest end-users that were detected in the last interval. The interval is 
defined in End User Management Administration. The slowest end-users are 
those that experienced the highest average network latency for the defined 
interval.

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_comp_hits Page Hits INT number of 
hits

Total number of components 
hit

tot_dl Page 
Download 
Time

DOUBLE milliseconds Total page download time

tot_server_time Page Server 
Time

DOUBLE milliseconds Total server time

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description

application_id INT Monitored application internal 
ID number

availability Availability INT Currently not used

Field Display Name Data Type Units Description
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customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software 
Solutions, otherwise Default 
client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_id INT HP Business Availability Center 
internal end-user ID number

eu_loc End User 
Location

STRING End-user location as configured 
in End User Management 
Administration

eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

new_tot_page_hit
s

New Total 
Page Hits

INT number of 
hits

Total number of pages hit by 
end-user

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

sampletype STRING Currently not used

Field Display Name Data Type Units Description
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time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_conn_hits Total 
Connection 
Hits

INT Currently not used

tot_http_bytes Total http 
bytes

DOUBLE bytes Total number of bytes sent and 
received by the end-user for 
http

tot_https_bytes Total https 
bytes

DOUBLE bytes Total number of bytes sent and 
received by the end-user for 
https

tot_latency Latency DOUBLE milliseconds total latency of all packets sent 
by end-user

tot_latency_color DOUBLE number 
representing 
color

Color of end-user status in 
Dashboard

tot_page_hits Total Page 
Hits

INT number of 
hits

Total number of pages hit by 
the end-user

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description
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Sample: RUM Transactions (rum_trans_t)
The RUM Transactions sample (rum_trans_t) contains data performance and 
availability measurements of end-user transactions that match one of the 
transaction definitions in End User Management Administration.

Field Display Name Data Type Units Description

application_id Application 
ID

INT HP Business Availability Center 
internal application ID number

availability Availability INT value 
between 0 
and 1

availability of pages included in 
the transaction

bb_guid BB GUID STRING An internal, unique session ID 
from the Real User Monitor 
probe

customer_name STRING Customer name to which the 
sample belongs (for 
HP Managed Software Solutions, 
otherwise Default client)

engine_id INT HP Business Availability Center 
internal Real User Monitor 
engine ID number

engine_name Engine Name STRING Real User Monitor engine name 
as configured in End User 
Management Administration

eu_end_ip End User End 
IP

INT End IP address for end-user 
range as configured in Monitor 
Admistration

eu_id INT HP Business Availability Center 
internal end-user ID number

eu_ip End User IP INT IP address of end-user

eu_loc End User 
Location

STRING End-user location as configured 
in End User Management 
Administration
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eu_loc_city End User 
Location City

STRING End-user city as configured in 
End User Management 
Administration

eu_loc_country End User 
Location 
Country

STRING End-user country as configured 
in End User Management 
Administration

eu_loc_state End User 
Location 
State

STRING End-user state as configured in 
End User Management 
Administration

eu_name End User 
Domain And 
Subnet Range

STRING End-user name as configured in 
End User Management 
Administration

eu_start_ip End User 
Start IP

INT Start IP address for end-user 
range as configured in Monitor 
Admistration

last_http_error Last HTTP 
Error

INT http error 
code 
number

Error code number of last http 
error in transaction

last_trans_page Last 
Transaction 
Page

STRING page url URL of last page in transaction

last_trans_pid Last 
Transaction 
Page ID

INT HP Business Availability Center 
internal page ID number of the 
last page in transaction

max_client_time Maximum 
Client Time

Double

max_dl_time Maximum 
Download 
Time

Double

max_net_time Maximum 
Network 
Time

Double

Field Display Name Data Type Units Description
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max_server_time Maximum 
Server Time

Double

min_client_time Minimum 
Client Time

Double

min_dl_time Minimum 
Download 
Time

Double

min_net_time Minimum 
Network 
Time

Double

min_server_time Minimum 
Server Time

Double

profile_id INT HP Business Availability Center 
internal profile ID number 
(default 1)

profile_name Profile Name STRING HP Business Availability Center 
internal profile name

reporter INT Currently not used

sampletype STRING Currently not used

server_ip Server IP INT IP address of component server

server_name First Page 
Server Name

STRING Name of server of first page in 
transaction

squares_sum_clie
nt_time

Squares Sum 
Client Time

DOUBLE

squares_sum_dl_t
ime

Squares Sum 
Download 
Time

DOUBLE

squares_sum_net
_time

Squares Sum 
Network 
Time

DOUBLE

Field Display Name Data Type Units Description
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squares_sum_serv
er_time

Squares Sum 
Server Time

DOUBLE

time_stamp DOUBLE seconds 
since Jan 1 
1970

Time stamp in seconds since Jan 
1 1970

tot_avail_color DOUBLE number 
representing 
color

Color representing status of 
page in Dashboard

tot_client_time Client Time DOUBLE milliseconds Amount of time of total 
processing time between 
components

tot_completed Number of 
Completed 
Transctions

INT number of 
transactions

Always 1

tot_components Number of 
Page 
Components

INT number Total number of components on 
transaction pages

tot_event_app_er
ror

Application 
Errors Events

INT number of 
error events

Total number of application 
error events in transaction

tot_event_http_er
ror

HTTP Errors 
Events

INT number of 
error events

Total number of http error 
events in transaction

tot_event_info Non Error 
Events

INT number of 
error events

Total number of information 
events in transaction

tot_event_perfor
mance 

Performance 
Events

INT number of 
error events

Total number of performance 
events in transaction

tot_frstbffr_b_fbt
h

Total time of 
time to first 
buffer below 
the threshold

Double

tot_frstbffr_o_fbt
h

Total time of 
time to first 
buffer over 
the threshold

Double

Field Display Name Data Type Units Description
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tot_frstbffr_time Sum of total 
time to first 
buffer

Double

tot_gdl_b_gth Gross 
Download 
Time Below 
Gross 
Warning 
Threshold

DOUBLE milliseconds Total download time of 
transaction less than the 
threshold configured in End 
User Management 
Administration

tot_gdl_o_gth Gross 
Download 
Time Over 
Gross 
Threshold

DOUBLE milliseconds Total download time of 
transaction more than the 
threshold configured in End 
User Management 
Administration

tot_gdl_time Gross 
Download 
Time

DOUBLE milliseconds Total download time of 
transaction

tot_gross_color DOUBLEe number 
representing 
color

Color representing status of 
transaction in Dashboard

tot_hits_b_fbth Total hits 
below the 
time to first 
buffer 
threshold

Double number of 
hits

tot_hits_b_gth Hits Below 
Gross 
Warning 
Threshold

INT number of 
hits

Number of hits whose time was 
less than the gross threshold 
configured in End User 
Management Administration. 
Always 0 or 1

tot_hits_b_nth Hits Below 
Net Warning 
Threshold

INT number of 
hits

Number of hits whose time was 
less than the net threshold 
configured in End User 
Management Administration. 
Always 0 or 1

Field Display Name Data Type Units Description
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tot_hits_b_sth Hits Below 
Server 
Warning 
Threshold

INT number of 
hits

Number of hits whose time was 
less than the server threshold 
configured in End User 
Management Administration

tot_hits_o_fbth Total hits 
over the time 
to first buffer 
threshold

Double number of 
hits

tot_hits_o_gth Hits Over 
Gross 
Threshold

INT number of 
hits

Number of hits whose time was 
more than the gross threshold 
configured in End User 
Management Administration. 
Always 0 or 1

tot_hits_o_nth Hits Over Net 
Threshold

INT number of 
hits

Number of hits whose time was 
more than the net threshold 
configured in End User 
Management Administration. 
Always 0 or 1

tot_hits_o_sth Hits Over 
Server 
Threshold

INT number of 
hits

Number of hits whose time was 
more than the server threshold 
configured in End User 
Management Administration

tot_ndl_b_nth Net 
Download 
Time Below 
Net Warning 
Threshold

DOUBLE milliseconds Total time of pages in the 
transaction whose time was less 
than the net threshold 
configured in End User 
Management Administration

tot_ndl_o_nth Net 
Download 
Time Over 
Net 
Threshold

DOUBLE milliseconds Total time of pages in the 
transaction whose time was 
more than the net threshold 
configured in End User 
Management Administration

tot_ndl_time Net 
Download 
Time

DOUBLE milliseconds Total net download time

Field Display Name Data Type Units Description
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tot_net_color DOUBLE number 
representing 
color

Color representing status of 
transaction in Dashboard

tot_net_time Network 
Time

DOUBLE milliseconds Total network time

tot_server_b_sth Server Time 
Below Server 
Warning 
Threshold

DOUBLE number of 
hits

Total number of hits whose time 
was below the threshold 
configured in End User 
Management Administration

tot_server_color DOUBLE number 
representing 
color

Color representing status of 
server in Dashboard

tot_server_o_sth Server Time 
Over Server 
Threshold

DOUBLE milliseconds Total server time more than the 
threshold configured in End 
User Management 
Administration

tot_server_time Server Time DOUBLE milliseconds Total server time

tot_trans_size Transaction 
Size

DOUBLE bytes Total size of transaction

total_hits Transaction 
Hits

INT number of 
hits

Total number of hits in 
transaction

trans_id INT HP Business Availability Center 
internal transaction ID

trans_name Transaction 
Name

STRING alpha-
numeric

Transaction name as configured 
in End User Management 
Administration

trans_pages_seq_i
ds

STRING sequence 
numbers

String of the sequence numbers 
of the pages that comprise the 
transaction

TUID STRING Internal ID from the profile 
database

Field Display Name Data Type Units Description
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Data Samples for Alerts

This section describes the samples and sample fields for alerts generated by 
the new alert engine (CI Status Alerts) and the legacy alert engine (Business 
Process Monitor and Real User Monitor alerts).

Sample: Alert Log (alert_log)
The Alert Log sample (alert_log) contains data generated by CI Status Alerts 
used when generating the Configuration Item Status Alerts report. 

Limitation: There is currently no configuration item name field, and it is not 
possible to map CI names to their CMDB IDs (entity_id field). As such, the 
value of this sample is limited.

This sample uses the Universal Data Exchange (UDX) framework, and is 
thus available for filtering in the Measurement Filters page (for details, see 
“Working with Measurement Filters” in Platform Administration).

Field Display Name Data Type Units Description

action Action STRING The actions performed by the alert

alert_id alert_id INT Alert instance ID

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client)

entity_id CMDB Entity 
id

BINARY Configuration ID of CI

kpi_name KPI name STRING The name of the KPI 

name Alert Name STRING The name of the alert
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next_severity Next Severity INT The severity status of the KPI after 
the change that caused the alert to 
be sent, expresses as the ID defined 
in the From field in the Parameter 
Details window (Admin > 
Dashboard > Repositories > KPIs > 
clone/override KPI > click the Edit 
Entity button > Item Details > click 
the parameter to display the 
Parameter Details window)

obj_name Objective 
name

STRING For future use

prev_severity Previous 
Severity

INT The severity status of the KPI 
before the change that caused the 
alert to be sent, expresses as the ID 
defined in the From field in the 
Parameter Details window (Admin 
> Dashboard > Repositories > KPIs 
> clone/override KPI > click the 
Edit Entity button > Item Details > 
click the parameter to display the 
Parameter Details window)

sampletype STRING The name of the sample.

send_time Send time DOUBLE seconds 
since Jan 
1 1970

The date and time that the alert 
was sent, expressed in seconds 
since Jan 1 1970

time_stamp Time Stamp DOUBLE seconds 
since Jan 
1 1970

The date and time of the event that 
caused the status change, expressed 
in seconds since Jan 1 1970

TUID STRING Internal ID 

Field Display Name Data Type Units Description
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Sample: Alerts (alarm_t)
The Alerts sample (alarm_t) contains data generated by Business Process 
Monitor and Real User Monitor alerts. 

Field Display Name Data Type Units Description

alarm_id alarm Id INT ID of the alert (definition)

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client)

dEventTimeStam
p

triggered 
time

DOUBLE seconds Time of the event that triggered 
the alert

iIsLoggedOnly Is logged 
Only

INT Determines whether the alert is 
logged only (1 is true or 0 is false)

iIsPositive Is Positive INT Determines whether the alert is a 
follow-up (1 is true or 0 is false)

iNmmtEventType
Id

Nmmt Event 
Type Id

INT Obsolete 

iNmmtId NMMT Id INT Obsolete

iSessionId Profile ID INT Profile ID as stored in the 
SESSIONS table in the 
management database

iSeverityId Severity ID INT Severity of the alert

profile_name Profile Name STRING Profile name

szActionDesc Action 
Description

STRING Action that is taken as a result of 
the alert

szAlarmDesc Alarm 
Description

STRING Description of the alert

szAlarmName Alarm Name STRING Alert name

szNmmtEventTyp
e

Nmmt Event 
Type

STRING Obsolete 
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Data Sample for Real Transaction Monitor

The Real Transaction Monitor sample (bristol_t3) contains data integrated 
into HP Business Availability Center from HP TransactionVision monitoring 
software. This sample uses the Universal Data Exchange (UDX) framework, 
and is thus available for filtering in the Measurement Filters page. For 
details, see “Working with Measurement Filters” in Platform Administration. 

 

szNmmtName NMMT Name STRING Obsolete 

time_stamp Time Stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970

Field Display Name Data Type Units Description

bpmTransaction
Field

Transaction 
Field

STRING The transaction name as it appears 
in the Business Process Monitor 
script

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client)

EndTime End Time STRING The transaction end time

IsBPMScripted BPM 
Generated 
Transaction

INT 0 or 1 If true (1), transaction initiated 
from a Business Process Monitor; if 
false (0), transaction originated 
from a real user.

IsBPMScripted
RealEquivalent

Is Real 
Correlated 
BPM 
Transaction

INT 0 or 1 If true (1), the sample is for real 
transactions, and the Business 
Process Monitor is also generating 
the same type of transaction 
synthetically.

profile_id BPM Profile 
ID

INT The correlated Business Process 
Monitor profile ID

Field Display Name Data Type Units Description
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profile_name Profile Name STRING Business Process Monitor profile 
name

ReportingInterval Reporting 
Interval

INT seconds The interval between samples 
originating from Bristol software 
(all transaction hits are aggregated 
and one aggregated data sample is 
sent in each interval)

sampletype STRING The name of the sample.

StartTime Start Time STRING The transaction start time

time_stamp Time Stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970

TUID STRING Internal ID 

TxAvgResponseTi
me

Transaction 
Avg 
ResponseTim
e

DOUBLE milli-
seconds

The average response time of 
transactions in the Reporting 
Interval

TxClass Transaction 
Class

STRING The transaction name as it is called 
in Bristol software (should be the 
same name as Business Process 
Monitor transaction name)

TxCount Transaction 
Count

INT Total number of transactions in the 
Reporting Interval

TxFailedCount Transaction 
Failed Count

INT Number of failed transactions

TxFailedValue Transaction 
Failed Value

DOUBLE Total value of the failed transaction

TxId BPM 
Transaction 
ID

INT The correlated Business Process 
Monitor transaction ID

TxLateCount Transaction 
Late Count

INT Number of transactions that are 
above some response threshold 
(defined in Bristol software)

Field Display Name Data Type Units Description
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TxLateValue Transaction 
Late Value

DOUBLE Total value of transaction that are 
late

TxMaxResponse
Time

Transaction 
Max 
ResponseTim
e

DOUBLE milli-
seconds

The maximum response time of 
transactions in the Reporting 
Interval

TxMinResponse
Time

Transaction 
Min 
ResponseTim
e

DOUBLE milli-
seconds

The minimum response time of 
transactions in the Reporting 
Interval

TxResponse
Threshold

Transaction 
Response 
Threshold

DOUBLE milli-
seconds

The response time threshold

TxValue Transaction 
Value

DOUBLE Total value of the specific fields 
read from the data (Bristol software 
can read real transaction values, for 
example, the number of dollars 
transferred in a transaction)

Field Display Name Data Type Units Description
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Data Samples for SOA

This section describes the samples and sample fields for SOA data (that is, 
data used in the Business Availability Center for SOA application). These 
samples use the Universal Data Exchange (UDX) framework, and are thus 
available for filtering in the Measurement Filters page (for details, see 
“Working with Measurement Filters” in Platform Administration).

Sample: SOA Event (ws_event_aggr_t)
The SOA Event sample (ws_event_aggr_t) contains data used in SOA event 
reports. Data collectors can collect data for the following types of events:

➤ HTTP errors. Can be used to detect client and server side errors, such as: Not 
found 404 and Internal Error 500.

➤ SOAP errors. There are several standard SOAP faults that can indicate on the 
reason for a problem. For example: "version mismatch". In addition there 
can be customized SOAP faults per WS implementation.

Field Display Name Data Type Units Description

consumer Consumer IP INT The IP address of the consumer of 
the service

customer_name STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client)

dc_source DC Source STRING Specifies the data collector 
source—Diagnostics or SiteScope

end_point End Point STRING The name of the monitored end 
point (it appears in the WSDL as 
the port name)

event_count Event Count INT The number of occurrences of the 
event in the time period of the 
aggregation

event_name Event Name STRING The name of the event
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is_synthetic Is Synthetic STRING Specify 0 for real user monitoring 
and 1 for synthetic monitoring

name Name STRING The name of the Web service. It 
appears in the WSDL as the service 
name. There might be more than 
one in a WSDL

namespace Namespace STRING The URI of the definition resource 
of the Web service (it appears in 
the WSDL as the targetNamespace)

operation Operation 
Name

STRING The operation name of the Web 
service

sampletype STRING The name of the sample

server Server IP INT The IP address of the monitored 
server

time_stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970 (this sample has aggregated 
values of 5 minutes)

TUID STRING Internal ID

Field Display Name Data Type Units Description
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Sample: WS Performance (ws_perf_aggr_t)
The WS Performance sample (ws_perf_aggr_t) contains data used in SOA 
performance reports. Data collectors can collect data for end to end 
performance of Web service operation, including availability and response 
time.

Field Display Name Data Type Units Description

calls_count Calls Count INT The number of calls in the last 5 
minutes

consumer Consumer INT The IP address of the consumer of 
the service

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client). 

dc_source DC Source STRING Specifies the data collector 
source—Diagnostics or SiteScope

end_point End Point STRING The name of the monitored end 
point (it appears in the WSDL as 
the port name)

error_count Error Count INT The numbers of errors in the last 5 
minutes

 is_synthetic Is Synthetic STRING Specify 0 for real user monitor data 
source and 1 for synthetic monitor 
data source

max_st Max Server 
Time

INT milli-
seconds

The maximum server response 
time

max_rtt Max Total 
Response 
Time

INT milli-
seconds

The maximum round trip response 
time

 min_st Min Server 
Time

INT milli-
seconds

The minimum server response 
time
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min_rtt Min Total 
Response 
Time

INT milli-
seconds

The minimum round trip response 
time

 name Name STRING The name of the Web service. It 
appears in the WSDL as the service 
name. There might be more than 
one in a WSDL

 namespace Namespace STRING The URI of the definition resource 
of the Web service (it appears in 
the WSDL as the targetNamespace)

 operation Operation STRING The operation name of the Web 
service

over_threshold_rt
t

Over 
Threshold 
Client Time

INT The number of instances of round 
trip response time being over 
threshold

over_threshold_st Over 
Threshold 
Server Time

INT The number of instances of server 
time being over threshold

sampletype STRING The name of the sample

 server Server IP INT The IP address of the monitored 
server

 sum_st Sum Server 
Time

INT milli-
seconds

The sum of server response time

 sum_rtt Sum Total 
Response 
Time

INT milli-
seconds

The sum of round trip response 
time

time_stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970 (this sample has aggregated 
values of 5 minutes)

TUID STRING Internal ID

Field Display Name Data Type Units Description
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Data Samples for Business Process Insight (BPI)

The BPI sample (bpi_t) contains data from the HP Business Process Insight 
application.

Field Display Name Data Type Units Description

bac_kpi_type BAC KPI ID 
for reporting 
data

INT The ID of the Business Availability 
Center KPI, as displayed in the 
Repositories page (Admin > 
Dashboard > Repositories > KPIs). 

customer_name Customer 
Name

STRING Customer name to which the 
sample belongs (for HP Managed 
Software Solutions, otherwise 
Default client). 

metric_id BPI Metric ID STRING The ID of the Business Process 
Insight Metric.

sampletype STRING The name of the sample

status BPI 
Calculated 
Status for 
BAC 
Dashboard

INT The Business Process Insight 
calculated status displayed in 
Business Availability Center 
Dashboard.

time_stamp DOUBLE seconds 
since Jan 
1 1970

Time stamp in seconds since Jan 1 
1970 (this sample has aggregated 
values of 5 minutes)

TUID STRING Internal ID

unit_desc Unit 
description of 
value field

STRING The units of the value field.

value Calculated 
value

DOUBLE The calculated value of the 
bac_kpi_type field. It can 
corresponds to the Backlog, 
Throughput, or Duration KPIs.
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Data Aggregation

This chapter describes the how HP Business Availability Center uses data 
aggregation to improve data management.

Introducing Data Aggregation

HP Business Availability Center uses data aggregation to make data handling 
and management more efficient and to improve the speed and performance 
of report generation. HP Business Availability Center data aggregation tasks 
are performed on the Data Processing Server.

HP Business Availability Center aggregates various types of data that it 
collects for reports (for example, response time data collected by Business 
Process Monitor, infrastructure machine performance data collected by 
SiteScope, and user traffic data collected by Real User Monitor). Data 
aggregation involves combining individual measurements into manageable 
chunks. The result is improved speed and performance of report generation.

This chapter describes: On page:

Introducing Data Aggregation 309

How Data Is Aggregated 310

How Reports Use Aggregated Data 311

Effect of Outlier Setting on Data Aggregation 314

Data Aggregation Limitations 314
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HP Business Availability Center groups data into the following categories:

➤ raw data. The actual metrics collected by data collectors.

➤ fine aggregation granularity. Data grouped into hourly chunks.

➤ coarse aggregation granularity. Data grouped into daily chunks.

How Data Is Aggregated

HP Business Availability Center aggregates data collected by Business Process 
Monitor and SiteScope data collectors (not including SiteScope Integration 
Monitors using the event data template). Data is aggregated as follows:

Hourly
Hourly aggregation is performed every hour. The default schedule is as 
follows:

Hourly aggregation for Business Process Monitor and SiteScope data is done 
every hour for the time period that began 2 hours earlier (for example, at 
12:00 PM HP Business Availability Center aggregates the data collected 
between 10:00 AM and 11:00 AM). 

Daily
Daily aggregation is performed once a day after the hourly aggregation. The 
default schedule is that aggregation begins at 1:00 AM for the previous day 
(for example, at 1:00 AM HP Business Availability Center aggregates the data 
collected between 12 am, 25 hours ago and 12 am, 1 hour ago). When 
configuring profile properties, you can specify the time zone that 
HP Business Availability Center uses to determine when to perform daily 
aggregation in GMT Offset. For more details, see “GMT Time Zones” on 
page 323.
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You can define a different delay for when the aggregation begins in the 
Offline Aggregator context of the Infrastructure Settings page (Admin > 
Platform > Setup and Maintenance > Infrastructure Settings > Foundation > 
Offline Aggregator). You can specify a separate delay for Business Process 
Monitor, custom, and SiteScope data. The delay you specify is for both the 
hourly and daily aggregations. It is recommended that only advanced users 
change the defaults set in Infrastructure Settings and after first consulting 
Customer Support or your HP Services representative. For details on using 
the Infrastructure Settings Manager page, see “Infrastructure Settings” in 
Platform Administration.

How Reports Use Aggregated Data

Whether HP Business Availability Center displays a report using raw data, 
daily aggregated data, or hourly aggregated data depends on several factors:

➤ If the requested data in the report is for the past 30 hours, HP Business 
Availability Center uses raw data for Business Process Monitor data. 

➤ For reports that use custom data—trend reports, Real User Monitor reports, 
Service Level Management reports containing custom data, and Diagnostics 
reports (if installed)—for the requested time range and granularity, Business 
Availability Center chooses the optimal combination of data categories so 
that the least amount of rows must be retrieved from the database.

For example, for a time range Jan. 1 10:40 AM - Jan. 3 10:40 AM and 
granularity of 1 day, Business Availability Center chooses data categories as 
follows:

➤ for Jan. 1 10:40 AM - Jan. 1 11:00 AM – raw data is used

➤ for Jan. 1 11:00 AM - Jan. 1 11:59 PM – hourly aggregated data is used

➤ for Jan. 2 12:00 AM - Jan. 2 11:59 PM – daily aggregated data is used

➤ for Jan. 3 12:00 AM - Jan. 3 10:00 AM – hourly aggregated data is used

➤ for Jan. 3 10:00 AM - Jan. 3 10:40 AM – raw data is used
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➤ If the requested data in the report does not use custom data and the report 
range is not 30 hours, HP Business Availability Center uses an aggregation 
threshold—by default, 93% of the maximum—to determine whether to use 
daily aggregated data, hourly aggregated data, or raw data. When a report is 
generated for a specific time range, HP Business Availability Center 
calculates the amount of each type of data that exists over that time range 
and considers only the data types that are above the aggregation threshold.

For example, HP Business Availability Center might determine that, for the 
requested time range “Past Week,” raw data exists for 100% of the time 
range, hourly aggregated data exists for 96% of the time range, and daily 
aggregated data exists for 86% of the time range. In this case, HP Business 
Availability Center only considers raw data and hourly aggregated data as 
possible options since both exceed the aggregation threshold of 93%.

When more than one option exists, HP Business Availability Center gives 
priority to the data with the highest granularity (that is, daily is chosen over 
hourly or raw, hourly is chosen over raw). Thus, in the above example, 
HP Business Availability Center would display the report using hourly 
aggregated data.

➤ If the time granularity for the report (or report time range in reports that are 
not over time) is set to less than a day, regardless of the chosen time range, 
HP Business Availability Center never uses daily aggregated data.

➤ If the time granularity for the report (or report time range in reports that are 
not over time) is set to less than an hour, regardless of the chosen time 
range, HP Business Availability Center always uses raw data.
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Note: (not relevant for HP Managed Software Solutions customers) If you 
select a report time range that includes the past day (for example Past 
Month), and for which HP Business Availability Center chooses daily 
aggregated data, the data for the past day may be missing, as it may not yet 
have been aggregated into its one day chunk. In such cases, you can “force” 
HP Business Availability Center to use one hour chunks, instead of one day 
chunks, by increasing the aggregation threshold from its default setting of 
93% to 98%. To do so, open the file <Gateway Server root directory>\
AppServer\DataEngine\conf\ TAS_consts.properties in a text editor, and 
search for the line defConf.aggrReasonableDiff=7. Modify the value from 7 
to 2, save the file, and restart HP Business Availability Center on the 
Gateway Server machine. (If you have multiple Gateway Servers, repeat this 
procedure on all the servers.) Keep in mind that, once you make this 
change, it will apply for all generated reports.

The Aggregation Policy setting defines the aggregated data usage policy for 
reports that use custom data. By default, reports use all available data, raw 
and aggregated. In certain circumstances, however, it may be necessary to 
modify this setting. For example, if the aggregation engine is not working 
(aggregator process on the Data Processing Server is down), you can modify 
the setting so that only raw data is used.

The setting can be configured in the Infrastructure Settings Manager, 
Foundations > Generic Data Engine context, Generic Data Engine - 
Aggregation table to modify the way aggregated data is used in reports. 

Note: In general, Aggregation Policy setting should not be modified 
without first consulting Customer Support. It is not relevant for 
HP Managed Software Solutions customers.
313



Chapter 22 • Data Aggregation
Effect of Outlier Setting on Data Aggregation

When aggregating data, if the Ignore outlier data in reports setting is 
cleared in a profile’s properties, in the Transaction Threshold Settings 
section in End User Management Administration, HP Business Availability 
Center excludes transaction instances whose response time exceeds the 
outlier value, also set in the Transaction Threshold Settings section. If the 
Ignore outlier data in reports setting is selected, HP Business Availability 
Center ignores outlier transactions, and therefore the data is not considered. 
Note that the default outlier value for all transactions is 45 seconds. For 
details on configuring outlier values, see “Setting Transaction Thresholds” in 
Using End User Management.

Data Aggregation Limitations

The following limitations apply, as a result of data aggregation:

➤ When viewing aggregated data, you may not always be able to see results 
when drilling down to individual transaction instances. 

➤ When viewing aggregated data for non-rounded time periods, there might 
be inaccuracies for the time period close to the starting and ending times of 
the report. For example, if you generate a report on a Thursday based on 
data collected between 9:45 AM the previous Monday and 9:45 AM the 
previous Tuesday, the time period between 9:45 AM and 10:00 AM Monday 
will not contain any data, even if data was originally collected.

➤ HP Business Availability Center is unable to display both aggregated and raw 
data simultaneously in the Multi-Profile report.

➤ When viewing SiteScope data that is aggregated hourly, keep in mind that if 
the aggregator did not finish aggregating the necessary data, the latest hour 
may not include all the data. This may happen on rare occasions when there 
is a large amount of data needing hourly aggregation.

➤ Service Level Management aggregates some data differently. For details, see 
“Aggregated Data” in Using Service Level Management.
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Date and Time Reference Information

This chapter describes date and time reference information for HP Business 
Availability Center. 

Times and Time Zones Used in HP Business Availability 
Center

HP Business Availability Center deals with times and time zones differently, 
depending on the context.

Note: All HP Business Availability Center servers, as well as the database 
servers, must be installed in the same time zone, with the same daylight 
savings time configuration, and be set to the same time.

This section includes the following topics:

➤ “Data Collection” on page 318

➤ “Business Process Monitor Scheduling” on page 318

This chapter describes: On page:

Times and Time Zones Used in HP Business Availability Center 317

Date Formats on Client Machines 320

Report Times 320

GMT Time Zones 323
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➤ “Data Aggregation” on page 318

➤ “Alerts and Alert Recipients” on page 319

➤ “Scheduled Reports” on page 319

➤ “Service Level Agreements” on page 320

Data Collection
HP Business Availability Center data collectors collect performance data and 
transmit it to the Gateway Server, which submits the data to profile 
databases using the loader mechanism. Data is inserted into the database 
along with a timestamp. HP Business Availability Center components 
synchronize their time clocks with that of the database server machine 
hosting the HP Business Availability Center management database. Thus, 
the timestamp attached to each measurement inserted into the database is 
that of the database server clock at the time the measurement was collected.

Business Process Monitor Scheduling
When running profiles and WebTrace, the Business Process Monitors use the 
schedule you set when specifying profile settings. When configuring 
schedule properties, the Business Process Monitor can base its scheduling 
on:

➤ the data collector machine’s time clock. HP Business Availability Center uses 
the host machine’s time zone (displayed in parentheses), which is registered 
in the management database when the Business Process Monitor is installed 
on the host machine.

➤ a specific time zone relative to GMT. HP Business Availability Center uses 
the time zone you specify. Choosing Offset from GMT enables you to 
synchronize transaction run times among hosts in different time zones. 
Note that this setting is not available for all-day scheduling schemes.

Data Aggregation
The aggregators on the Gateway Server aggregate the raw data in the profile 
databases on an hourly and daily basis.
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For the standard data aggregator, you set the time zone, relative to GMT, for 
daily data aggregation when defining a profile’s properties. For the custom 
data aggregator, you set the time zone for data aggregation when 
configuring the default profile database. For more information on the 
different aggregators used by HP Business Availability Center, see “Data 
Aggregation” on page 318.

For example, for HP Business Availability Center to perform daily 
aggregation on data collected by a particular profile based on Pacific Time, 
enter -8, since Pacific Time is GMT-8. Note that this setting cannot be edited 
once it is saved.

Alerts and Alert Recipients
HP Business Availability Center sends alerts from the Gateway Server. The 
Gateway Server synchronizes its time clock with that of the database server 
machine hosting the management database. Thus, the time associated with 
an alert or subalert is that of the database server clock at the time the alert or 
subalert occurred.

HP Business Availability Center sends alerts to recipients based on the time 
range and GMT offset factor that you set when configuring recipient 
properties in the Platform Administration. For example, if you configure a 
recipient to receive pager alerts from 9:00 AM - 9:00 PM, and choose a GMT 
offset of -5 hours, the recipient receives alerts via pager only from 9:00 AM - 
9:00 PM Eastern Time.

Scheduled Reports
HP Business Availability Center sends scheduled reports from the Gateway 
Server machine. HP Business Availability Center sends scheduled reports 
based on the report generation time and GMT offset factor that you set 
when configuring scheduled reports in the Platform Administration. 

For example, if you configure a scheduled report to be sent at 9:00 AM, and 
choose to offset report generation time from GMT by -8 hours, HP Business 
Availability Center sends the report at 9:00 AM Pacific Time.
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Service Level Agreements
Service Level Management enables you to specify the time zone of each SLA. 
Service Level Management calculates reports according to this time zone, so 
that data is linked to the appropriate time interval. However, Service Level 
Management displays dates and times according to the time zone settings of 
the machine on which it is installed.

Date Formats on Client Machines

HP Business Availability Center displays dates according to the machine’s 
locale (HP Business Availability Center supports 17 locale definitions). 

Note: HP Business Availability Center does not retrieve the date formats 
from the machine’s date definitions.

Report Times

In some HP Business Availability Center reports (for example, Average 
Response Times over Time and Transaction Breakdown over Time), the 
selected time range is displayed along the x-axis. HP Business Availability 
Center breaks down the time range according to segments, which differ 
depending on the time range. For example, for the Day time range, 
HP Business Availability Center uses one-hour segments. 

HP Business Availability Center calculates each time segment differently, 
depending on the selected time range. Each time segment is exactly the 
same amount of time with the exception of the first and last time segment 
of the time range, which are rounded to the start and end time of the report. 
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The table below describes the time segments that appear along the x-axis for 
each available time range. For illustration purposes, the information in the 
table is based on the starting date and time 13/9/01 12:03 PM, where the 
date format is month/day/year and the time format is 
hours:minutes:seconds.

Time 
Range

Segment First Time 
Segment

Example of 
Middle Time 
Segment

Last Time 
Segment

Hour 5 minutes 9/13/01 
12:03:00 PM

to

9/13/01 
12:04:59 PM

9/13/01 
12:05:00 PM

to

9/13/01 
12:09:59 PM

9/13/01 
1:00:00 PM

to

9/13/01 
1:02:59 PM

Day 1 hour 9/13/01 
12:03:00 PM

to

9/13/01 
12:59:59 PM

9/13/01 
1:00:00 PM

to

9/13/01 
1:59:59 PM

9/14/01 
12:00:00 PM

to

9/14/01 
12:02:59 PM

Week 1 day 9/13/01 
12:03:00 PM

to

9/13/01 
11:59:59 PM

9/14/01 
12:00:00 AM

to

9/14/01 
11:59:59 PM

9/20/01 
12:00:00 AM

to

9/20/01 
12:02:59 PM

Month 1 day 9/13/01 
12:03:00 PM

to

9/13/01 
11:59:59 PM

9/14/01 
12:00:00 AM

to

9/14/01 
11:59:59 PM

10/13/01 
12:00:00 AM

to

10/13/01 
12:02:59 PM
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* For the Quarter time range, the week starts on Monday, and the first step is 
from the start time until the beginning of the following week.

Quarter* 1 week 9/13/01 
12:03:00 PM

to

9/16/01 
11:59:59 PM

9/17/01 
12:00:00 AM

to

9/23/01 
11:59:59 PM

12/10/01 
12:00:00 AM

to

12/13/01 
12:02:59 PM

Year 1 month 9/13/01 
12:03:00 PM

to

9/30/01 
11:59:59 PM

10/1/01 
12:00:00 AM

to

10/31/01 
11:59:59 PM

9/1/02 
12:00:00 AM

to

9/13/02 
12:02:59 PM

Time 
Range

Segment First Time 
Segment

Example of 
Middle Time 
Segment

Last Time 
Segment
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GMT Time Zones

The following list describes GMT time zones for locations throughout the 
world.

(GMT -11) Pacific/Niue (GMT -11) Pacific/Apia
(GMT -11) MIT (GMT -11) Pacific/Pago_Pago
(GMT -10) Pacific/Tahiti (GMT -10) Pacific/Fakaofo
(GMT -10) Pacific/Honolulu (GMT -10) HST
(GMT -10) America/Adak (GMT -10) Pacific/Rarotonga
(GMT -9) Pacific/Marquesas (GMT -9) Pacific/Gambier
(GMT -9) America/Anchorage (GMT -9) AST
(GMT -8) Pacific/Pitcairn (GMT -8) America/Vancouver
(GMT -8) America/Tijuana (GMT -8) America/Los_Angeles
(GMT -8) PST (GMT -7) America/Dawson_Creek
(GMT -7) America/Phoenix (GMT -7) PNT
(GMT -7) America/Edmonton (GMT -7) America/Mazatlan
(GMT -7) America/Denver (GMT -7) MST
(GMT -6) America/Belize (GMT -6) America/Regina
(GMT -6) Pacific/Galapagos (GMT -6) America/Guatemala
(GMT -6) America/Tegucigalpa (GMT -6) America/El_Salvador
(GMT -6) America/Costa_Rica (GMT -6) America/Winnipeg
(GMT -6) Pacific/Easter (GMT -6) America/Mexico_City
(GMT -6) America/Chicago (GMT -6) CST
(GMT -5) America/Porto_Acre (GMT -5) America/Bogota
(GMT -5) America/Guayaquil (GMT -5) America/Jamaica
(GMT -5) America/Cayman (GMT -5) America/Managua
(GMT -5) America/Panama (GMT -5) America/Lima
(GMT -5) America/Indianapolis (GMT -5) IET
(GMT -5) America/Nassau (GMT -5) America/Montreal
(GMT -5) America/Havana (GMT -5) America/Port-au-Prince
(GMT -5) America/Grand_Turk (GMT -5) America/New_York
(GMT -5) EST (GMT -4) America/Antigua
(GMT -4) America/Anguilla (GMT -4) America/Curacao
(GMT -4) America/Aruba (GMT -4) America/Barbados
(GMT -4) America/La_Paz (GMT -4) America/Manaus
(GMT -4) America/Dominica (GMT -4) America/Santo_Domingo
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(GMT -4) America/Grenada (GMT -4) America/Guadeloupe
(GMT -4) America/Guyana (GMT -4) America/St_Kitts
(GMT -4) America/St_Lucia (GMT -4) America/Martinique
(GMT -4) America/Montserrat (GMT -4) America/Puerto_Rico
(GMT -4) PRT (GMT -4) America/Port_of_Spain
(GMT -4) America/St_Vincent (GMT -4) America/Tortola
(GMT -4) America/St_Thomas (GMT -4) America/Caracas
(GMT -4) Antarctica/Palmer (GMT -4) Atlantic/Bermuda
(GMT -4) America/Cuiaba (GMT -4) America/Halifax
(GMT -4) Atlantic/Stanley (GMT -4) America/Thule
(GMT -4) America/Asuncion (GMT -4) America/Santiago
(GMT -3) America/St_Johns (GMT -3) CNT
(GMT -3) America/Fortaleza (GMT -3) America/Cayenne
(GMT -3) America/Paramaribo (GMT -3) America/Montevideo
(GMT -3) America/Buenos_Aires (GMT -3) AGT
(GMT -3) America/Godthab (GMT -3) America/Miquelon
(GMT -3) America/Sao_Paulo (GMT -3) BET
(GMT -2) America/Noronha (GMT -2) Atlantic/South_Georgia
(GMT -1) Atlantic/Jan_Mayen (GMT -1) Atlantic/Cape_Verde
(GMT -1) America/Scoresbysund (GMT -1) Atlantic/Azores
(GMT +0) Africa/Ouagadougou (GMT +0) Africa/Abidjan
(GMT +0) Africa/Accra (GMT +0) Africa/Banjul
(GMT +0) Africa/Conakry (GMT +0) Africa/Bissau
(GMT +0) Atlantic/Reykjavik (GMT +0) Africa/Monrovia
(GMT +0) Africa/Casablanca (GMT +0) Africa/Timbuktu
(GMT +0) Africa/Nouakchott (GMT +0) Atlantic/St_Helena
(GMT +0) Africa/Freetown (GMT +0) Africa/Dakar
(GMT +0) Africa/Sao_Tome (GMT +0) Africa/Lome
(GMT +0) GMT (GMT +0) UTC
(GMT +0) Atlantic/Faeroe (GMT +0) Atlantic/Canary
(GMT +0) Europe/Dublin (GMT +0) Europe/Lisbon
(GMT +0) Europe/London (GMT +1) Africa/Luanda
(GMT +1) Africa/Porto-Novo (GMT +1) Africa/Bangui
(GMT +1) Africa/Kinshasa (GMT +1) Africa/Douala
(GMT +1) Africa/Libreville (GMT +1) Africa/Malabo
(GMT +1) Africa/Niamey (GMT +1) Africa/Lagos
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(GMT +1) Africa/Ndjamena (GMT +1) Africa/Tunis
(GMT +1) Africa/Algiers (GMT +1) Europe/Andorra
(GMT +1) Europe/Tirane (GMT +1) Europe/Vienna
(GMT +1) Europe/Brussels (GMT +1) Europe/Zurich
(GMT +1) Europe/Prague (GMT +1) Europe/Berlin
(GMT +1) Europe/Copenhagen (GMT +1) Europe/Madrid
(GMT +1) Europe/Gibraltar (GMT +1) Europe/Budapest
(GMT +1) Europe/Rome (GMT +1) Europe/Vaduz
(GMT +1) Europe/Luxembourg (GMT +2) Africa/Tripoli
(GMT +1) Europe/Monaco (GMT +1) Europe/Malta
(GMT +1) Africa/Windhoek (GMT +1) Europe/Amsterdam
(GMT +1) Europe/Oslo (GMT +1) Europe/Warsaw
(GMT +1) Europe/Stockholm (GMT +1) Europe/Belgrade
(GMT +1) Europe/Paris (GMT +1) ECT
(GMT +2) Africa/Bujumbura (GMT +2) Africa/Gaborone
(GMT +2) Africa/Lubumbashi (GMT +2) Africa/Maseru
(GMT +2) Africa/Blantyre (GMT +2) Africa/Maputo
(GMT +2) Africa/Kigali (GMT +2) Africa/Khartoum
(GMT +2) Africa/Mbabane (GMT +2) Africa/Lusaka
(GMT +2) Africa/Harare (GMT +2) CAT
(GMT +2) Africa/Johannesburg (GMT +2) Europe/Sofia
(GMT +2) Europe/Minsk (GMT +2) Asia/Nicosia
(GMT +2) Europe/Tallinn (GMT +2) Africa/Cairo
(GMT +2) ART (GMT +2) Europe/Helsinki
(GMT +2) Europe/Athens (GMT +2) Asia/Jerusalem
(GMT +2) Asia/Amman (GMT +2) Asia/Beirut
(GMT +1) Europe/Vilnius (GMT +2) Europe/Riga
(GMT +2) Europe/Chisinau (GMT +2) Europe/Bucharest
(GMT +2) Europe/Kaliningrad (GMT +2) Asia/Damascus
(GMT +2) Europe/Kiev (GMT +2) Europe/Istanbul
(GMT +2) EET (GMT +3) Asia/Bahrain
(GMT +3) Africa/Djibouti (GMT +3) Africa/Asmera
(GMT +3) Africa/Addis_Ababa (GMT +3) EAT
(GMT +3) Africa/Nairobi (GMT +3) Indian/Comoro
(GMT +3) Asia/Kuwait (GMT +3) Indian/Antananarivo
(GMT +3) Asia/Qatar (GMT +3) Africa/Mogadishu
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(GMT +3) Africa/Dar_es_Salaam (GMT +3) Africa/Kampala
(GMT +3) Asia/Aden (GMT +3) Indian/Mayotte
(GMT +3) Asia/Riyadh (GMT +3) Asia/Baghdad
(GMT +2) Europe/Simferopol (GMT +3) Europe/Moscow
(GMT +3) Asia/Tehran (GMT +3) MET
(GMT +4) Asia/Dubai (GMT +4) Indian/Mauritius
(GMT +4) Asia/Muscat (GMT +4) Indian/Reunion
(GMT +4) Indian/Mahe (GMT +4) Asia/Yerevan
(GMT +4) NET (GMT +4) Asia/Baku
(GMT +4) Asia/Aqtau (GMT +4) Europe/Samara
(GMT +4) Asia/Kabul (GMT +5) Indian/Kerguelen
(GMT +4) Asia/Tbilisi (GMT +5) Indian/Chagos
(GMT +5) Indian/Maldives (GMT +5) Asia/Dushanbe
(GMT +5) Asia/Ashkhabad (GMT +5) Asia/Tashkent
(GMT +5) Asia/Karachi (GMT +5) PLT
(GMT +5) Asia/Bishkek (GMT +5) Asia/Aqtobe
(GMT +5) Asia/Yekaterinburg (GMT +5) Asia/Calcutta
(GMT +5) IST (GMT +5) Asia/Katmandu
(GMT +6) Antarctica/Mawson (GMT +6) Asia/Thimbu
(GMT +6) Asia/Colombo (GMT +6) Asia/Dacca
(GMT +6) BST (GMT +6) Asia/Almaty
(GMT +6) Asia/Novosibirsk (GMT +6) Indian/Cocos
(GMT +6) Asia/Rangoon (GMT +7) Indian/Christmas
(GMT +7) Asia/Jakarta (GMT +7) Asia/Phnom_Penh
(GMT +7) Asia/Vientiane (GMT +7) Asia/Saigon
(GMT +7) VST (GMT +7) Asia/Bangkok
(GMT +7) Asia/Krasnoyarsk (GMT +8) Antarctica/Casey
(GMT +8) Australia/Perth (GMT +8) Asia/Brunei
(GMT +8) Asia/Hong_Kong (GMT +8) Asia/Ujung_Pandang
(GMT +8) Asia/Macao (GMT +8) Asia/Kuala_Lumpur
(GMT +8) Asia/Manila (GMT +8) Asia/Singapore
(GMT +8) Asia/Taipei (GMT +8) Asia/Shanghai
(GMT +8) CTT (GMT +8) Asia/Ulan_Bator
(GMT +8) Asia/Irkutsk (GMT +9) Asia/Jayapura
(GMT +9) Asia/Pyongyang (GMT +9) Asia/Seoul
(GMT +9) Pacific/Palau (GMT +9) Asia/Tokyo
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(GMT +9) JST (GMT +9) Asia/Yakutsk
(GMT +9) Australia/Darwin (GMT +9) ACT
(GMT +9) Australia/Adelaide (GMT +9) Australia/Broken_Hill
(GMT +10) Australia/Hobart (GMT +10) Antarctica/

DumontDUrville
(GMT +10) Pacific/Truk (GMT +10) Pacific/Guam
(GMT +10) Pacific/Saipan (GMT +10) Pacific/Port_Moresby
(GMT +10) Australia/Brisbane (GMT +10) Asia/Vladivostok
(GMT +10) Australia/Sydney (GMT +10) AET
(GMT +10) Australia/Lord_Howe (GMT +11) Pacific/Ponape
(GMT +11) Pacific/Efate (GMT +11) Pacific/Guadalcanal
(GMT +11) SST (GMT +11) Pacific/Noumea
(GMT +11) Asia/Magadan (GMT +11) Pacific/Norfolk
(GMT +12) Pacific/Kosrae (GMT +12) Pacific/Tarawa
(GMT +12) Pacific/Majuro (GMT +12) Pacific/Nauru
(GMT +12) Pacific/Funafuti (GMT +12) Pacific/Wake
(GMT +12) Pacific/Wallis (GMT +12) Pacific/Fiji
(GMT +12) Antarctica/McMurdo (GMT +12) Asia/Kamchatka
(GMT +12) Pacific/Auckland (GMT +12) NST
(GMT +12) Pacific/Chatham (GMT +13) Pacific/Enderbury
(GMT +13) Pacific/Tongatapu (GMT +13) Asia/Anadyr
(GMT +14) Pacific/Kiritimati
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Troubleshooting Resources

The following resources are available to aid in troubleshooting problems 
that arise while working with or administering HP Business Availability 
Center:

➤ Installation troubleshooting. Use to troubleshoot common problems that 
you may encounter when installing HP Business Availability Center, and the 
solutions to those problems. For details, see “Installation and Connectivity 
Troubleshooting” in the HP Business Availability Center Deployment Guide 
PDF. 

➤ Login troubleshooting. Use to troubleshoot possible causes of failure to log 
in to HP Business Availability Center. For details, see “Troubleshooting 
HP Business Availability Center Login” in Platform Administration.

➤ Customer Knowledge Base. Use to search for specific troubleshooting 
information on a wide variety of topics. Located on the Customer Support 
Web site (http://support.mercury.com), the Knowledge Base can be accessed by 
selecting Troubleshooting & Knowledge Base from the HP Business 
Availability Center Help menu.

Note that only registered customers can access the resources on the 
Customer Support Web site. Customers who have not yet registered can do 
so from the site.

➤ HP Business Availability Center tools. Use to assist in troubleshooting the 
HP Business Availability Center environment. You access the tools from the 
<HP Business Availability Center server root directory>\tools directory. 
Most of the tools should only be used in coordination with HP personnel. 
The Database Schema Verification utility (dbverify) and Data Marking utility 
should be used according to their documented instructions.
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Working in Non-English Locales

This chapter lists considerations and limitations when working in a non-
English locale. 

This chapter describes: On page:

Installation and Deployment Issues 334

Database Environment Issues 334

Administration Issues 335

Dashboard Issues 335

Service Level Management Issues 336

HP Business Availability Center for Siebel Applications Issues 336

Report Issues 336

Business Process Monitor Issues 337

SiteScope Issues 338

Real User Monitor Issues 338

End User Management Administration Issues 338

System Availability Management Issues 339

Problem Isolation Issues 339

Multiple-language Issues 339

Multi-Lingual User (MLU) Interface Support 340
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Installation and Deployment Issues

➤ Installing HP Business Availability Center in an I18N environment is only 
supported for HP Business Availability Center installed on a Windows 
platform. For details on installing HP Business Availability Center on a 
Windows platform, see “Installing HP Business Availability Center Servers 
on a Windows Platform” in the HP Business Availability Center Deployment 
Guide PDF.

➤ The installation path for all HP Business Availability Center components 
must not contain non-English language characters.

➤ Business Process Monitors and the Gateway Server must be installed on an 
operating system that has the same locale as the data.

➤ During Business Process Monitor installation, use English names only for 
the host name and location. If necessary, you can change the names to 
non-English names after installation, in Business Process Monitor Admin.

Database Environment Issues

➤ To work in a non-English language HP Business Availability Center 
environment, you can use either Oracle Server database or MS SQL Server 
database. The encoding of the database should be the same as the encoding 
of the specific language. When using Oracle Server database, the encoding 
of the database can also be UTF-8, which supports both non-English 
languages as well as multiple languages.

➤ When you create a new Oracle instance in an Oracle database, you must 
specify the character set for the instance. All character data, including data 
in the data dictionary, is stored in the instance’s character set. For details on 
working with Oracle databases, see “Deploying and Maintaining the Oracle 
Server Database” in the HP Business Availability Center Database Guide PDF.

➤ The Database Query Monitor can connect to an Oracle database but the 
Oracle user names and passwords must contain only English characters. 
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Administration Issues

➤ E-mail alerts sent with ISO-2022-JP encoding are supported only by an SMTP 
server running on a Windows NT platform. Use of this encoding affects all 
HP Business Availability Center servers. 

➤ When using the default authentication strategy to authenticate users 
logging in to HP Business Availability Center, all user names and passwords 
must be in English.

Dashboard Issues

➤ To display non-Latin languages in Dashboard Top View:

 a Verify that you have followed the instructions on installing the JRE on a 
non-Western Windows system. The instructions are found at 
http://java.sun.com/j2se/1.5.0/jre/install-windows.html.

 b Make sure that you:

➤ have administrative permissions to install the J2SE Runtime 
Environment on Microsoft Windows 2000 and XP.

➤ (For users installing the JRE on non-Western 32-bit machines) choose a 
Custom Setup Type. In Custom Setup under feature 2 (Support for 
Additional Languages), select This feature is installed on local hard 
drive. 

 c Select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, click Applications, select Dashboard Application, and locate the 
Top View Font Name entry in the Dashboard Application – Top View 
Properties table. Change the value to Arial Unicode MS. 

Important: If the value of the Top View Font Name entry is default, you do 
not need to perform this step, as the Top View Font Name property 
automatically assumes the Arial Unicode MS value in that case. 
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 d Close all instances of the Web browser.

 e Log in to HP Business Availability Center and access Dashboard Top 
View. Verify that the Chinese or Japanese characters now appear 
correctly.

Service Level Management Issues

Service Level Management does not support service names that contain 
more than 50 multibyte characters.

HP Business Availability Center for Siebel Applications 
Issues

➤ Non-English characters may not appear or may be corrupted in the 
Topology View. If you encounter this problem, install the Arial Unicode 
Microsoft font from the Microsoft Web site.

➤ HP Business Availability Center by default only supports English language 
Siebel. Do not deliver data from a non-English version of Siebel to 
HP Business Availability Center. You should use special translation adapters 
to enable HP Business Availability Center to work with a non-English 
version of the Siebel application. For details, contact Customer Support.

Report Issues

➤ HP Business Availability Center does not support Custom Report names that 
contain more than 50 multibyte characters.

➤ The Page Component Breakdown report does not support URLs that contain 
multibyte characters. When specifying a URL and a location from which to 
run the breakdown, you must enter English characters in the URL box.

➤ Excel reports must have English file names when uploading to HP Business 
Availability Center running on a Chinese Simplified operating system. To 
view Excel reports, select Applications > End User Management. Choose the 
User Reports tab and click Excel Reports.
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➤ Reports downloaded from HP Business Availability Center to Excel cannot 
be displayed properly on an operating system whose language differs from 
the data language.

To download Excel files with multibyte data when HP Business Availability 
Center is installed on an English-language machine, set the user.encoding 
entry in the <Business Availability Center root 
directory>\AppServer\resources\strings.properties file to the correct 
encoding.

➤ By default, Excel does not open UTF8 encoded CSV documents correctly. 
After saving a report as a .csv file, you can import it into Excel by doing the 
following in Excel: 

➤ On the Data menu, select Import External Data, and click Import Data.

➤ In the Files of type box, click Text Files.

➤ In the Look in box, locate and double-click the text file you want to 
import as an external data range.

To specify how you want to divide the text into columns, follow the 
instructions in the Text Import Wizard, and then click Finish.

Business Process Monitor Issues

➤ If the Business Process Monitor log files contain non-English data, you must 
open them in a viewer that supports UTF-8 format parsing, for example, 
Notepad, rather than from the View BPM Files window in the Business 
Process Monitor Admin.

Log files that are saved in the default encoding of the server on which the 
Business Process Monitor Admin is installed are shown correctly in the View 
BPM Files window.

➤ HP Business Availability Center does not support Business Process Monitor 
host names that contain more than 25 multibyte characters.
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SiteScope Issues

➤ In SiteScopes running in I18N mode, the Return to Group link displayed 
during monitor set creation shows the indexed-based group name (for 
example, group0) instead of the user-defined group name.

➤ The Database Query Monitor can connect to an Oracle database only if the 
Oracle user names and passwords contain English-only characters.

➤ SiteScope does not support non-English characters in the 
username/password.

➤ Beginning with SiteScope version 8.5, the user interface can be displayed in 
several languages. For details, see “Working in an Internationalization 
Environment” in Using System Availability Management.

➤ For a list of monitors that are tested for internationalization, see “Monitors 
Tested for Internationalization” in Using System Availability Management.

Real User Monitor Issues

➤ Real User Monitor supports non-English characters in UTF-8 format. For 
details on configuring the HP Real User Monitor probe to support non-
Unicode encodings, see “Configuring the HP Real User Monitor Probe for 
I18N” in the Real User Monitor Administration PDF.

➤ To support non-English character from Real User Monitor, the encoding for 
HP Business Availability Center databases must be defined as UTF-8, or set to 
the specific language. For further details, see “Database Environment Issues” 
on page 334.

End User Management Administration Issues

Global replace does not support non-English languages.
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System Availability Management Issues

➤ Global replace does not support non-English languages.

Problem Isolation Issues

Problem Isolation does not support I18N and is not translated into non-
English languages.

Multiple-language Issues

➤ The SNMP notification method does not support multiple-language text, 
and can only send a notification in the character set of the Gateway Server 
machine. This is because HP Business Availability Center uses SNMP 
version 1.0, which does not support multilingual data. 

➤ Error messages in the Failed Transactions report do not display correctly 
when HP Business Availability Center runs on an English operating system, 
and the Business Process Monitor runs on a Japanese operating system. To 
access the Failed Transactions report, select Applications > End User 
Management > Business Processes > Error Summary. Locate the General 
Errors table, and click a link to open the Failed Transactions window.

➤ In UNIX, there is no support for I18N. Make sure that transactions and 
scripts contain English characters only.

➤ HP Business Availability Center can store multiple-language data. However, 
a regular executable cannot usually accept multiple-language data on the 
command line.
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The following table describes the procedures that you must perform to add 
multiple-language data to the command line when running an executable 
file upon alert:

For details on using a custom command line when running an executable 
file upon alert, refer to “Run Executable File Dialog Box” in Platform 
Administration.

➤ An executable file that was created for a previous version of HP Business 
Availability Center is compatible with a multiple-language version.

Multi-Lingual User (MLU) Interface Support

The HP Business Availability Center user interface can be viewed in the 
following languages in your Web browser:

 

Platform Procedure

Windows To prevent multiple-language data from being lost, write the 
application with a wmain function instead of a main 
function. You can also use another main-type function that 
can take command line parameters of type wchar instead of 
type char.

Note: When you use the SubAlerts command line option, 
the created XML file does not include an encoding attribute, 
and the encoding is different from the default UTF-8 
encoding.

Solaris Inform the writer of the application that the parameters 
passed to the application must be encoded in UTF-8.

Language Language Preference in Web Browser

English English 

French French (France) [fr]

Japanese Japanese [ja]
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Note: There is no support for I18N on a UNIX machine.

Use the language preference option in your browser to select how to view 
HP Business Availability Center. The language preference chosen affects 
only your local machine (the client machine) and not the HP Business 
Availability Center machine or any other user accessing the same 
HP Business Availability Center machine.

To set up and view HP Business Availability Center in a specific language:

 1 Install the appropriate language’s fonts on your local machine if they are 
not yet installed. If you choose a language in your Web browser whose fonts 
have not been installed, HP Business Availability Center displays the 
characters as squares.

 2 If you are logged in to HP Business Availability Center, you must log out. 
Click LOGOUT at the top of the HP Business Availability Center window.

Close every open browser window or alternatively clear the cache (if 
HP Business Availability Center is running on Internet Explorer). 

 3 If HP Business Availability Center is running on Internet Explorer, configure 
the Web browser on your local machine to select the language in which you 
want to view HP Business Availability Center (Tools > Internet Options). 

 a Click the Languages button and in the Language Preference dialog box, 
highlight the language in which you want to view HP Business 
Availability Center. 

 b If the language you want is not listed in the dialog box, click Add to 
display the list of languages. Select the language you want to add and 
click OK.

 c Click Move Up to move the selected language to the first row.

Korean Korean [ko]

Simplified Chinese Chinese (China) [zh-cn]

Language Language Preference in Web Browser
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 d Click OK to save the settings. 

 e Display the HP Business Availability Center login window.

 f From the Internet Explorer menu, select View > Refresh. HP Business 
Availability Center immediately refreshes and the user interface is 
displayed in the selected language. 

Note: For details on viewing Web pages in Internet Explorer that are written 
in a different language, see http://support.microsoft.com/kb/306872/en-us.

If HP Business Availability Center is being viewed on FireFox, configure the 
Web browser on your local machine as follows:

 a Select Tools > Options > Advanced. Click Edit Languages. The Language 
dialog box opens. 

 b Highlight the language in which you want to view HP Business 
Availability Center.

If the language you want is not listed in the dialog box, expand the 
Select language to add... list, select the language, and click Add. 

 c Click Move Up to move the selected language to the first row.

 d Click OK to save the settings. Click OK to close the Language dialog box. 

Notes and Limitations

➤ There is no language pack installation. All translated languages are 
integrated into the HP Business Availability Center Multi-lingual User 
Interface (MLU). 

➤ Data remains in the language it is entered in, even if the language of the 
Web browser changes. Changing the language of the Web browser on your 
local machine does not change the language of the data input definitions 
and configurations.

➤ Some of the links in the Help menu are displayed in the user interface 
language you select. 
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HP Business Availability Center Logs

Note to HP Managed Software Solutions customers: This chapter is not 
relevant for HP Managed Software Solutions customers.

This chapter provides an overview of HP Business Availability Center log 
files.

This chapter describes: On page:

About HP Business Availability Center Logs 344

Log File Locations 344

Log Severity Levels 345

Log File Size and Automatic Archiving 346

JBoss and Tomcat Logs 347

Real User Monitor Logs 348
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About HP Business Availability Center Logs 

HP Business Availability Center records the procedures and actions 
performed by the various components in log files. The log files are usually 
designed to serve Customer Support when HP Business Availability Center 
does not perform as expected.

The default severity threshold level for log files is differs per log, but is 
generally set to either Info or Error. For a definition of log levels, see “Log 
Severity Levels” on page 345.

You can view log files with any text editor.

Log File Locations

Most log files are located in the <HP Business Availability Center root 
directory>\log directory and in subdirectories organized by component.

Log file properties are defined in files in the following directory and its 
subdirectories: <HP Business Availability Center root 
directory>\conf\core\Tools\log4j.

Log File Locations in a Distributed Deployment
In typical or compact installations, all HP Business Availability Center 
servers and their logs reside on the same machine. In the case of a 
distributed deployment of the servers among several machines, logs for a 
particular server are usually saved on the computer on which the server is 
installed. However, if it is necessary for you to inspect logs, you should do so 
on all machines.

When comparing logs on client machines to those on the HP Business 
Availability Center server machines, keep in mind that the date and time 
recorded in a log are taken from the machine on which the log was 
produced. It follows that if there is a time difference between the server and 
client machines, the same event is recorded by each with a different time 
stamp.
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Log Severity Levels 

Each log is set so that the information it records corresponds to a certain 
severity threshold. Because the various logs are used to keep track of 
different information, each is pre-set to an appropriate default level. For 
details on changing the log level, see “Changing Log Levels” below.

Typical log levels are listed below from narrowest to widest scope:

➤ Error. The log records only events that adversely affect the immediate 
functioning of HP Business Availability Center. When a malfunction occurs, 
you can check if Error messages were logged and inspect their content to 
trace the source of the failure.

➤ Warning. The log’s scope includes, in addition to Error-level events, 
problems for which HP Business Availability Center is currently able to 
compensate and incidents that should be noted to prevent possible future 
malfunctions.

➤ Info. The log records all activity. Most of the information is normally 
routine and of little use and the log file quickly fills up.

➤ Debug. This level is used by Customer Support when troubleshooting 
problems.

Note: The names of the different log levels may vary slightly on different 
servers and for different procedures. For example, Info may be referred to as 
Always logged or Flow.

Changing Log Levels
If requested by Customer Support, you may have to change the severity 
threshold level in a log, for example, to a debug level.

To change the severity threshold level:

 1 Open the log properties file in a text editor. Log file properties are defined in 
files in the following directory: <HP Business Availability Center root 
directory>\conf\core\Tools\log4j.
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 2 Locate the loglevel parameter. For example,

 3 Change the level to the required level. For example, 

For a description of the log levels, see “Log Severity Levels” on page 345.

 4 Save the file.

Log File Size and Automatic Archiving

A size limit is set for each type of log file. When a file reaches this limit, it is 
renamed and becomes an archived log. A new active log file is then created. 

For many logs, the number of archived log files saved can be configured. 
When a file reaches its size limit, it is renamed with the numbered 
extension 1. If there is currently an archived log with the extension 1, it is 
renamed with the extension 2, log.2 becomes log.3, and so on, until the 
oldest archived log file (with the number corresponding to the maximum 
number of files to be saved) is permanently deleted.

The following image shows an example of a log file, topaz_all.ejb.log, and 
its archived copies.  

loglevel=ERROR

loglevel=DEBUG
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The maximum file size and the number of archived log files are defined in 
the log properties files located in <HP Business Availability Center root 
directory>\conf\core\Tools\log4j. An example is:

JBoss and Tomcat Logs

The following <HP Business Availability Center root directory>\log 
directory holds JBoss- and Tomcat-related log files:

➤ jboss_boot.log. Logs startup activities including running the JBoss 
process, deployment, and startup status, as well as the number of busy 
ports. If HP Business Availability Center fails to start, any problems are 
written to this log. 

➤ jboss_server.log. Logs all JBoss activities including JBoss messages, 
deployment and startup status.

➤ jboss_tomcat.log. Logs the Tomcat messages.

Note: You can view the JBoss Management Console at http://<HP Business 
Availability Center server>:8080/jmx-console.

def.file.max.size=2000KB
def.files.backup.count=10
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Real User Monitor Logs

Real User Monitor logs store messages from Real User Monitor modules and 
are used to troubleshoot problems, and to provide information about the 
system’s operations. There are three types of logs: engine logs, JBoss logs, 
and core logs. The log files are located in the <Real User Monitor Engine 
root>\log directory.

You change log levels, and the default log size and archiving parameters, in 
the same way as in HP Business Availability Center. For details, see 
“Changing Log Levels” on page 345, and “Log File Size and Automatic 
Archiving” on page 346.

This section contains the following topics:

➤ Engine Logs

➤ JBoss and Tomcat Logs

➤ Core Logs

Engine Logs
Engine logs contain log messages from the different processes. There are two 
types of engine log files:

➤ rumengine log files. Log files for modules within the Real User Monitor 
engine.

➤ repository log files. Log files for modules connecting the Real User Monitor 
engine and its mySQL database.

There is a log for each module and the Real User Monitor engine saves up to 
20 files for each log by default. When a file reaches a maximum, default size 
of 3 MB, a new log file is created automatically. Each time the Real User 
Monitor engine is restarted, it creates a new set of logs. The name of the log 
file consists of the log type (rumengine or repository), the module name, log 
and the log file number.
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For example, a rumengine type module called clustermanager would 
produce the following log files:

and so on.

The structure of a message in the log file is as follows: <timestamp> 
<invoking thread> <java class name and line number> <message log level> 
<message content>. For example:  

You can change the default log file size and archiving cycle. For details, see 
“Log File Size and Automatic Archiving” on page 346.

You can change the error level that is reported to the log file for each 
module. The following error levels can be set for Real User Monitor log files:

➤ Fatal. The log only records severe events that could cause the Real User 
Monitor to abort.

➤ Error. The log records severe events that adversely affect the immediate 
functioning of Real User Monitor, that might still allow the application to 
continue running.

➤ Warn. The log’s scope is widened to include events that include potentially 
harmful situations.

➤ Info. The log includes informational messages about the regular running of 
the system.

➤ Debug. This level is used by Customer Support when troubleshooting 
problems.

For details on changing the error level, see “Changing Log Levels” on 
page 345.

rumengine.clustermanager.log
rumengine.clustermanager.log.1
rumengine.clustermanager.log.2

2005-08-03 14:20:32,953 [main] (NodesVerifierManager.java:185) INFO - Found 
primary installation on current machine
2005-08-03 14:20:33,125 [main] (NodeVerifierServer.java:103) INFO - Got host 
name=paddington from repository. Hostname ID=1
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Note: Each severity level includes all the levels above it. For example, if the 
log is set to Warn level, it includes Warn, Error and Fatal events.

JBoss and Tomcat Logs
JBoss and Tomcat log messages are written to the following files in the
<Real User Monitor Engine root>\log directory:

➤ jboss_boot.log. Logs startup activities including running the JBoss process, 
deployment, and startup status. If the Real User Monitor fails to start, any 
problems are written to this log. 

➤ jboss_server.log. Logs all JBoss activities including JBoss messages, 
deployment and startup status.

➤ jboss_tomcat.log. Logs the Tomcat messages.

Core Logs
Core log messages are written to log files in the <Real User Monitor Engine 
root>\log\core directory.

The core log files contain messages about the general status of the 
application server on which the HP Real User Monitor engine is installed, 
and its services.
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CMDB Logs

This chapter describes various log files and explains how to perform basic 
troubleshooting. 

 

This chapter describes: On page:

CMDB Log File Overview 352

CMDB Server Parameters 352

CI Type Model Log 354

CMDB Notification Log 355

CMDB Model Audit Short Log 356

TQL Logs 357

History Database Log 361

CMDB Enrichment Log 362

CMDB Plug-in Log 363

CMDB Dal Log 363
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CMDB Log File Overview

This chapter describes configuration management database (CMDB) log 
files.

CMDB log files enable you to perform basic troubleshooting of common 
CMDB runtime problems. Additionally, by tracking CMDB behavior in the 
log files, you can examine the effects of changes made in the system. CMDB 
is composed of subsystems and each subsystem records to several log files. 

Note: Log files are located in the <HP Business Availability Center root 
directory>\log folders.

CMDB Server Parameters

This section contains definitions for CMDB server parameter log files.

This section includes the following topics:

➤ “Lifecycle Log” on page 353

➤ “General CMDB Log” on page 353

➤ “Quota Log” on page 354
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Lifecycle Log
The log name is cmdb.info.log. 

General CMDB Log
The log name is cmdb.log.

Log File Description

Purpose CMDB server lifecycle: 

➤ all server tasks

➤ customer loading and unloading 

➤ startup and shutdown of Task manager

Contains information about any application that does not 
start up correctly.

Information 
Level

All lifecycle details.

Error Level Startup errors of CMDB subsystems, primarily in the data 
access layer.

Debug Level Not applicable

Basic 
Troubleshooting

➤ If the CMDB client receives an exception that the customer 
does not exist, check that the customer is properly loaded. 

➤ If the CMDB client receives an exception that it cannot find 
CMDB in a JNDI lookup, check that the CMDB server is 
bound in the JNDI tree.

➤ If the HA Controller does not load the CMDB customers, 
check that the CMDB server is registered in the HA 
controller.

Log File Description

Purpose Errors of all CMDB subsystems and CMDB CITs that do not 
have their own log file.

Information 
Level

Information from the CMDB server not directed to any 
specific log.

Error Level All errors in the CMDB server.
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Quota Log
The log name is cmdb.quota.log.

CI Type Model Log

The log name is cmdb.classmodel.log.

Debug Level Debug information in the CMDB server that is not directed to 
a specific log.

Basic 
Troubleshooting

CMDB server errors during CMDB deployment.

Log File Description

Purpose Quota names, quota values, and current quota levels. 

Information 
Level

Quota names and values set in the server and customer levels 
during a customer load.

Error Level CMDB operations that fail because they exceed quota limits.

Debug Level A count collector runs every n minutes and gathers current 
counts for all quotas. Collected counts are logged.

Basic 
Troubleshooting

If operations fail because of quota limits, check the count 
growth and quota values.

Log File Description

Purpose CI Type Model errors and debug messages.

Information 
Level

When a CI Type Model is loaded, incorrect definitions are 
logged as informational messages. An example of an incorrect 
definition is duplicate attributes.

Error Level Not available.

Log File Description
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CMDB Notification Log

The log name is cmdb.notification.log.

Debug Level Every CI Type update includes the following:

➤ original CIT in XML format

➤ new CIT in XML format

➤ differences between the CITs 

If the CI Type Model update is rejected, the reason is logged.

Basic 
Troubleshooting

Compares the differences that the server finds between the 
original CIT and the new CIT. This is useful to understand the 
following scenarios:

➤ a CIT in a package failed 

➤ an action in the CIT browser applet failed

➤ an action in the CIT browser applet succeeded when it 
should have failed

Log File Description

Purpose Notification messages from the time of the component’s 
creation in CMDB until the client’s listener receives a message.

Most components receive configuration changes from CMDB 
in push mode, by the notification mechanism, rather than in 
pull mode.

Information 
Level

➤ startup and shutdown of publishers

➤ register and unregister remote and internal listeners

Error Level ➤ errors when messages are published

➤ errors when messages are received 

Debug Level ➤ unique message ID 

➤ number of changes that a message includes as well as more 
details according to the type of the message (for example, 
the TQL result version) 

➤ JMS header properties

Log File Description
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CMDB Model Audit Short Log

The log name is cmdb.model.audit.short.log.

Basic 
Troubleshooting

If an application does not receive a notification, check the 
following:

➤ a listener is registered with the appropriate notification 
filter

➤ a message is published with data that matches this filter

➤ a message is received by the listener (use the unique 
message ID to verify)

Log File Description

Purpose Information about a CI Type operation: type of operation, 
data received as input, and what happened to the data in each 
CIT. 

Also contains information about the caller application, 
execution times, and persistency time.

Information 
Level

Operation details

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

If there are no changes when there should be, check the 
following:

➤ the operation exists

➤ the input is correct 

➤ what happened to the data. There may have been a false 
update. 

This is especially useful when running Discovery to trace the 
input. 

Log File Description
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TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

➤ “Pattern Log” on page 357

➤ “Pattern Statistics Log” on page 358

➤ “Audit Short/Detailed Log (TQL Perspective)” on page 359

➤ “Incremental Statistics Log” on page 359

➤ “Incremental Splitter Log” on page 360

➤ “Incremental Detailed Log” on page 361

Pattern Log
The log name is cmdb.pattern.log.

Log File Description

Purpose Information about the lifecycle of a TQL query that is handled 
and calculated in the CMDB. 

Only TQLs stored in the CMDB are included. Information 
about ad hoc TQLs is not included.

Information 
Level

Not available.

Error Level Not available.

Debug Level Possible actions performed on each TQL query include:

➤ status changes

➤ model changes

➤ query changes

➤ completed calculations
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Pattern Statistics Log
The log name is cmdb.pattern.statistics.log.

Basic 
Troubleshooting

Check if a TQL query has the same status for a long time:

➤ new – the query is in lazy loading

➤ inactive 

➤ calculation – the calculation may have failed but the 
scheduler was not informed

You can also see the number of notifications that a TQL 
received.

Log File Description

Purpose General calculation data for each TQL, updated at predefined 
intervals.

Information 
Level

The following information is given for each TQL:

➤ name

➤ average, minimum, and maximum calculation times

➤ number of calculations

➤ last calculation time

➤ result size

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

➤ Verify that a specific TQL was updated.

➤ Evaluate a TQL’s calculation time.

➤ Evaluate a TQL’s result size. 

Log File Description
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Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Incremental Statistics Log
The log name is cmdb.incremental.statistics.log. 

Log File Description

Purpose CMDB state changes, CI Type changes, and TQL results.

You can use this log to follow the results of TQL queries.

Information 
Level

Not available.

Error Level Not available.

Debug Level ➤ Final calculation for TQLs is logged.

➤ If the final TQL calculation is unchanged from the previous 
calculation, this is noted.

➤ If the final TQL calculation is changed from the previous 
calculation, results of the CIs and relationships are recorded 
in the detailed log. The number of CIs and relationships are 
recorded in the short log.

Basic 
Troubleshooting

➤ Use this log to verify which notifications are published by 
the TQL subsystem.

➤ Check the section at the end of each result. This section 
includes added, removed, and updated CIs and 
relationships.

➤ Track the CIT changes and see if the query results also 
change. You can thus correlate the CIT changes to the 
results of the query calculations.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every 
query.

Information 
Level

Not available.
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Incremental Splitter Log
The log name is cmdb.incremental.splitter.log.

Error Level Not available.

Debug Level ➤ Gives the date, time, query name, and whether an 
incremental statistic calculation was performed (yes/no). 

➤ If an incremental statistic calculation was not performed, 
states the reason, the number of subcalculations (relevant 
for incremental calculations only), and the complete 
calculation time.

Basic 
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a 
full or incremental calculation:

➤ If full, check whether a full calculation is necessary.

➤ If incremental, check how many subcalculations have been 
performed.

Log File Description

Purpose Monitors the incremental splitter result made during an 
incremental calculation.

Information 
Level

Not available.

Error Level Not available.

Debug Level Gives the set of node numbers of each query graph created by 
the incremental splitter.

Basic 
Troubleshooting

If the TQL result calculated by the incremental calculator is 
wrong, verify that the splitter result is correct.

Log File Description
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Incremental Detailed Log
The log name is cmdb.incremental.detailed.log.

History Database Log

The log name is cmdb.history.log.

Log File Description

Purpose Monitors the incremental calculation process. 

Information 
Level

Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

➤ the trigger node 

➤ the number of elements classified to the trigger node 

➤ whether the subcalculation step is driven by new elements 
added to the model or by existing elements

➤ the calculated query graph

Basic 
Troubleshooting

Follows the basic steps of an incremental calculation.

Log File Description

Purpose ➤ Records which CITs are found by the History database when 
the database is initialized from an existing topology. 

➤ Records what is to be saved in the History database.

➤ Tracks events saved in the History database.

➤ Records when the History database was purged.

Information 
Level

➤ When the last purge was carried out.

➤ Information about initialization of the History database.
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CMDB Enrichment Log

The log name is cmdb.enrichment.log.

Error Level Lists errors that occur when event information is inserted in 
the History database.

Debug Level ➤ Details about CITs inserted during initialization of the 
History database.

➤ Details about changes in the TQL results saved in the 
History database.

Log File Description

Purpose Enrichment definitions: adding, updating, removing, and 
calculating. 

Calculation results such as how many CIs were added, how 
many relationships were removed, and so forth. 

Supplies the reason for a calculation failure. Failure in a model 
update, however, is not included since it is an asynchronous 
execution.

Information 
Level

➤ Add, update, and remove enrichment definitions.

➤ Add, update, and remove CIs or relationships to or from a 
model.

Error Level Calculation failure.

Debug Level Traces the enrichment calculation process.

Basic 
Troubleshooting

➤ If no calculation was carried out, check the definition of 
add enrichment.

➤ If there are no results, check the finish calculate entry.

Log File Description
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CMDB Plug-in Log

The log name is cmdb.plugins.log.

CMDB Dal Log

The log name is cmdb.dal.log.

Log File Description

Purpose Plug-in input and output notification.

Information 
Level

Lifecycle of publisher.

Error Level ➤ no customer name exists in the customer ID 

➤ publisher failure 

Debug Level Receive or send a change.

Basic 
Troubleshooting

If notification did not reach the destination, check that the 
plug-in received the input. 

Log File Description

Purpose Information about activity that occurred in the data access 
layer, the layer that works with CMDB.

Information 
Level

Not available.

Error Level ➤ connection pool errors

➤ database errors

➤ command execution errors
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Debug Level ➤ all DAL commands executed

➤ all SQL commands executed

Basic 
Troubleshooting

If you suspect that CMDB actions are taking too long, check 
the time spent on queries and updates in the dal logs and 
operation logs.

Exception details and ID are entered into the log. The 
exception ID appears in the exception itself.

Log File Description
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